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PREFACE
Spatial information is included in many information systems, including
the Information System of Geodesy, Cartography and Cadastre.
Cadastral systems usually include a database containing spatially
referenced land data, a set of procedures and techniques for systematic
collection, updating, processing and distribution of data and a uniform spatial
uniform system.
Cadastral data are defined as the geographic extent of the past, current,
and future rights and interests in real property including the spatial information
necessary to describe that geographic extent. Rights and interests are the
benefits or enjoyment in real property that can be conveyed, transferred, or
otherwise allocated to another for economic remuneration. Rights and interests
are recorded in land record documents. The spatial information necessary to
describe rights and interests includes surveys and legal description frameworks
such as the Public Land Survey System, as well as parcel-by-parcel surveys
and descriptions
This manual is divided into two parts. Both parts are about procedures
and techniques for spatial cadastral data collection.
The first part includes a more detailed overview of cadastral plans from a
surveying point of view. Also the direct techniques (field surveying and GNSS)
and COGO methods are discussed as well.
The second part of the manual is dedicated to the indirect techniques or
use of Remote Sensing and LIDAR for cadastral survey.
Each part of the manual ends with the lab assignments for the students.
Following the lab assignment 1, students are introduced with the process of
measurements of cadastral land plot by using professional GPS and
tacheometer instruments, as well as to demonstrate how ArcGIS software can
be used to process field survey measurements and draw a cadastral plan. The
aime of the lab assignment 2 is to introduce students with the use remote
sensing data to compile and update parcel cadastral plans. The scenario of this
assignment includes updating procedures of a land parcel by using an aerial
digital orthophoto image (or orthoimage) and LiDAR data without fieldwork.
Also, natural and infrastructure objects related to the cadastral data will be
derived from orthophoto image and LiDAR data. These tasks will be
completed in ArcGIS software.
Each lab assignment consists of an introduction, a theoretical justification
for the task, task methodological guidance, initial data sets and self-control
issues.
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The manual is dedicated for Erasmus program students, as well as for the
courses related with remote sensing, cadastral survey, GIS methods in field
survey and so on.
Authors are very thankful to Andrei Zubanov, who prepared the initial
data for lab assignments.
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CHAPTER I

1. SPATIAL DATA SOURCES FOR CADASTER: FIELD
SURVEY AND GPS
1.1. CADASTRAL MAPS AND CADASTRAL PLANS
A land information system usually includes a database containing
spatially referenced cadastral data (objects), and additionally it consists of a set
of procedures and techniques for systematic collection, updating, processing
and distribution of cadastral data. This manual is about procedures and
techniques for spatial cadastral data collection.
1.1.1. Cadastral Plan
This chapter includes a more detailed overview of cadastral plans from a
surveying point of view. The cadastral plan (or survey plan) is the foundation
block of a cadaster. A registered/licensed surveyor who accurately measures
and records the boundaries of each land property and/or cadastral objects
should produce it. This occurs whenever a new land parcel is created and each
new survey produces a new survey plan. Because of this, each plan is static in
time, i.e. it represents the shape and status of the cadaster at the time of survey.
However, an existing parcel can be resurveyed and its old survey plan can be
updated.
Cadastral plans from different parts of the world will contain different
information - this is dependent on local legislation rules/specifications relating
to the registering of cadastral plans into the local cadaster system. A properly
registered cadastral plan usually is a legal document, which can be used, for
example, for the sale of real estate property.
A cadastral plan represents visually or digitally the legal boundaries and
dimensions of a surveyed parcel of land and related cadastral objects (e.g.,
roads, easements etc.), and identifies the type and location of monuments or
survey posts (control points) set in the ground to define the boundaries of the
parcel (Figure 1).
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Figure 1: An example of cadastral plan from http://www.ltsa.ca/docs/ExamplePlan.pdf

Land records are composed of survey documents (plans) and associated
registry records (the rights and interests in land).
When surveying new parcels of land or resurveying existing parcels of
land, surveyors must be aware of the legal ownership rights on the land,
ownership disputes or conflicts, and historic surveys. Cadastral parcels should
be maintained together with both their survey source information (plans) and
corresponding registry information (rights).
There are many types of cadastral plans:
 Survey plans or plats (Figure 2);
 Subdivision plans (Figure 3);
 Reference or explanatory plans defining roads, or accompanying
right of way, easement, covenant, or lease charges;
 Strata plans;
 Reference plans accompanying municipal bylaws that cancel a
highway;
 Posting plans that depict the placement or replacement of the
corners of a parcel;
 Air space plans etc.

7

Figure 2: Re-surveyed plat
with bearings and
distances, the legal
description “lot 2 of section
th
11, T3N, R5W, 6
P.M.Walnut County,
Nebraska”, descriptions of
surveyor etc. (page 186)

Figure 3: Subdivision
plan with bearings
and distances (page
230)

In a traditional cadastre, records of rights were supported by paper parcel
plans and the traditional term for paper cadaster drawing is a plat. A plat is a
report of a survey in the form of a drawing. States, provinces and professional
surveying organizations have developed, either through their state board of
registration or through their professional societies, a minimum standard or
guidelines for preparation of survey plans. Such standards can list elements,
which should be shown on plats, and how plats should be designed. One of
such examples is the “National Standards for the Survey of Canada Lands”
(Canada Lands Survey System, 2015).
One of the examples of successful projects in the establishment of state
cadastral survey system is the Swiss Cadastral Reform Project at the beginning
of the 1990s (Figure 4). An important feature of this reform was the
introduction of free choice of methods for the cadastral survey. In order to
guarantee the exchange of geographical data despite the resulting wide variety
of hardware and software used, the official cadastral survey interface (AVS)
was defined and introduced as a neutral and independent system.
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Figure 4: Components of the official cadastral survey interface

AVS is prescribed in the Technical Ordinance on Official Cadastral
Surveying and consists of the cadastral survey data model which lays down the
structure of the data and the corresponding transfer format constituted by the
architecture of the file containing the geographical data to be transferred.
It is also legally specified that the IT systems used within the official
cadastral survey must both guarantee the import and export of data to and from
the cadastral survey and conform to the description of the data model in the
INTERLIS data description language. The official cadastral survey interface
was the first application of INTERLIS, which has today become a recognized
standard for modelling, integration and exchange cadastral data in the world of
geographical information.
The Swiss cadastral surveying data is available in both forms of paper
maps and digital datasets and is structured into eleven thematic feature
classes/layers (Figure 5), which can be combined among themselves or with
other related spatial data such as noise maps, zoning plans etc.
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Figure 5: Eleven thematic feature classes of the Swiss cadastral surveying data

The Swiss digital cadastral data can be linked and combined with other related
spatial data such as noise and zoning plans spatial data. INTERLIS facilitates
the exchange of data between different LIS/GIS.
1.1.2. How is Cadastral Map Different to a Cadastral Plan?
Cadastral maps are produced by joining together individual cadastral
plans. A cadastral map also may show the boundaries and ownership of land
parcels within administrative units. Some cadastral maps show additional
details such as unique identifying numbers for parcels, positions of existing
buildings or adjacent street names.
Cadastral mapping is one of the best-known forms of mapping, because it
is the mapping that shows all of the land parcels in relation to one another and
to the adjoining roads (Figure 6). It is also one of the most ancient forms of
mapping – for example ancient Egyptians are known to have developed
cadastral records so that land ownership could be re-established after the
annual flooding of the Nile River.

Figure 6. Brody Cadastral Map, 1844
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A cadastral map is a general land-administrative tool, which has no real
legislative basis (as a cadastral plan does). It is often created on demand and
therefore is not necessarily up-to-date. These maps are used by a broad range
of people (public and professional) for all manner of things including real
estate sales, valuation, planning etc.
1.1.3. Digital Cadaster Database and Survey Data
A digital cadastral geodatabase is a repository where is stored
information acquired from the survey process in a form that allows an analysis
of the relationship/topology among spatial cadastral objects. A geodatabase
may comprise of many feature classes and standalone attribute tables,
representing different objects and attributes of land and property boundaries.
There are concerns of survey data entry into a geodatabase. Thus, the
database structures should be such that only “valid and clean” data can be
entered and stored in the geodatabase. That involves procedures of conversion,
cleaning and validation of spatial/attributive data acquired by surveying. For
example, parcel boundaries should be closed, without undershoots or
overshoots. Correcting data on input is an expensive process.
There are also developed some cadastral geodatabase models (for
example ISO-TC211 2012: Land Administration Domain Model (LADM),
ESRI Parcel Fabric Model, ILMB Cadastral Fabric Specification and Standard,
etc.), which provides schemas in which a progressive creation and
improvement of a geodatabase can be done. These schemas can be used in the
early stages of a survey to structure the surveying data.

1.2. SPATIAL DATA SOURCES FOR CADASTRE AND
SURVEYING TECHNIQUES
Land Information Systems may comprise of spatial and nonspatial/attributive data (survey plans and registry records). Both these spatial
data (such as parcel boundary and other cadastral objects) and non-spatial data
(such as records of rights, responsibilities or/and restrictions in land and/or
attachments to the land) are stored, maintained, and accessed in the database
environment. Spatial cadastral data is acquired through cadastral surveying
methods which are concerned with geometrical data of each land parcel. The
results of cadastral surveys are isolated plans of a parcel or a subdivision.
Cadastral mapping goes a step further and produces complete maps, which are
based on cadastral surveys.
The cadastral surveying system gives preference to the survey records of
parcel boundary positions over physical locations of landmarks on the ground.
These records provide information with the coordinates of the landmarks and
11

site plans within a particular national geodetic coordinate reference system in a
country. In case of lost or disputed boundary of a land parcel, it is this record or
register that takes the precedence over marks on the ground.
Spatial cadastral data can be obtained by several surveying methods.
These methods can be divided into the sets of direct and indirect techniques.
In case of direct techniques, the relative or absolute positions of control
points (survey marks) is located first on the ground, and then the distance and
angles or coordinates of turning points of parcels/plots are measured using
surveying instruments. If the distance and angles are measured, then
coordinates of turning point’s locations for each land parcel are re-computed
from distance-angles measurements using Coordinate Geometry (COGO)
methods.
On the other hand, in case of indirect techniques, the surveyors use aerial
photographs, digital aerial images, satellite images or/and LiDAR point clouds
to delineate parcel/plot boundaries and the polygons then are digitized in a
second step.
In this module, the direct techniques (field surveying and Global
Navigation Satellite System - GNSS) and COGO methods are discussed. It is
not a main goal of this course to teach ground surveying techniques in detail,
this course is more concerned with how to enter and use survey measurements
in GIS/LIS with COGO and other GIS tools.
Usually, country or regional survey standards (guidelines or instructions)
define survey methods used for preparation of survey plans. Thus, for example,
General Survey Instruction Rules for British Columbia (General Survey
Instruction Rules, 2015) defines that

Cadastral surveys may be conducted using conventional, GNSS,
or other methods, providing the survey accuracy standards are met.

For new surveys consisting of the land surveyor’s own work, the
maximum limit of error is 1:5000 ± 2 cm.

The datum for UTM coordinates must be NAD83 (CSRS).

A surveyor has a choice what techniques to use: it is the
responsibility of the land surveyor to assess which survey method or
combination of survey methods must be used for a particular survey.

However, direct traversing techniques of land boundary lines,
which discussed below, should be the preferred method that is placing
monuments and determining the length and direction of boundaries is by direct
measurement along boundaries.

The position of natural boundaries may be determined by any
survey method that yields an accuracy of 0.5 metres or better. Such methods
12

also can include indirect photogrammetric methods, e.g., aircraft and satellite
images.
Assignment 2 is dedicated to the indirect techniques or use of Remote
Sensing and LIDAR for cadastral survey.
1.2.1. Land Boundary Lines
Real property boundaries exist independently of measurements.
Boundary lines (also commonly called property lines) define the extent of the
legal limits of ownership of any parcel of land.
In initial stages of cadastre’s development, land parcels, especially
smaller, individual holdings were described according to its relative position to
well-known landmarks and by identifying the adjoining landowners, although
the large land settlement companies usually claimed land based on latitudinal
boundaries. The primary means of distinguishing one parcel from another was
the “bounds” system. In many cases of areas of long settlement, the
construction of fences, hedgerows, or other obvious physical signs of the parcel
limits made the task of marking the boundaries less difficult. This “bounds”
system did not require that the size of the parcel be determined in order to
define it.
The new cadastre uses the concept of “metes”. The parcels’ boundaries
are defined by the location of corners. The corners or limits of the land parcels
were physical marks on the ground. In the past, often, a landowner would
simply place set boundary stones to mark a land. Parcel’s boundaries (“metes”)
are defined by measuring the location of the real property corners/marks, along
with the plotting of natural landmarks, artificial monuments, and adjacent
owners. In real property boundaries, it is the physical location of the corners
that is important.
Modern monumentation requirements of corners of parcel’s boundaries
(technical specifications, marking, planting, re-establishment and restoration of
posts) are defined in specifications established by states, provincial and/or
professional surveying organizations. Such requirements for example may
include (National Standards for the Survey of Canada Lands, 2014):


Place monuments on all artificial boundaries being surveyed:
o at each change of direction of straight line boundaries;
o at intervals not exceeding one kilometre for straight line
boundaries;
o at points of intersection with previously monumented boundaries;
and
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o at the beginning and end of curves, at points of changes of
curvature, and at points where straight line boundaries intersect curves etc.

The main purpose of line cutting, blazing, and placement of line
markers is to make boundaries identifiable on the ground. Well cut-out
boundary lines and markers on boundary lines minimize the risk of boundary
encroachments and disputes, support enforcement initiatives …
This record of the distances (metes) and physical limits (bounds) of a
land parcel constitutes a “metes and bounds” description. “Metes and bounds”
descriptions are used to describe the perimeter of property. Beginning at a
point located using the rectangular survey system, “metes and bounds”
descriptions are read forwards, traversing from point to point until the entire
property has been circumscribed, returning at the point of beginning. In metes
and bounds descriptions “commencing,” “beginning at,” and “point of
beginning” are all terms used to describe the starting point for the metes and
bounds description.
The “metes and bounds” description is often used to supplement land
record system descriptions. Metes and bounds descriptions are, of necessity,
redundant. The spatial component of modern cadastre may not include
“bounds” description, but includes “meters” description of parcel’s boundaries.
Traditionally, surveyors recorded parcel boundaries by the use of
bearings and distance dimensions between corners or turning points (Figure 7).
With the advent of high-accuracy GNSS technology, it has become
significantly easier to measure absolute GNSS coordinates to define the
location of parcel’s corners. Accurate coordinates give the closest estimate of
the true location of a corner on the ground and also have error information
indicating the reliability of the coordinates. In a coordinate-based cadaster,
parcel boundaries are defined by coordinates at each parcel corner in addition
to, or instead of, bearings and distances.
Parcel boundaries have typically, followed a three-part process of coming
into being – they are defined by the party who has legal rights in the land; they
are demarcated/marked on the ground by a surveyor in the corners (posts, bars,
pins, pits, mounds); they are delineated on plans and maps. The use of
coordinates is predicated on deleting demarcation from the process – the
boundary is defined and then delineated. To be clear: defining boundaries using
only coordinates means that monuments (markers, control points) are not
placed in the ground to mark the boundaries. Some countries, such as Canada
and Australia, permit a surveyor to not plant monuments to mark corners of
parcels in subdivisions if some conditions are met.
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Figure 7: Plat that shows monuments, bearings and distances

Traditional survey methods used for relocating property boundary
corners may be interpreted in different ways. When different surveyors use
different data to re-establish the location of a boundary, boundary location
disputes can arise. A coordinate provides a unique and unambiguous record of
a corner and can be quickly and accurately relocated with the use of GPS. To
gain maximum benefit from the use of coordinates, a system needs to be in
place within the cadaster that provides a measure of the reliability and accuracy
of coordinates in a parcel boundary fabric. The more accurate and reliable the
coordinate, the higher its weight and influence would be in determining the
location of the boundary in the parcel fabric.
Boundary lines are, more often than not, subject to acts of possession or
acquiescence. Fences, hedges, tree lines, or other physical obstructions
frequently occupy the full length of a real property boundary. These objects,
while clearly indicating the general location of the boundary, make the direct
measurement of the distance between corners quite difficult. Thus, the majority
of boundary dimensions are the result of indirect measurement. As parcel
dimensions are almost always the result of computations based on several
measurements of angles and distances. The actual distance measured was still
15

between offset points. The relationship of the offset points to the corner
monumentation was now more accurately known because of the use of the
modern surveying instruments to measure the angle and distance to the actual
corner.
The land surveyor must be knowledgeable not only in technical aspects
of property boundaries surveying discussed above, but also in legal aspects of
cadastre. Thus considerable experience is required to make decisions on the
"best evidence" of а boundary location. A cadastral surveyor is usually
required to be licenced to cadastral practice by a state, province or professional
association. The land surveyor should be aware about legal issues that can
affect property cоnvеyаnсе process.
When any piece of land changes ownership it cannot be by word of
mouth, but must be done by а written document called а deed. The deed
includes а legal description of the property for which some type of survey is
usually required. The purchaser normally wants to have a plan of the land(s)
described in the offer to purchase. It is also important to see where structures
included in the offer are located on the land. Spatial knowledge of any rightsof-way, easements, highway widenings, and the like are essential. Such title
encumbrances are important as the owner's rights on the lands are usually
severely curtailed. For example, erection of any structure such as even а small
construction may be not allowed even though the land is still owned by the
owner of the lands adjacent to the encumbrance.
The legal principles of establishing properly boundaries are usually
defined by country or province legal documents. These are based on set
definitions of legal terms, deed descriptions or title descriptions, riparian rights
(for lands bordering on water bodies), adverse possession etc.
Deed descriptions include the directions and distances of all lines along
the property boundaries of the parcel of land. The types of corners
monumentation and the area of the parcel may or may not be included. The
deed description is usually in written form, rather than a survey plan.
Surveys for title records involve the detailed boundaries surveys as well
as detailed positioning of the existing buildings on а parcel of land in relation
to the boundaries.
Riparian rights refer to those rights of a property owner of land that
borders on a water body. The rights include the use of the shore and ownership
of land under the water surface and therefore use of the water. The definition of
riparian rights and specifications of shoreline boundary’s survey vary
somewhat from one country/province to another.
16

In addition, the survey techniques and their specifications for carrying
out rural land surveys and urban land surveys can be different in different
countries/provinces (Kavanagh & Mastin, 2012).
Rural land is considered to be land outside the boundaries of cities,
towns, villages, and the like. It usually consists of relatively large areas. Rural
lands are as not as valuable as urban lands on а per unit basis. Therefore, the
property surveys can be done with less accuracy. Control survey networks are
not as dense as in urban areas. Most lands were usually classified as
agricultural and homestead landuse types. The scale of such survey is 1:1,000
at best.
Spatial descriptions of rural land can be done in several forms, such as
written descriptions, “metes and bounds”, and coordinates. Two general types
of boundary surveys are carried out in rural lands. One is the original survey
whereby new property lines are created. The other is а re-survey, which results
in relocating property lines that have been previously surveyed. The principles
for both types are similar in that both have to be located with respect to the
control point’s survey. However, the procedures (monumentation, survey
techniques, accuracy, adjustments etc.) can be somewhat different. Rural land
can be subdivided for the purpose of creation of large lots. Certain principles
are involved in surveying the irregular boundaries of subdivisions in rural
lands, and the surveyor should be aware about these principles.
Urban land surveys differ from rural land surveys. The lands are located
within or adjacent to the city or town boundary. The lot sizes are smaller than
rural land, but the land value is greater than rural lands. Therefore, the surveys
must be carried out with greater accuracy. Re-surveys are simpler and easier
than in rural lands because monumentation is more recent and more permanent
but the conflict between adjacent property owners can be more intensive
because of the higher cost of the land involved.
The boundaries of а land parcel can be described within or adjacent to
city or town boundaries in relation to registered plans, blocks, or lots. The
original township subdivision boundaries have usually been well established.
Consequently, deed descriptions of urban lands usually relate to street locations
and lots within а registered plan of subdivision. Land boundaries can coincide
and be described with lots on the plan of the subdivision (e.g., "Lot 6,
Registered Plan No. 696, Guelph Township, County of Wellington, Province of
Ontario"). Or the properties can be described by “metes and\bounds” with the
point of commencement referred to а lot or block corner shown on the plan.
Either way, boundaries can be related to coordinated monuments/control
points.
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Original urban boundary surveys fall into two categories. The first is the
establishment of the boundary of the area proposed for subdivision. The second
is the establishment of the new lot lines by the town or urban planner. Resurveying of urban lands are seldom done. Re-surveying а urban subdivision is
а considerable challenge, requiring perseverance and understanding.
Boundaries and property rights are linked in a cadastral system. Such
systems answer the following questions (Canada Lands Survey System, 2015):
1)
Who has the right (person, family, corporation, state etc.)?
2)
What type of right exists (ownership, lease, licenses, mortgage,
easement etc.)?
3)
How much is the right worth? What is its value (either monetary
or cultural)?
4)
Where is the right? This is the role of parcel’s boundaries.
5)
What is the type of land use? What restrictions are applied? These
things require parcel’s boundaries to be effectively managed.

1.3. LAND FIELD SURVEYING
Cadastral or land surveying is а general term applied to а number of
different types of surveys. Cadastral surveying deals with the establishment of
parcel’s boundaries of public and private real properties for legal purposes,
land ownership, value assessments etc. It also includes the re-establishment of
existing parcel’s boundaries, measurement of boundaries of new parcels,
subdivision of parcels, establishment of positions of cadastral objects (e.g.,
buildings, drainage features) on ore adjusted to the parcels etc. The legal
boundaries of а parcel of land can be rural, urban, or city.
Land field surveying is one of the techniques to obtain initial spatial
information according to which cadastral plans are formed. Ground teams of
surveyors using surveying methods and instruments undertake field surveys.
The primary function of surveying instruments in the field survey is to measure
distances, angles, heights and/or coordinates. Field survey method, depending
on instruments used, can be extremely accurate, but it involves a lot of time
and resources, including a large number of well-trained land field surveyors
with assistants for a countrywide implementation.
Conventional techniques for field surveying of distances, angles and
heights include the use of plane tabling, sight rule, optical square, levels, the
toise, chain or steel measuring tapes. The steel measuring tape, still called a
“chain,” was state of the art for measuring distances in land boundary surveys
almost until the 1970s.
18

Unlike distances, the measurement of angles developed to a high
precision very early in history. In early days, land surveys were carried out
using simple instruments that essentially consisted of an aiming sight on top of
a plate that had angle readings engraved on it. The surveyor could measure the
angle between two sighted points, aided by a survey assistant holding a vertical
pole on the point. With the help of compasses, the magnetic bearings of the
survey lines are measured. Thus, in chain and compass traversing, the magnetic
bearings of the survey lines are measured by a compass and the lengths of the
lines are measured either with a chain or with a tape.
The logical development was to have plates with horizontal angle
readings enclosed in a metal body, whereby a vertical plate was added in order
to also be able to measure the vertical angle, and an optical sight was quickly
adopted in favour of the sight lines. The main survey tool was born: the
theodolite.
Traditionally, one of the most often used methods for cadaster survey of
land plot/parcels boundaries is tachometry or tacheometry (from Greek for
"quick or swift measure"). Tacheometry is an optical solution to the
measurement of distances and angles. A typical application of tachometry is
the measurement of topographic and cadastral objects.
Tachometry is a method(s) of surveying for the determination of
distance, direction, and relative elevation of a point with respect to the survey
station (a position from which measurements in surveying are made), by a
single observation on a rod/staff/prism or other object at the point. The
tachometry computation uses a single survey station at a control point with
known coordinates.
There are several tacheometry techniques that surveyors can use. These
techniques includes traversing, triangulation, trilateration, cross-resections etc.
Some of these techniques will be discussed in the next COGO section and
associated lab assignment 1.
There are a several methods of tacheometry. The two groups will be
covered in these notes.
1.

Stadia System:

Traditionally a tachymeter or tacheometer was a type of theodolite. A
theodolite was introduced by 1920s into everyday survey work. Theodolite
(Figure 8) is a precision instrument that consists of a movable telescope for
sighting distant target objects, two measurement wheels that work like
protractors for reading horizontal and vertical angles, and bubble levels to
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ensure that the angles are true. In modern theodolites, some mechanical parts
are replaced with electronics.

Figure 8: An optical theodolite, manufactured in the Soviet Union in 1958
and used for topographic surveying

Tacheometric surveys are usually performed to measure the three
dimensional location of points on the landscape so as to produce detail land
plans including contours, or to collect COGO measurements for a cadastral
plan. Observations are usually performed from known survey stations, often
established by traversing will be discussed in the next chapter.
When the telescope is pointed at a target object, the angle of horizontal
and vertical axes can be measured with great precision - to seconds of an arc.
Instead of observing independent bearings for every line of a boundary, a
land surveyor can measure the angles formed at the boundary corners with a
theodolite. The angle between two “horizontal” directions can be reported as
the angle of a property boundary intersection. Real property boundary angles in
corners are measured in the horizontal plane. When surveyors measure angles,
the resultant calculations are typically reported as either azimuths or bearings
(discussed in the next chapter).
Vertical angles are measurements between geometric lines in a vertical
plane. Because real property boundaries are in horizontal plane, vertical angles
rarely find their way into property descriptions. Vertical angles are commonly
measured in order to compute horizontal and vertical distances.
The land surveyor can measure distances with theodolite combined with
a levelling staff to produce a cadastral plan (Figure 9). A levelling staff, also
called rod, is a graduated wooden or aluminum rod, used in connection with a
surveying instrument for measuring. The theodolite is directed at the levelling
staff, held by an assistant surveyor, and the horizontal or vertical distance is
calculated based on readings of the top and bottom stadia hairs on the telescope
view. A land surveyor makes cross hair intercept readings on a levelling staff
manually. As the angle subtended by the crosshairs is known, the distance can
be calculated.
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Figure 9: Surveyor is taking readings on stuff

For example, vertical and horizontal distances can be calculate by using
the following equations with measurements from a fixed hair theodolite
(tachometer) in case of when light of sight is inclined but staff is held
vertically:
𝑓

𝑉 = ( 𝑖 ) ∗ 𝑆 ∗ sin2 (𝜃) /2 + (𝑓 + 𝑐) ∗ sin( 𝜃)
sin2 𝜃 + (𝑓 + 𝑐) ∗ cos(𝜃),

and

𝑓

𝐷 = (𝑖 ) ∗ 𝑆 ∗

where 𝑉 and 𝐷 are the vertical and horizontal distances respectively; 𝑆 is the
staff intercept that is obtained by subtracting the reading given on the staff by
the lower stadia hair from the top stadia hair; 𝜃 is the angle between horizontal
line of sight and middle cross hair; 𝑓 is the focal length of object lens; 𝑐 is
length of image that is the constant distance between a lens focal point and
center of instrument; 𝑖 – stadia interval that is the distance apart of the stadia
lines; values of 𝑓, 𝑖 and 𝑐 are fixed, known and constant for a particular
instrument (Figure 10).

Figure 10: Principles of calculations of a vertical and horizontal distances by
using a fixed hair theodolite (tachometer) in case when light of sight is inclined
but a staff is held vertically

Conventionally, COGO measurements are recorded in the field-booking
sheet/notebooks. Thus, for example, the cross hair intercept readings,
horizontal and vertical angles can be observed by theodolite and recorded and
later can be used to recalculate horizontal distances and elevation heights by
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using the formulas. The horizontal distances, heights and bearings parameters
are necessary to compute the coordinates of the point on which the staff was
placed. Bearings are computed from the horizontal circle reading of theodolite
and a known or adopted reference bearing.
Theodolite tacheometry is a quick way of collecting a large amount of
information with limited accuracy. Current practice is to replace the staff with
an Electronic Distance Measuring (EDM) device for distance measurement,
but if you do not have EDM this is a good method for a field object’s survey.
2.

Electronic Tacheometry:

The stadia procedure is used fewer these days, from the mid-1970s to
today more commonly land surveys and geomatics’ engineers use a
combination theodolite-EDMs (Electronic Distance Measuring devices)
known in jargon as a total station (TPS - total station theodolite). A
theodolite-EDM is able to measure distance, direction, and relative elevation
by reflecting off a reflector’s prism on a metal staff, which is moved around
the site and placed at the points.
The theodolite part of the total station has a lens rather like a telescopic
rifle-sight with cross-hairs which are focused on the prism. The whole
instrument swivels horizontally and the lens swivels vertically too. The total
station is partly based on a principle used in traditional theodolites, where
angles are calculated from vertical and horizontal 360-degree scales. It
combines these with an EDM device. This sends out a tiny light signal (often
a modulated near-infrared light), which bounces back from the prism giving a
time interval that is used to calculate distance. The math behind the operation
is very simple, it is in effect the same as the stadia formulas with the term for
the distance replaced by the measured slope distance (Figure 11). In this case,
𝑉 = 𝐿 ∗ 𝑠𝑖𝑛(𝜃) and 𝐷 = 𝐿 ∗ 𝑐𝑜𝑠 (𝜃),
where 𝑉 and 𝐷 are the vertical and horizontal distances respectively; 𝐿
is the measured slope distance measured by EDM, and 𝜃 is the angle between
horizontal line of sight and prism.
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Figure 11: Principles of calculations of a horizontal distances by using a
theodolite-EDM in case when light of sight is inclined but a prism is held
vertically

EDM instruments include or are connected to a field computer, which
stores readings of measurements and facilitates the processing of the data
electronically. The computer records the slope and horizontal distances,
horizontal and vertical angles from the survey EDM station to the point, and
can perform numerous calculations, including absolute coordinates of the
point, using operating software that is loaded into the field computer (Figure
12). Coordinates are normally sent directly to a data-logger mounted on the
tripod, which can then be downloaded into a computer to produce a plot.
The field computer software is usually includes a number of menus such
as Function menu; Survey menu, COGO menu, Road menu, Level menu etc.
Some functions of these menus are shown in this chapter lab assignment 1.

Figure 12. Total station (electronic theodolite-EDM and field computer on
tripod), prism and prism pole) and electronic measurements of distance
and vertical and horizontal angels

Some total stations can work in reflectorless mode. If the visibility in
the surveying area is good, the coordinates of a cadastral object can be done
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with a laser beam without using a reflector with prism. The laser of the
tacheometer can be pointed at a parcel object (e.g., poles), parcel terminal
points (e.g. fences), and their coordinates can be fixed. Measurements by the
laser speed up the work and make it easier, because an assistant to the
surveyor does not have to walk and move a reflector. In addition, the
measurement with a laser is very convenient when measurements are made in
hard to reach or dangerous locations. However, reflectorless survey can be
less accurate.
There exists on the market also advanced total station machines. Thus,
robotic TPS or self-tracking total stations can be remotely controlled from the
prism and programmed to follow the prism automatically, making surveying a
one-person job - an assistant surveyor, who holds the reflector, can be
eliminated.
Digital photographic imaging TPS contains an integrated metric digital
camera that allows a surveyor to take digital photos to each measured point.
While photographing, the camera can rotate with the telescope of the total
station to take scanning photos whose corresponding orientations are observed
from total station. With software, a surveyor can create 3D point clouds and
stereoscopic images of surveying site.
Grid scanning TPS can move by itself and does not need a reflector
target to measure points by specifying a view window area and setting the
horizontal and vertical intervals of the points to be measured/scanned. Rather
than surveying each individual point, the surveyor only needs to decide the
optimum point interval (grid interval) in order to represent the object with
sufficient accuracy. There is, however, still a big gap between grid scanning
in total stations and laser scanners.
Integrated GPS TPS combines TPS and GPS. Such a high performance
total station with powerful GNSS receiver has no need for control points, long
traverses or resections. The GNSS determine the position of instrument
station. However, GNSS measurements may require longer occupation
periods to do measurements.
Advantages of total station surveying that is the EDM instrumentation
has facilitated the development of tacheometry method of cadastral,
topographic and contour surveying into a very quick operation. It is now
possible to produce plans of large areas that previously would have taken
weeks, in a matter of days. In addition, use of EDMs has greatly increased the
accuracy of the distance measurements. Total stations are able to measure
distances to an accuracy of 2-3 millimeters per kilometer, and angles to 124

second (1°/3,600°) accuracy. One second in an angle is equivalent to the
width of pencil lead at 100 meters.

1.4. COORDINATE GEOMETRY
Coordinate Geometry (COGO) is a method of inputting surveying or
engineering data/measurements into GIS, CAD or mapping software. This
aspect of cadastral data processing is one of the main interests of working with
cadastral data in GIS.
COGO data may be collected in the field using conventional surveying
techniques and instrumentation, or may be derived from existing legal survey
plans/maps, plats, engineering plans, drawings or records.
Data collected in the field consist typically of coordinates of points,
distances and angels (e.g., bearings) between points, and point identifiers (with
possibly additional attributes for these points). The data are observed and
recorded through standard field surveying procedures, such as a traverse,
resections etc. The data may be non-digital (recorded in field notebooks), or
digital (recorded on some sort of total station or data logging device). In the
latter case the digital data will be transferred to office computers through
specialized software. However, non-digital recordings should be manually
added to spreadsheets or directly into COGO software in office computers.
The fundamental type of coordinate transformation that COGO software
does for the surveyors or topographers is the conversion of surveying
measurements (distances, bearings and/or angles) into XY coordinated shapes
(points, lines, arcs or polygons features). COGO software, installed in field
mobile device and/or office computers, use trigonometry with emphasis on
triangle solutions to compute the two or three dimensional coordinates of
points based on bearings, angels and distances.
Thus, for example, using COGO, coordinates of parcel’s corners are
calculated using surveyed bearings, distances, and/or angles from known
reference points. The parcel corners and points of deflection defined by these
coordinates can then be used to plot the boundaries of the parcel that in turn
can be used to define the parcel polygon for incorporation into the cadastral
fabric.
Some cadastral state, regional or local authorities provides guidelines on
how to work and incorporate COGO inputs into the legal integrated cadastral
fabric. For example, COGO output files (e.g., raw and adjusted traverses) must
be retained and submitted as project deliverables. When computing parcel
corner coordinates to delineate missing or suspect parcels, the incorporation
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into the fabric should always start with the newest survey plan information in
an area, etc.
Ideally, the legal cadastral fabric, which incorporate many spatial
datasets, should contain only the parcel geometry was originally created
through COGO computational techniques.
1.4.1. COGO Computations Techniques
There exist many COGO computational techniques and associated
software tools such as the following:

Delta X,Y – construction of point or/and line that is based on a change
(delta) in x and a change in y from an existing construction point;

Bearing(Angle)/Distance – construction of point or/and line that is
based on a bearing/angle and distance from an existing construction point;

Curve or Tangent Curve – construction of curve that is based on two of
the following parameters: chord distance, angle, arc length, radius; or a radius
and arc length, or from an existing construction point;

Distance-Distance intersection – construction of point at the intersection
of two distances from two existing construction points;

Bearing-Bearing intersection – construction of point at the intersection
of two bearings from two existing construction points;

Parallel, Perpendicular, and Deflection - construction of line by adding a
parallel line to an existing line, perpendicular line to an existing line, and
deflection off line to an existing line;

Traverse, that is a series of lines, can be constructed by using the above
COGO techniques.

Triangulation and trilateration etc.
The common COGO computation techniques are discus in more details
below.
Delta XY
Coordinates for a new survey point can be computed based on a known
differences in X and Y coordinates from a given start point (Figure 13). These
coordinate differences are termed delta X, Y. The direction of the computed
coordinates from the start point is defined by the sign of the delta values as
shown below:




Northeast: +X, +Y (as shown above)
Northwest: -X, +Y
Southeast: +X, -Y
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Southwest: -X, -Y

Figure 13: Delta XY computation

Direction-Distance
Coordinates for a new survey point can be computed from an existing
coordinate using known distance and direction values Figure 14).

Figure 14: Direction-Distance computation

When surveyors measure angles, the resultant calculations of directions
are typically reported as either azimuths or bearings, as seen in Figure 15.
An azimuth is an angle between 0° and 360° which is measured
clockwise from the north in most cases. A back-azimuth is the reverse of an
azimuth.
Bearings are measured clockwise or counter-clockwise within a quadrant
by the cardinal directions from the meridian (directed to the north) and are
always less than or equal to 90 degrees. A bearing is an angle from the North
or South end of the meridian turned to the East or West. In case of bearings, the
surveyor defines lines as being east or west of north (NE or NW), or east or
west of south (SE or SW). This method is easily comprehended and widely
favored by most users of real property information.
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Figure 15: Azimuths and bearings. Note that an azimuth of 360° is the
same as 0°.

A bearing notation has three parts:


Prefix - N or S indicating which end of the meridian is turned

from.


the line.

Angle
Suffix - E or W indicating turning direction from the meridian to

For, example, a bearing notation is N 66°40' E means that from the North
end of the meridian, turn 66°40' to the East.
"South 45° East" and "135°" are the same direction expressed as a
bearing and as an azimuth.
The most common datum for boundary directions is “north.” However,
there are a few definitions of the term “north”: true north, magnetic north,
astronomic north, assumed north, geodetic north, north used in a map
coordinate system etc. A surveyor may measure angles on the ground relative
to a particular definition of north. However, during COGO computation, it is
possible to apply corrections between “north” direction used in ground
measurements and “north” direction of coordinate reference system used in
cadastral fabric dataset. The direction offset is an angle that is added to ground
directions to rotate them to used coordinate reference system directions or
reverse.
In addition, a surveyor measures distances on the ground relative to the
local ground elevation. However, distances in coordinate reference system of
spatial data are measured on the ellipsoid. Therefore, the distance factor or a
scale factor is used to multiply ground distances to convert them to ellipsoid
distances or reverse.
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Deflection-Angle-Distance
Coordinates for a new survey point can be computed by defining a
deflection angle offset from a reference direction, and a distance from a
known point. The deflection angle is an angle between a line and the
prolongation of a preceding line; it is a right or left angle depending on
whether the new line is right (clockwise) or left (counter-clockwise) of the
preceding line (Figure 16).

Figure 16: Deflection-Angle-Distance computation

The reference direction is either a bearing or an azimuth, based on a
meridian of coordinate reference system.
Intersections and Resection
When the existing survey points are accessible, but the new point is not
then the survey needs to employ an intersection technique, e.g., DistanceDistance or Bearing-Bearing intersection (Figure 17). When the existing
survey points are not accessible, but the new point is, then the survey needs to
employ a resection technique.
COGO intersection is used to create a new point(s) from the intersection
of dimensions from two known points. For example, a bearing-bearing
intersection creates a point at the intersection point of two bearings from two
known points. It also can be a bearing-distance intersection where two
possible intersection points are created from the intersection of a distance
radiating outward from one known point and a bearing from a another known
point. A new parcel point or construction point can be created from the
intersection of two line distances from known points.
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Figure 17: Intersection computations (Bearing-Bearing, Bearing-Distance
and Distance-Distance)

GOGO resection is a calculation for the coordinates of an unknown or
free station by observing the three established stations or known points from
the unknown point. The two angles from the unknown point will be measured
by accurate sightings to the three traverse stations in the field (Figure 18). All
other angles and distances can be calculated trigonometrically based on the
measured two angels and coordinates of known stations. Resection is
considered as a technique of plain tabling survey.

Figure 18 : Resection computation.

1.4.2. COGO Traverse
A traverse consists of a series of lines, whose lengths and directions are
measured by surveyors in associated connecting points, called traverse stations
(TS) or traverse points, whose X and Y coordinates are to be determined in
some reference system of coordinates (Figure 19). A position of a traverse
station is computed relatively the preceding TS of traverse and starting from a
control point with known coordinates. The route of the traverse line can be
adjusted for obstacles such as rough or timbered terrain, swampy land,
buildings and areas of heavy traffic.
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Figure 19. Traverse diagram

Measuring a series of positions in this way is known as "running a
traverse." Starting at control points, surveyors measure angles and distances to
new locations, and use trigonometry to calculate positions in a plane coordinate
system. A traverse that begins and ends at different locations, in which at least
one end point is initially unknown, is called an open traverse. A traverse that
begins and ends at the same point, or at two different but known points, is
called a closed traverse. By "closing" a route between one known location and
another known location, the surveyor can determine errors in the traverse.
The angles between the traverse stations can be measured by transit,
theodolite, compass, plane table, or sextant. These angles can be interior
angles, deflection angles, or angles to the right. The azimuths or bearings can
be true, magnetic, assumed, or coordinate reference system. The distances
between the traverse stations can be measured by tape, theodolite or EDM. The
lengths are horizontal distances. The lengths and azimuths or bearings of each
line of the traverse are calculated through field measurements.
Traverse field work consists of the following steps:
1)
Select control stations’ positions as close as possible to the objects
to be surveyed.
2)
Mark the stations with monuments in the ground with a precise
point marked on the top of it.
3)
Make angle and distance measurements.
4)
Place signals at each station such as a range pole to be used
for taping and angle measurement.
5)
A traverse may be either open or closed.
Traverse is a method in the field of surveying to establish control
networks, perform tacheometry surveys for topographic and cadastral purposes,
etc. Thus, traverses can be used to find accurate positions of a small number of
marked control stations. From these stations, less precise measurements can be
made to objects to be located without accumulating accidental errors. In this
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case, traverses can be served as control surveys. When drawing cadastral plans,
the stations can be used as beginning points from which to lay out work. When
new parcel subdivisions of any kind are to be made, a system of traverse
stations in the area must be established and surveyed.
Traverse surveys are made for many purposes which include:

To establish supplementary ground control points from which
cadastral objects may be surveyed for preparing various types of cadastral plans
(i.e., establish control);

To re-establish the positions of exiting parcel’s boundary markers;

To survey the positions of parcel’s boundary corners and lines (i.e.,
a land parcel, recreation site, forest plot, or wildlife habitat area);

To establish control and surveying railroads, highways, and other
objects associated with cadastral surveying and other private and public works;

Ground control surveys for photogrammetric surveys.
Open Traverse
An open traverse (Figure 20) originates at a starting control station,
proceeds to its destination, and terminates at a station whose relative position
is not previously known. The open traverse is the least desirable type of
traverse because it cannot be checked for accuracy of field measurements as
errors or mistakes are not revealed. For this reason, the planning of a traverse
should always provide for closure of the traverse. Traverses are closed in all
cases where time permits.

Figure 20. An open traverse

A side-shot course is used to compute a coordinate that is not part of the
main traverse course sequence (Figure 21). A side shot is a single measurement
to a feature, which is to the side of the main traverse line.
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Figure 21. Side-shot in open traverse

The open traverse is suitable for surveying a long narrow strip of land.
Thus, open traverses may be run to establish preliminary trail and road
locations, canal or the coast line.
Closed Traverse
A closed traverse begins at a point and ends at the same point or at a
point whose position is known (Figure 22). Therefore, the position closure
gives an indication of the accuracy in measuring distances as well as azimuths.
Accidental errors made in the measurements can be adjusted. Large errors can
be corrected.

Figure 22. A closed traverse.

The closed traverse is suitable for locating the boundaries of plots, lakes,
woods, etc. and for survey of large areas.
A closed loop traverse is a traverse which starts at a given point,
proceeds to its destination, and returns to the starting point without crossing
itself in the process (Figure 23). The surveyor uses this type of traverse to
provide control of a parcel boundary, and measurements for the area
computation within the boundary. Angels of a loop traverse inside a closed
polygon called interior angles.
A loop traverse is also used if there is little or no existing control in the
area and only the relative position of the points is required. A loop traverse
33

starts and ends on a station of assumed coordinates and azimuth without
affecting the computations, area, or relative position of the stations. If,
however, the coordinates must be tied to an existing coordinate reference
system, the traverse starts from a known control station and azimuth on that
coordinate reference system. While the loop traverse provides some check
upon the fieldwork and computations, it does not provide for a check of
starting data or insure detection of all the systematic errors that may occur in
the survey.

Figure 23. A closed loop traverse

A traverse closed on a second known point (a closed link traverse) begins
at a point of known coordinates, moves through the required point(s), and
terminates at a second point of known coordinates (Figure 24). The surveyor
prefers this type of traverse because it provides a check on the fieldwork,
computations, and starting data. It also provides a basis for comparison to
determine the overall accuracy of the work.

Figure 24. A closed link traverse

In traversing surveying, the following type of angels can be measured:
deflection angles, interior-angles, angles to the right, azimuths, and compasses.
1.4.3. Errors in COGO Traversing
Distances and angles can never be determined exactly; measurements are
subject to error. The precision and accuracy of the bearings and distances
measurements on a survey plan are dependent on a number of factors
including, the method of the survey, required levels of accuracy (first order,
second order, etc.), density and location of permanent control stations, the type
of instrumentation used for the survey, the terrain and topography of the region
etc. Modern equipment (including use of GNSS) result in measurements that
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are more accurate than measurements made with twentieth century equipment.
These variations in measurement accuracy must be considered.
A closure error can be determined for a closed link or loop traverses. In a
closed traverse, a closure error (or misclosure, discloser error) indicates
accuracy of the surveying and potential problems in the original survey data. A
closure error is the amount by which a closed traverse fails to match the true
and computed position of the same point (Figure 25).

Figure 25. A closure error

X and Y coordinates of the end control point can be calculated through a
series of calculations of the coordinates of each station by using the measured
horizontal distances and adjusted angles/bearings. The difference between the
calculated and known coordinates of the end control point is 𝑑𝑥 and 𝑑𝑦 that is
the closure error in X and Y coordinates (northing and easting). Closure error
of can be calculate as the following:
𝐸𝑐𝑙𝑜𝑠𝑢𝑟𝑒 = √𝑑𝑥 2 + 𝑑𝑦 2
The relative accuracy of distance measurements can be expressed using
the following equation. An angular error of one minute is equivalent to a
distance measurement error of 3 cm over a distance of 100 m.
𝑃𝑟𝑒𝑐𝑖𝑠𝑖𝑜𝑛 𝑜𝑟 𝑟𝑒𝑙𝑎𝑡𝑖𝑣𝑒 𝑎𝑐𝑐𝑢𝑟𝑎𝑐𝑦 =
of the traverse.

𝐸𝑐𝑙𝑜𝑠𝑢𝑟𝑒
𝑙

, wher 𝑙 is the total length

The closure of a loop traverse can be computed based on the latitudes and
departures of each of its sides. The latitude is the Y-component of the side-line
(or its projection on the Y-axes) and the departure is its X-component of the
side-line (or its projection on the X-axes). When latitudes are added together,
the resulting error is called the error in latitudes (𝑑𝑦). The error resulting from
adding departures together is called the error in departures (𝑑𝑥)
The closure error in a COGO traverse could be the result of:





Measurement precision
Mistyped values
Incorrect values in the source
Measurement error (systematic and random) etc.
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Once the measurement data is deemed to be free of human accidental
errors and the rough closures are considered to be acceptable, the traverse may
be balanced and adjusted. Misclosure caused by numerical precision or
measurement error can be solved by applying an adjustment to distribute the
error through each of the courses. The most common methods of “balancing a
traverse” are the compass rule, the transit rule, Crandall’s rule, and the least
squares adjustment. The least squares adjustment is considered a rigorous
method, and other three as approximate methods.
All these methods distributes errors according to one of the
following adjustment methodologies.

In the Compass rule assumes that the error of closure is a result of
accidental errors affecting angular and linear measurements equally (or that
angles and distances are measured with equal accuracy so error is applied to
each).
The compass rule, also known as the Bowditch rule, distributes the
misclosure in the northings and eastings in proportion to the distance along all
the courses from the first point to each of the unadjusted coordinate locations.
This method is based on assumptions that the errors in linear measurements are
directly proportional to √𝑙 and that the errors angular measurements are
inversely proportional to √𝑙 , where 𝑙 is the length of the traverse. More
specifically, a correction factor is computed for each point as the sum of the
distances along the traverse from the first point to the point in question, divided
by the total length of the traverse. The correction factor at each point is
multiplied by the overall closure error to get the amount of error correction
distributed to the point's coordinates.

The Transit rule assumes that the error of closure is a result of accidental
errors and that the effects of errors in distance measurement are greater than
the effects of errors in angular measurements (or that angles are measured more
accurately than distances; distances receive greater adjustment).
The transit rule distributes the closure error by changing the northings
and eastings of each traverse point in proportion to the northing and easting
differences in each course. More specifically, a correction is computed for each
northing coordinate as the difference in the course's northings divided by the
sum of all the courses' northing differences. Similarly, a correction is computed
for each easting coordinate using the easting coordinate differences. The
corrections are applied additively to each successive coordinate pair, until the
final coordinate pair is adjusted by the whole closure error amount. After the
adjustments are made, revised lengths and bearings for the various traverse
lines are computed trigonometrically.
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Usually, observed angles are balanced for angular misclosure prior to
applying a transit rule adjustment. The angular error of closure (if acceptable
for the survey instrumentation used) in the traverse is evenly distributed
through each deflection point leaving closing bearings between control points
unaltered. The transit rule is used infrequently.

The Crandall rule assumes that the error of closure is a result of
accidental errors and the effects of errors in angular measurements are
negligible or have already been adjusted out of the traverse. It further assumes
that any adjustment should be applied only to the lengths/distances of the
courses (or that angles are held and errors are statistically distributed into the
distances).
Crandall’s rule was an attempt to apply the concepts of probability to
error correction. According to this rule, errors in long distances are more
probable than in short distances, and errors in distances in general are more
probable than errors in angles. The Crandall rule is most frequently used in a
closed traverse that represents a parcel from a subdivision plan to ensure that
tangency between courses remains intact as, for example, when applied to a
tangent curve. This method uses a least-squares adjustment to distribute the
closure error, and applies infinite weight to the angles or direction
measurements to ensure that they are not adjusted. In some circumstances the
results of this adjustment method may be unexpected, or the adjustment may
not be possible, and an alternative method is required.

The Least Squares adjustment assumes that the error of closure
is a result of accidental errors. Least Squares adjustment requires redundant
observations.
The Least Squares adjustment theory states that, for any set of measured
values, the best set of corrections to apply to the measured values is one such
that the sum of the squares of all of the corrections is minimized.
Unlike the above thee rules, in the Least Squares adjustment, the angles
of the traverse are not adjusted prior to beginning the least squares procedure.
Angles and distances are adjusted simultaneously, based on that the sum of
the squares of all of the corrections is minimized. The procedure renders
consistent and reliable results in proportion to the quality of the measurements
made.
To minimize introduced distortion, least squares adjustment should only
be applied against fabric of high positional and relative accuracy. The least
squares adjustment is the most commonly used method of adjusting measured
values.
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These techniques are used only to distribute accidental or random errors
of observation. Each assumes that the observations are free of blunder and
systematic errors. In general, the Transit rule is not recommended. The
Crandall method and the method of Least Squares are computationally
complex and are generally not required for simple traverse adjustments. In
most cases, a Compass rule adjustment is sufficient for cadastral mapping
purposes.
In most cases it should not be necessary to re-balance and re-adjust data
from a single plan. However, when a plan should be integrated into a parcel’s
subdivision or cadastral fabric network, it may be necessary to re-balance and
re-adjust traverse surveys. When linking adjacent surveys into cadastral fabric,
it may be necessary to re-define parcel’s perimeter boundaries by balancing
and adjusting data from a number of underlying and adjoining plans to affect a
closure and reconcile discrepancies.
1.4.4. Triangulation and Trilateration
The triangulation surveying method is based on the trigonometry that if
one side and three angles of a triangle are known, the remaining sides can be
computed. Furthermore, if the direction of one side is known, the directions of
the remaining sides can be determined. A triangulation system consists of a
series of joined or overlapping triangles in which a random side is measured
and remaining sides are calculated from angles measured at the corners of the
triangles. The corners of the triangles are known as triangulation stations. The
side of the triangle whose length is measured, is called the base line. The lines
of triangulation system form a network of triangles and triangulation stations
(Figure 26). Before survey-grade satellite positioning was available,
triangulation was the most common technique for establishment of horizontal
control survey network.
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Figure 26. Principle of triangulation network and an example of single chain of
triangles

A trilateration network also consists of a series of joined or overlapping
triangles. However, for trilateration the lengths of all the sides of the triangle
are measured and few directions or angles are measured to establish azimuth.
Trilateration has become feasible with the development of EDM devices,
which has made possible the measurement of all lengths with high order of
accuracy under almost all field conditions.
The main objective of triangulation or trilateration surveys is to provide a
number of control stations whose relative and absolute positions, horizontal as
well as vertical, are accurately established. More detailed topographic, cadastral
or engineering survey are then carried out from these stations.

1.5. GLOBAL NAVIGATION SATELLITE SYSTEM
Global Navigation Satellite System (GNSS) is a term used for the
infrastructure that includes a constellation of orbiting satellites stations with
worldwide coverage, which are working in conjunction with a network of
ground stations and Satellite-Based Augmentation Systems. This infrastructure
allows determination of the geographic position, distance, direction, velocity
and local time of a user's receiver anywhere in the Earth (on surface or in air)
by processing signals from satellites in space. GNSS can be used for civil and
military applications.
Currently, the following GNSS systems are operational:
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GPS (United States): the first GNSS, also known as NAVSTARGPS: NAVigation System with Timing and Ranging Global Positioning
System: fully operational since 1993, is managed by the US Department of
Defence (DoD). It now uses a constellation of between 24 and 32 satellites, and
provides global coverage.

GLONASS (Russia): the GNSS is completed in 1995 and fully
operational since 2011, is managed by the Russian Aerospace Defence Forces.
The full GLONASS constellation consists of 24 satellites, and provides global
coverage.
The following GNSS systems are in varying stages of development and
planning:

Galileo (European Union): Europe’s GNSS, currently under
development as the only civil GNSS, is owned and managed by the European
Union. When complete, it will consist of 30 satellites.

Compass (China): the Chinese GNSS, set to supersede the
Compass regional system operating since 2000, is managed by the
governmental China Satellite Navigation Office. The system will consist of 35
satellites. A regional service is provided by 2010; the service will be extended
to provide global coverage in the years 2015-2020.
The following regional navigation satellite systems are planned and are
in varying stages of development:



IRNSS (India)
QZSS (Japan)

Satellite-Based Augmentation Systems (SBAS), for example, such as
EGNOS (Europe), WAAS (North America), GAGAN (India) and MSAS
(Japan), are geostationary satellite systems that provide services for improving
the accuracy, integrity, and availability of basic GNSS signals.
1.5.1. The use of GPSS for Cadaster
Surveying for cadastral purposes normally requires an accuracy in
absolute position of 10 cm. This accuracy and higher (up to 1 cm) can be
easily achieved utilizing GNSS observations of survey grade GNSS receivers.
Thus, the high precision of GNSS carrier phase techniques, together with
appropriate adjustment algorithms and differential corrections, which are
discussed below, provide an adequate accuracy of cadastral surveying with
using GNSS.
In current cadastral surveying practice, GNSS is often used in
conjunction with traditional surveying methods to provide sufficient
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information to fix boundaries, marks and occupations which are needed to
create or to update a cadastral plan.
GNSS receivers can be used to position survey markers, parcels
boundaries and corners, buildings, and other objects related to a cadastral
survey. Probably the main use of GNSS in a cadastral survey is an absolute
coordinate surveying of control points or tacheometric stations. For example,
control points measured by GNSS can be used as start and end points of total
station traversing. Or, as is shown in Lab Assignment 1, the GPS point
network can be used for the positioning and orientation of a tacheometer at a
survey control station from which the plot’s boundary are measured by
tacheometric techniques.
GNSS instruments can also be used to measure corners and tuning
points of a plot’s boundary directly. However, GNSS measurements may
require longer occupation times to do measurements on a point. An
occupation time is the amount of time required to allow satellite acquisitions
on a station, or point, and to achieve successful processing of GNSS data.
Higher precision typically requires a longer occupation time. Occupation
times can vary from a couple of seconds (kinematic surveys) to several hours
(control surveys). Therefore, for cadastral surveying, it could be more timeeffective to establish control points with GNSS, but perform cadastral
boundary surveying with a total station. For such a method of surveying an
integrated GPS TPS can be used. However, kinematic and rapid-static GNSS
surveying techniques do not require excessively long occupation times and
can provide accurate cadastral maps in a relatively short period of time and
can be reasonably inexpensive.
One advantage of GNSS surveying is that it provides absolute
measurements of coordinates in a predefined coordinate reference system.
However, for the very accurate GNSS measurements differential or a relative
position to base station(s) are required. In addition, GNSS survey techniques
can be more accurate than conventional tacheometry.
All GNSS cadastral surveys must be undertaken in accordance with
accepted good survey practice such as GNSS observation procedures, and
should be designed to detect and eliminate GNSS-related surveying errors.
GNSS data processing and mission planning software are available on
the market/Internet or supplied with GNSS devices. The software provides a
capability to process GNSS observations captured by receiver(s) and then
export data files in a number of different GIS/CAD formats. Then the GNSS
data can be represented in a graphical form to draw parcel boundaries with
dimensions derived from the GNSS coordinates.
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1.5.2. Components of Global Navigation Satellite System
GNSS satellite systems consist of three major segments or components:
space segment, control segment and user segment (Figure 27). These segments
are quite similar in the three major satellite technologies (GPS, GLONASS and
Galileo).

Figure 27. Components of Global Navigation Satellite System.


The space segment consists of a number of GNSS satellites
that are orbiting more than 20,000 km above the Earth. GNSS satellites
typically fly in medium Earth orbit. Satellites orbit the earth in an
elliptical path. Earth becomes the focal points link.
Each GNSS has its own “constellation” of satellites, arranged in
orbits to provide the desired coverage. Each satellite in a GNSS
constellation broadcasts a signal that identifies it and provides its time,
orbit, and status.
Satellites of SBAS also can be considered as a part of the space
segment. SBAS satellites usually use the geostationary orbits. The term
geostationary is used to refer to the special case of a geosynchronous orbit
that is circular (or nearly circular) and at zero (or nearly zero) inclination, that
is, directly above the equator. Satellites in geostationary orbits appear
stationary at one location at all times.
 The control segment comprises a ground-based network of master
control stations, data uploading stations, and monitor stations.
Monitor stations, usually installed over a broad geographic area,
monitor the satellites' signals and status, and relay this information to the
master control station. The master control station analyses the signals then
transmits orbit and time corrections to the satellites through data uploading
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stations. The master control station corrects the satellites' orbit parameters and
onboard high-precision clocks when necessary to maintain accuracy.
 The user segment of GNSS consists of military and civilian users
who use GNSS equipment to process the received signals from the GNSS
and/or SBAS satellites to derive and apply location, velocity, direction and
time information. The equipment ranges from handheld receivers used for
navigation, to sophisticated, specialized receivers used for survey and
mapping applications.
Satellite signals require a direct line to GNSS receivers. Trees,
buildings, bridges, mountain ranges, and your body can all block the satellite
signals. Heavy forest canopy causes interference, making it difficult to
compute positions. Signals cannot penetrate water, soil, walls or other
obstacles.
1.5.3. Basic Principles of GNSS Measurements
The basic idea behind of satellite-based navigation systems is that they
use a version of trilateration to locate a user’s receiver, through calculations
involving information from a number of satellites. Each satellite transmits
coded signals at precise intervals. A GNSS receiver on or near the earth's
surface uses these signals to calculate the distance between it and the
transmitting satellite (from the transmission time delay). Coordinating current
signal data from four or more satellites enables the receiver to determine its
position, velocity, and time.
GNSS radio signals are quite complex. Their frequencies are around 1.5
GHz (gigahertz) - 1.5 billion cycles per second – it is a portion of UHF (Ultra
High Frequency) radio waves of the electromagnetic spectrum. GNSS operates
at frequencies that are higher than FM radio, but lower than a microwave oven.
In general, GNSS satellites transmit signals at extremely low power levels.
Because of their frequency and low power, the signals have a relatively limited
ability to penetrate tree canopy, water, soils, building walls, or other obstacles.
GNSS signals will be discussed in detail below.
By knowing exactly where each GNSS satellite is, and how long it has
been since the signal was emitted, a GNSS receiver can calculate the distance
to the satellite. The receiver calculates how long the tracked satellite signal
took to reach it, as follows:
𝑇 (𝑝𝑟𝑜𝑝𝑎𝑔𝑎𝑡𝑖𝑜𝑛 𝑡𝑖𝑚𝑒) = 𝑇𝑖𝑚𝑒 𝑆𝑖𝑔𝑛𝑎𝑙 𝑅𝑒𝑎𝑐ℎ𝑒𝑑 𝑅𝑒𝑐𝑒𝑖𝑣𝑒𝑟 – 𝑇𝑖𝑚𝑒 𝑆𝑖𝑔𝑛𝑎𝑙 𝐿𝑒𝑓𝑡 𝑆𝑎𝑡𝑒𝑙𝑙𝑖𝑡𝑒

Since the speed of light, 𝑐, is approximately 300,000 km/s in a vacuum, a
receiver can calculate the distance or range 𝐷 to the satellite by using
𝑃𝑟𝑜𝑝𝑎𝑔𝑎𝑡𝑖𝑜𝑛 𝑇𝑖𝑚𝑒. Since 𝐷 = 𝑐 ∗ 𝑇, it can calculate the distance to the
43

satellite. If the propagation time was calculated as 0.07 seconds, the distance or
pseudo-range to a satellite from a receiver can be calculated as follows:
If 𝐷 = 𝑐 ∗ 𝑇, and 𝐷 = 300,000 𝑘𝑚/𝑠 ∗ 0.07 𝑠 then 𝐷 = 21,000 𝑘𝑚

A pseudo-range is a range estimated from the time rather than a true
range.
Of course, this is estimated calculation, since the speed of light slows
slightly, and is refracted when it enters a medium such as the Earth’s
atmosphere. Differing levels of atmospheric pressure cause differing amounts
of refraction as the radio signal penetrates more deeply into the Earth’s
atmosphere.
In order to calculate the position of user’s receiver (or coordinates of
point on the Earth), the receiver should know the exact position of three
satellites and the exact distance to each of them. Therefore, with GNSS,
trilateration refers to measuring the distances (ranges) from 3 satellites to
establish a position of a receiver on the Earth.
In Figure 28C, the positions of the three satellites are known exactly, and
the receiver can calculate D1, D2, and D3 by the time it takes the radio signal
to reach the GNSS receiver. Three distance measurements narrow down the
receiver position to just two points. Usually the receiver can discard one of the
last two points because it is nowhere near the Earth. Three distances plus
Earth’s surface define one point - the X and Y coordinates of the GNSS
receiver on an ellipsoid. Four distances define one point as well, however
distances from four 4 satellites can be used for 3D positioning - the X and Y
coordinates on an ellipsoid and height above the ellipsoid (ℎ).

A: The GNSS
receiver locks on to
one satellite and
calculates the range
to be for example
22,000 km. This fact
helps narrow the

B: Now, consider that the
receiver picks up a signal
from a second satellite and
calculates the range between
the receiver and the satellite
to be 26,000 km. That means
the receiver is also

C: When a GNSS receiver is locked
onto 3 satellites, its position is
somewhere at the intersection of 3
circles which result from the
intersection of three spheres. Only
two possible points (red) lie at the
intersection of these three circles
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receiver location
down, but it only tells
us that the receiver
are somewhere on a
sphere which is
centered on the
satellite and has a
22,000 km. Many of
the locations on that
sphere are not on
earth, but out in
space.

somewhere on a sphere with
26,000 km radius with the
second satellite at the center.
The receiver must, therefore,
be somewhere where these
two spheres intersect. When
the two spheres intersect, a
circle is formed, so the
receiver must be somewhere
on that circle.1, 2 satellites no lock, course

3 Satellites - 2D positioning Earth’s surface assumed

Figure 28. Geometry of the GNSS satellites

In order to transmit the exact time as part of the GNSS signal, each
satellite must keep very precise time. To do this, GNSS satellites make use of
atomic clocks that is very precise but also very expensive ($100,000 and more).
All satellite clocks are synchronized and they send their codes at a known time.
However, receivers contain clocks similar to a quartz watch, which is not
very accurate. Normally a quartz crystal can lose a second a day, thus there is
always an error between satellite and receiver clocks. This error is called
timing offset (∆𝑡).
Thus, the first three measurements narrow down a GNSS position. Three
ranges are enough if we reject ridiculous answers. The fourth measurement is
needed to correct for timing offset (difference in synchronization between
satellite and receiver clocks). An extra 4th satellite’s range measurement
removes timing offset errors. Distances to four satellites enable the receiver to
resolve ambiguity in spatial positioning.
There are four unknowns: the receiver coordinates (Latitude, Longitude
and Altitude) and the receiver clock offset. Four measurements are needed to
solve the equation. In order to solve for these four unknowns, pseudo-range
measurements must be taken to a minimum of four satellites to triangulate the
position of the receiver.
1.5.4. Global Positioning System (GPS)
As of today, the complete satellite technology is the GPS technology and
most of the existing worldwide applications related to the GPS technology.
Therefore, this technology will be discussed in more detail in this manual.
The Global Positioning System (GPS or originally known as NAVSTAR)
is a worldwide radio-navigation system formed from a constellation of 24
satellites and their ground stations. The GPS can be used to locate positions
anywhere on the earth. Operated by the U.S. Department of Defense (DoD),
GPS provides continuous (2 hours/day), real-time, 3-dimensional positioning,
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navigation and timing worldwide (Figure 29). Any person with a GPS receiver
can access the system, and it can be used for any application that requires
location coordinates.

Figure 29. GPS satellite constellation.

GPS Space Segment: The first GPS satellite was launched by the U.S.
Air Force in early 1978. The current GPS constellation consists of 24 satellites
plus spares, located in 6 orbital planes, which are inclined 55 degrees to the
equator. As of August 17, 2015, there were 31 operational satellites in the GPS
constellation. The GPS constellation is a mix of old and new satellites (Block’s
generations). See the official U.S. Government information about GPS page
satellites at http://www.gps.gov/systems/gps/space/.
There are four satellites in each of 6 orbital planes. Each orbital plane
crosses the equator at 60 degrees from the next plane, so the orbits cross at 17,
77, 137, 197, 257, and 317 degrees. The system is designed to maintain full
operational capability even if two of the 24 satellites fail.
Each satellite orbits at 20,200 km altitude. The orbits are very high so
that they are stable and predictable. If the orbits were lower, friction from the
Earth’s atmosphere would eventually alter the orbit of the satellite. Each
satellite orbits the Earth every 11 hours 56 minutes, which means that they pass
over any point on the earth about twice a day. The satellites rise (and set) about
four minutes earlier each day, and are synchronized with the celestial sphere.
Each satellite is about the size of a car, and weighs 860 kg. The satellites
are powered by solar panels, which rotate to follow the sun, and are used to
charge Nickel-Cadmium batteries for times when the satellite is in the Earth’s
shadow. The satellites have two important types of equipment on board –
atomic clocks and radios/antennae to transmit the signal to Earth. On board
each GPS satellite are four atomic clocks, only one of which is in use at a time.
GPS Satellite Signals: GPS satellites broadcast in the UHF portion of
the electromagnetic spectrum. The radio waves that they emit are governed by
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the same rules that affect all other forms of light. Because GPS supports
multiple military and civilian applications, each satellite transmits multiple
signals on multiple frequencies to support the different services offered. The
same is true for the Galileo and GLONASS systems.
Each GPS satellite is sending out signals with the following content: the
satellite’s ID, position and time stamp. In addition, each satellite sends a
navigation message about the position of other satellites (ephemeris and
almanac data) used in GPS receivers for later calculations. This content is
modulated onto a carrier frequency signal in order to be sent from the satellite
to the receiver.
GPS satellites currently emit in five frequencies carrier channels, which
are identified as L1 to L5. The frequencies, availability, and applications of
these carrier channels are described in Table 1. The carrier signal is controlled
by atomic clock. All carrier radiofrequencies and codes are generated from the
same 10.23MHz crystal whose long term stability is controlled by Cesium or
Rubidium clock (older satellites). 10.23 MHz is fundamental frequency in
GPS.
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Table 1. Signals used in GPS Satellites, their frequencies, application, and
current availability
Channel

Frequency
(MHz)

Original usage

Modernized usage

Availability

Encrypted precision P(Y) code

L1

1575.42
(10.23×154)

Contains 2 positioning codes:
C/A (Coarse/Acquisition) and P
(Precise) code. Also contains
the navigation message, which
is contained within the C/A
code.

C/A, L1 Civilian (L1C),
and Military (M) code

All Satellites

Encrypted precision P(Y) code

L2

L3

L4

L5

1227.60
(10.23×120)

1381.60
(10.23×135)

1379.913
(10.23×1214/9)

1176.45
(10.23×115)

Contains P (Precise) Code
(redundant transmission of
same code as in L1 signal).
This channel is also used to
measure ionospheric delay in
military receivers.

C/A code has been added
on this channel in newer
satellites (L2 Civilian
(L2C) code) and Military
(M) code

Nuclear weapons monitoring.
Used to detect when missile
launches, nuclear detonations,
and
high-energy
infrared
events are detected

The same

Block IA and
above

(No transmission)

Additional
Ionospheric
correction
signal
for
improvement of GPS
accuracy

Block IIR and
above
satellites

(No transmission)

Safety-of-Life
signal.
Used
for
aircraft
navigation.
Within
protected band with little
radio interference.

Block IIF and
Block III GPS
Satellites

All Satellites

For example, the L1 carrier signal at 1575.42 MHz (10.23 MHz × 154)
frequency, is modulated with C/A code, P(Y) code and navigation message
(Figure 30). L1C code will be launched soon as a fourth code of L1 carrier
signal and will be used as a common civil signal for GPS, Galileo, QZSS and
BeiDou GNSSs. Figure 31 shows how these signals are combined.
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Figure 30. Multiplexing of C/A, Navigation Message, and P code into L1 signal

There are two basic kinds of GPS ranging codes (codes used to
determine 𝑝𝑟𝑜𝑝𝑎𝑔𝑎𝑡𝑖𝑜𝑛 𝑡𝑖𝑚𝑒): these are Coarse Acquisition (C/A) and
Precise (P) codes. C/A-code and P-code are used for the satellite clock reading,
both are characterized by a pseudorandom noise (PRN) sequence. Current C/A
and P(Y) code-signals are broadcast on both the L1 and L2 frequency carriers.
C/A Code is modulated into the L1 signal (and L2 since 2014) and
available to civilian users. The course acquisition code chip rate (rate at which
the phase might change) is 1.023 MHz. C/A Code provides Standard
Positioning Service (SPS). Using the SPS one can achieve 15 meter horizontal
accuracy 95% of the time. This means that 95% of the time, the coordinates
you read from your GPS receiver display will be within 15 meters of your true
position on the earth. Using C/A code on both frequencies (L1 and L2) and
additional techniques, a GPS receiver can achieve better accuracy.
C/A Code (as well as P-code) is a repeating Pseudo Random Noise
(PRN) code. The codes consist of a sequence with the states +1 or -1,
corresponding to the binary values 0 or 1 (Figure 32) information. Each
satellite has its own PRN sequence or code. PRN is generated from a "seed"
number by algorithm. The algorithm is conveyed in the navigation message
from the satellites to a receiver. By using the algorithm received from satellites,
a GPS receiver generates the identical C/A code as the satellite. Thus the
receiver can separate the signals of each of the satellites by PRN code and plus
use the code to determine 𝑝𝑟𝑜𝑝𝑎𝑔𝑎𝑡𝑖𝑜𝑛 𝑡𝑖𝑚𝑒.
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Figure 31: Example of Pseudo Random Noise code and C/A code modulation

In April 2014, the new L2C-code was added to the L2 frequency. L2C is
the second civilian GPS signal, which can be combined with L1 C/A in a dualfrequency receiver, to enable ionospheric correction to increase accuracy.
Dual-frequency GPS receivers can achieve the same accuracy as the military
receivers.
L1C is the fourth civilian GPS signal, designed to enable interoperability
between GPS and international satellite navigation systems. L1C is not fully
implemented yet.
P (Precise) code, used for the Precise Positioning Service (PPS), is
available only to the military and authorized users, the P(Y) code is classified.
The P-code rate is 10 times higher than C/A code and is 10.23 PRN code. Pcode has the anti-spoofing mode: Virtually anybody can generate a correct C/A
code, so it is quite easy to throw off the GPS position. The actual P-code is not
directly transmitted by the satellite, but it is modified by a Y anti-spoofing
code, which is often referred to as the P(Y) code. A GPS receiver with a
cryptographic key can decode Y-Code to produce P-Code. Being able to
decode a signal allows a user to be sure that it is a "real" GPS signal. Y-code is
also 10.23 MHz derived by multiplying P-code by ~20KHz code.
Using C/A code and P-code on both frequencies, a GPS receiver can
achieve better accuracy. Additional techniques can increase the accuracy of
both C/A code and P code GPS receivers.
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Figure 32: P-code modulation

Figure 33: Composite: Sum of C/A and P code

The M-code GPS signal was first broadcast from the GPS Block IIR14(M) satellite that was launched on September 25, 2005. All new GPS
satellites transmit M-code as well as the P(Y)-code signal. M-code is an
integral part of GPS modernization and the key enabler for the US Defense
Department’s Navigation Warfare program.
In addition to the PRN code, the navigational message is modulated into
the signal. Navigational message data modulation is implemented by changing
the sign of code at a rate of 50 bits/second. The GPS navigational message is
used for prediction of orbital parameters and contains two different pieces of
information – ephemeris data and almanac data. After turned on, a GPS
receiver must update its almanac and ephemeris data and store it in memory.
Ephemeris data tells the GPS receiver where each GPS satellite should be
at any time throughout the day. Satellite position (ephemeris) must be known
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as a reference for range measurements. Ephemeris data is a set of parameters
that can be used to accurately calculate the location of a GPS satellite at a
particular point in time. This information is accurate to many decimal places.
Satellites are launched into precise and very predictable orbits. US
Airforce measures error in ephemeris (satellite position and speed) when they
fly over the Colorado Springs control station. Corrected ephemeris information
is sent up to the satellite, to be transmitted to users’ receivers along with the
PRN signals.
To accurately calculate a receiver location, ephemeris data is only usable
for a limited time. Ephemeris records are updated every hour. Up-to-date data
is needed to minimize error that results from minor variations in a satellite's
orbit.
After using all of these parameters, corrections to satellite coordinates at
signal transmission time are calculated. Satellite coordinates refer to the WGS
84 system.
Satellite almanac data are used by GPS receivers to predict positions for
the satellites (ephemeris). Almanac information is constantly transmitted by
each satellite. It has information about the orbits of the entire GPS 24-satellite
constellation. It is sent along with position and timing messages. A GPS
receiver uses the almanac to establish the availability and position of each
satellite it is tracking. Almanac information is less accurate than the ephemeris.
It is valid for about 30 days and updated every 6 days or less.
Almanac information includes data about the state (health) of the entire
GPS satellite constellation, coarse data (including coordinates) on every
satellite's orbit, and satellite clock correction parameters. A complete almanac
file in GPS memory helps a ground GPS receiver acquire a signal and
determine an initial position more rapidly; used to predict satellite visibility at a
particular location; used in mission planning software etc.
GPS Coordinate Systems: The Cartesian coordinate system of reference
used in GPS/GLONASS is called Earth-Centered, Earth-Fixed (ECEF). ECEF
uses three-dimensional X,Y,Z coordinates (in meters) to describe the location
of a GPS receiver or satellite. The origin (0,0,0) of Earth-centered reference is
located at the mass center of gravity (determined through years of tracking
satellite trajectories). The axes of reference are fixed with respect to the earth
(that is, they rotate with the earth). The Z-axis pierces the North Pole, and the
XY-axis defines the equatorial plane.
The ECEF coordinates are converted by receiver into reference ellipsoid
geodetic coordinates of Latitude, Longitude, and Altitude by using the
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equation-based method. GPS measurements are calculated by GPS software in
the geographic coordinate system of WGS84 datum with Geodetic Reference
System 1980 (GRS) ellipsoid (ECEF). Then, a receiver or office GNSS
software can transform satellite coordinates to other coordinate systems,
NAD83, УСК–2000, etc.
The height determined by GPS measurements relates to the perpendicular
distance above the reference ellipsoid and not the elevation above geoid or
Mean Sea Level (MSL).
GPS Control Segment: The GPS-System is controlled by the US DoD
(Department of Defence). The current operational GPS control segment
includes a master control station, an alternate master control station, 12
command and control antennas, and 16 monitoring sites. A master control
station is located at Falcon Air Force Base in Colorado Springs, CO.
The GPS control stations measure the satellite orbits precisely. Any
discrepancies between predicted orbits (almanac) and actual orbits, and clock
(time) information are transmitted back to the satellites. The satellites can then
broadcast these corrections, along with the other position and timing data, so
that a GPS receiver on the earth can precisely establish the location of each
satellite it is tracking.
GPS User Segment: The U.S. military uses GPS for navigation,
reconnaissance, and missile guidance systems. Civilian use of GPS developed
at the same time as military uses were being established, and has expanded far
beyond original expectations. There are civilian applications for GPS in almost
every field, from surveying to transportation to natural resource management to
agriculture.
1.5.5. GLONASS (Global'naya Navigatsionnaya Sputnikovaya
Sistema)
GLONASS (Globalnaya Navigatsionnay Sputnikovaya Sistema) is the
Russian Federation's GNSS. The Ministry of Defense of the Russian
Federation operates GLONASS.
The nominal GLONASS Space Segment consists of 24 operational
satellites and several spares. The satellites are placed into nominally circular
orbits with target inclinations of 64.8 degrees and an orbital radius of 19,100
km. This results in an orbital period of 11 hours 15 min 44 sec. Eight evenly
spaced satellites are arranged in each of three orbital planes, inclined at 64.8
degrees to the equator and spaced 120 degrees apart (Figure 34). The
constellation of 24 satellites provides a continuous and simultaneous visibility
of at least five satellites over more than 99% of the earth surface. GLONASS
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provides three-dimensional position and velocity determinations based upon
the measurement of transit time and Doppler shift of radio frequency (RF)
signals transmitted by GLONASS satellites.

Figure 34. GLONASS satellite constellation

The GLONASS satellite signal identifies the satellite and includes:
positioning, velocity and acceleration information for computing satellite
locations; satellite health information; offset of GLONASS time from UTC
(Coordinated Universal Time); almanac of all other GLONASS satellites.
GLONASS has its own time scale called GLONASS time, which is
synchronized within 1 second of UTC time. The navigation message has the
data necessary to convert between GLONASS time and UTC time.
GLONASS satellites each transmit on slightly different L1 and L2
frequencies, with the P-code (HP-code) on both L1 and L2, and the C/A code
(SP-code), on L1 (all satellites) and L2 (most satellites).
Table 2 summarizes the GLONASS signals.
Table 2: GLONASS FDMA Signal Characteristics
Designation

Frequency

Description

L1

1598.0625 -1609.3125
MHz

L1 is modulated by the HP (high
precision) and the SP (standard
precision) signals.

L2

1242.9375 -1251.6875
MHz

L2 is modulated by the HP and
SP signals. The SP code is
identical to that transmitted on L1.

At peak efficiency, the SP-signal offers horizontal positioning accuracy
within 5–10 meters, vertical positioning within 15 metres.
GLONASS is based upon a frequency division multiple access (FDMA)
concept: each satellite transmits carrier signals on a different frequency (e.g.,
L1 carriers are in 1598.0625 -1609.3125 MHz). A GLONASS receiver
separates the total incoming signal from all visible satellites by assigning
different frequencies to its tracking channels. The use of FDMA permits each
GLONASS satellite to transmit an identical SP-code. More exactly, the
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GLONASS system is based on 24 satellites using 12 frequencies. It achieves
this by having antipodal satellites transmitting on the same frequency.
Antipodal satellites are in the same orbital plane but are separated by 180
degrees. The paired satellites can transmit on the same frequency because
they will never appear at the same time in view of a receiver on the Earth’s
surface. Since 2008, new CDMA (Code division multiple access) signals are
being researched for use with GLONASS.
A navigation message, which is modulated in carrier, is transmitted
from each satellite consisting of satellite coordinates, velocity and
acceleration vector components, satellite health information and corrections to
GLONASS system time.
The GLONASS Control Segment consists of the system control center
located in Kranznamensk Space Center about 70 km southwest Moscow. The
center is connected with 8 tracking stations distributed across Russia. These
stations are responsible for tracking and monitoring the satellite orbit status,
determining the ephemerides and satellite clock offsets with respect to
GLONASS time, and transmitting this information to the system control
center via radio link once per hour.
Additional information concerning GLONASS is available at the
website http://www.glonass-ianc.rsa.ru/.
With the availability of combined GPS/GLONASS receivers, users have
access to a satellite combined system with over 40 satellites. The use of
GLONASS in addition to GPS can reduce signal acquisition time, improve
position and time accuracy, reduce problems caused by obstructions such as
buildings and foliage and improved spatial distribution of visible satellites,
etc.
To determine a position in GPS-only mode, a receiver must track a
minimum of four satellites. In combined GPS/GLONASS mode, the
GPS/GLONASS enabled receiver must track five satellites, at least one of
which must be a GLONASS satellite, so the receiver can determine the
GPS/GLONASS time offset.
1.5.6. Galileo
Galileo is the GNSS that is currently being created (not fully
operational) by the European Union and the European Space Agency (ESA).
The first two operational Galileo satellites were launched from Europe's
Spaceport in French Guiana in October 2011. The use of basic (low-precision)
Galileo services will be free and open to everyone. The high-precision
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capabilities will be available for paying commercial users. Galileo will start
offering services from 2016.
The Galileo Space Segment will consist of 27 operational and three
active spare satellites distributed in 3 orbit planes. The satellites are placed
into nominally circular orbits with target inclinations of 56 degrees, ascending
nodes separated by 120° longitude (9 operational satellites and one active
spare per orbital plane), and a medium-Earth orbit radius of 23,222 km. Each
satellite will take about 14 hours to orbit the Earth. Currently 9 Galileo
satellite are in orbit and healthy. As of 2012, the system was scheduled to
reach full operation in 2020.
Once the constellation is operational, Galileo navigation signals will
provide coverage at all latitudes. From most locations, six to eight satellites
will always be visible. Galileo is intended to provide horizontal and vertical
position measurements within 1-metre precision, and better positioning
services at high latitudes than other GPS and GLONASS systems.
The Galileo Ground Control Segment consists of a network of ground
stations. The ground control centre is located in Oberpfaffenhofen; the ground
mission centre is located in Fucino; 5 tracking stations are located in Kiruna,
Kourou, Noumea, Sainte-Marie, Réunion & Redu; plus there are several
uplink stations, sensor stations and a data dissemination network between
stations.
The Galileo User Segment is composed of Galileo receivers. Their
main function is to receive Galileo signals, determine pseudo-ranges (and
other observables), and solve the navigation equations in order to obtain their
coordinates and provide a very accurate time.
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1.5.7. Comparison between GPS, GLONASS and Galileo
Table 3 shows a comparison between GPS, GLONASS and
Galileo.
Table 3. Systems comparison: GPS, GLONASS and GALILEO
Systems
First launch
Full operational
capability Launch
site
Nominal number of
SV
Orbital planes
Orbit inclination
Orbital altitude
Orbit
plane
separation
Revolution period
Signal separation
Number
of
frequencies

Frequency (MHz)

Number of ranging
codes
Geodetic reference
system used
(Datum)
Time system

GPS
February,
1978
1995
Cape
Canaveral
24
6
55
20,180 km
60
11h 57.96
min
CDMA
5 - L1 -L5

GLONASS

Galileo

October, 1982
1996
Baikonur/Plesetsk

December, 2011
2020
Kourou (French Guiana)

24
3
64.8
19,140 km
120
11h 15.73 min

27
3
56
23,222 km
120
14h 4.75 min

FDMA
one per two antipodal
SV

CDMA
3(4)-E1,E6,E5(E5a,E5b)

L1:
1,575.420
L2:
1,227.600
L3:
1,176.450
L4:
1379.913
L5: 1176.45

L1:
1598.0625
1609.3125
L2:
1242.9375
1251.6875

11

6

10

WGS-84

PZ-90.11 (Earth
Parameters 1990)

GTRF (International
Terrestrial Reference System
at epoch 2011.0)

GPS time,
UTC

GLONASS time,
UTC(SU)

Galileo system time

-

E1: 1,575.420
E6: 1,278.750
E5: 1,191.795

1.6. GNSS ERRORS
There are many sources of possible errors that will degrade the accuracy
of positions computed by a GNSS receiver. The errors that can affect the
accuracy of standard GNSS pseudo-range determination, that is, the
determination of the pseudo-range by single satellite discussed above, are
summarised in Table 4.
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Table 4: Sources of errors of GNSS pseudo-range determination - Error Budget
Contributing
Source

Satellite
clocks

Orbit errors
(ephemeris
data)

Ionospheric
delays

Tropospheric
delays

Error
Range
Potential

1.5 meters

2.5 meters

5 meters

Error
Range
Typical

Explanation

0 meters

Errors in the transmitted clock.
Small variations in the atomic clocks (clock drift) on
board the satellites can translate to large position
errors; a clock error of 1 nanosecond translates to
3 meters user error on the ground.

0 meters

Errors in the transmitted location of the satellite.
Errors in the ephemeris data (the information about
satellite orbits) will also cause errors in computed
positions, because the satellites were not really
where the GNSS receiver "thought" they were
(based on the information it received) when it
computed the positions.

0.4 meters

Atmospheric effects are the largest source of error.
Because of free electrons in the ionosphere,
GNSS signals do not travel at the vacuum speed
of light as they transit this region.
The modulation on the signal is delayed in
proportion to the number of free electrons
encountered and is also (to first order) proportional
to the inverse of the carrier frequency squared
(1/𝑓 squared).
With short baselines, less than ten kilometers, the
effect are almost equal, and will be canceled out of
the solution.
Sunspot activity also causes interference with
GNSS signals.
Delays in ionosphere can be compensated by
using dual frequency receivers.
Another deviation from the vacuum speed of light
is caused by the troposphere.
Variations in temperature, pressure, and humidity
all contribute to variations in the speed of light of
radio waves.
Both the code and carrier will have the same
delays.
Delays in troposphere can be only estimated.

0.2 meters

0.2 meters
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Receiver
noise

0.3 meters

0.3 meters

Multipath

0.6 meters

0.6 meters

Total

~ 15
meters

~ 10
meters

Distortion of the signal caused by electrical
interference or errors inherent in the GNSS
receiver itself.
Errors in the receiver's measurement of range
caused by thermal noise, software accuracy, and
inter-channel biases.
Errors caused by reflected signals entering the
receiver antenna.
The GNSS signal is a radio wave signal that can
easily be blocked. Mountains, trees, towers, and
buildings are just a few examples of possible
obstructions.
Multipath is the error caused by reflected signals
entering the front end of the receiver and masking
the real correlation peak.
These effects tend to be more pronounced in a
static receiver near large reflecting surfaces, where
15 m in or more in ranging error can be found in
extreme cases.
If obstructions are present, it is important to note
the azimuth and elevation above the horizon of
these structures, and then account for these in
GNSS mission planning. Also, some structures
that are obstructions in one direction can also be
sources of multipath in another direction.
Beware of other sources of multipath.

Geometry of
satellite
positions

Errors are cumulative and increased by PDOP
(Positional Dilution of Precision).

Selective
Availability

Selective Availability, or SA, occurred when the
DoD intentionally degraded the accuracy of GNSS
signals by introducing artificial clock and
ephemeris errors. When SA was implemented, it
was the largest component of GNSS error, causing
error of up to 100 meters. SA is a component of
the Standard Positioning Service (SPS), which was
formally implemented on March 25, 1990, and was
intended to protect national defense. SA was
turned off on May 1, 2000.

> 50
meters

In the next chapter, techniques for reducing these errors further will be
discussed. However, the degree with which the above pseudo-range errors
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affect positioning accuracy depends largely on the geometry of the satellites’
arrangement being used.
The quality of satellite geometry arrangement can be defined by Dilution
of Precision (DOP) parameters. DOP is a numerical definition of satellite
geometry, and it is dependent on the locations of satellites that are visible to the
receiver. The smaller the value of DOP, the more precise the result of the time
or position calculation. The relationship is shown in the following formula:
𝐼𝑛𝑎𝑐𝑐𝑢𝑟𝑎𝑐𝑦 𝑜𝑓 𝑃𝑜𝑠𝑖𝑡𝑖𝑜𝑛 𝑀𝑒𝑎𝑠𝑢𝑟𝑒𝑚𝑒𝑛𝑡
= 𝐷𝑂𝑃 𝑥 𝐼𝑛𝑎𝑐𝑐𝑢𝑟𝑎𝑐𝑦 𝑜𝑓 𝑅𝑎𝑛𝑔𝑒 𝑀𝑒𝑎𝑠𝑢𝑟𝑒𝑚𝑒𝑛𝑡
So, if DOP is very high, the inaccuracy of the position measurement will
be much larger than the inaccuracy of the range measurement.
There are five distinct kinds of DOP:






GDOP - Geometric Dilution of Precision.
PDOP - Position Dilution of Precision (most commonly used).
HDOP - Horizontal Dilution of Precision.
VDOP - Vertical Dilution of Precision.
TDOP - Time Dilution of Precision.

GDOP refers to where the satellites are in relation to one another, and is a
measure of the quality of the satellite configuration. It can magnify or lessen
other GNSS errors. In general, the wider the angle between satellites, the better
the measurement. If satellites spaced widely across the sky, a receiver can get a
more accurate determination of its position by trilateration than if they are
“clumped” together. Most GNSS receivers may select the satellite constellation
that will give the least uncertainty, the best satellite geometry.
PDOP refers to horizontal (HDOP) and vertical (VDOP) measurements
(latitude, longitude and altitude). The quality of the satellite configuration can
be checked on a receiver screen by looking at the PDOP value. A low DOP
indicates a higher probability of accuracy, and a high DOP indicates a lower
probability of accuracy. PDOP values are:





1 - theoretically ideal
1-4 - very good
5-8 - acceptable
>9 - poor

Another quality measurement of satellite arrangements is TDOP, or Time
Dilution of Precision. TDOP refers to satellite clock offset. A parameter known
as the PDOP mask can be set on a GNSS receiver. This will cause the receiver
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to ignore satellite configurations that have a PDOP higher than the specified
limit.
These five DOPS are mathematically related. In some cases, for example
when satellites are low in the sky, HDOP is low and it will therefore be
possible to get a good to excellent determination of horizontal position (latitude
and longitude), but VDOP may only be adequate for a moderate altitude
determination. Similarly, when satellites are clustered high in the sky, VDOP is
better than HDOP.
In the Figure 35A, the effect of DOP is illustrated. It is difficult to
determine where the ranges intersect. Position is “spread” over the area of
range intersections, an area which is enlarged by range inaccuracies (which can
be viewed as a “thickening” of the range lines). As shown in Figure 35B, the
addition of a range measurement to a satellite that is angularly separated from
the satellite cluster allows a receiver to determine a position more precisely.

Figure 35. Dilution of precision: poor satellite geometry and improved geometry

DOP can be used as the basis for selecting the satellites on which the
position solution will be based to minimize DOP and increase GNSS
measurement’s accuracy. DOP varies with time of day and geographic location
but, for a fixed position, the geometric presentation of the satellites repeats
every day, for GNSS. DOP can be calculated without determining the range
only the satellite positions and the approximate receiver location are needed.
Thus, GNSS mission planning software, which can read the satellite almanac,
can be used to plan a date and time for GNSS fieldwork in order to obtain good
DOP during the ground surveying.
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In Canada and in other countries at high latitude, GNSS satellites are
lower in the sky, and achieving optimal DOP for some applications,
particularly where good VDOP is required, is sometimes a challenge. This
challenge is being reduced with more GNSS constellations and satellites
coming on line every year.

1.7. TYPES OF GNSS POSITIONING
The “standard” technique of measurements with GNSS provides
positional accuracy of 10-15 meters. However, there are techniques to reduce
GNSS errors and get GNSS measurements with accuracy of a few centimetres.
Thus, for example, accuracy of GNSS receivers with the use of particular
techniques can be classified as:

Recreational grade GNSS receivers - 10-15 m of horizontal
positional accuracy
o Use of autonomous Code Phase positioning technique
o Use of C/A code

Mapping grade GNSS receivers - 1-5 m of horizontal positional
accuracy
o Use of C/A code with Code Phase positioning
o Use of differential correction in real-time or/and post-processing

Sub-meter mapping grade GNSS receivers - 10 cm to 1 m of
horizontal positional accuracy
o Use of C/A code and Carrier Phase positioning
o Use of differential correction in real-time or/and post-processing

Survey grade GNSS receivers - 1 cm of horizontal positional
accuracy
o Use of P-code or dual frequency positioning
o Use of Carrier Phase positioning and advanced survey methods
The following discussion describes the listed techniques. The increased
accuracy comes at a price of using more expensive equipment, more advanced
techniques and more time spent on field work surveying.
1.7.1. Code Phase Positioning
As we have discussed above a GNSS receiver calculates its position by a
technique called satellite ranging, which involves measuring the distance
between the GNSS receiver and at least three GNSS satellites it is tracking.
The range (the range a receiver calculates is actually a pseudo-range, or an
estimate of range rather than a true range) or distance, is measured as elapsed
transit time.
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A range/distance to each satellite can be calculate from the following
formula:
𝐷 = 𝑐 ∗ 𝑇 + 𝑒𝑟𝑟𝑜𝑟𝑠, where 𝑐 is the speed of light (299,792,458 m / s
in a vacuum), 𝑇 is a propagation time that is a difference between time when
signal reached receiver and time when signal left satellite.
In order to measure the travel time 𝑇 of the satellite signal, the receiver
has to know when the signal left the satellite and when the signal reached the
receiver. Knowing when the signal reaches the receiver is easy, the GNSS
receiver just uses its internal clock to measure when the signal arrives to see
what time it is. But how does a receiver "know" when the signal left the
satellite? All GNSS receivers are synchronized with the satellites by using
ephemeris so they generate the same PRN code at the same time. The amount
of delay is the transit time. This principle is demonstrated in Figure 36.

Figure 36: Determining Time of Propagation

Once the receiver has three or more distance measurements, it is
basically a problem of trigonometry (trilateration) to determine a receiver
coordinates.
1.7.2. Differential corrections and SBAS
Integrating external information into the GNSS-coordinators calculation
process can materially improve accuracy. For this purpose networks of
augmentation systems are developed. Such augmentation systems are generally
named or described based on how the external information arrives to improve
accuracy GNSS measurements through differential correction.
Some systems transmit additional error information (such as clock drift,
ephemera, or ionospheric delay), others characterize prior errors, while a third
group provides additional navigational or vehicle information. Examples of
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augmentation systems include the International GNSS Service (IGS), US
Nationwide Differential GPS System (NDGPS), Wide Area Augmentation
System (WAAS), European Geostationary Navigation Overlay Service
(EGNOS),
OmniSTAR
etc.
See
more
at
http://www.gps.gov/systems/augmentations/.
Differential correction reduces the effects of some GNSS errors. The
main principle of differential correction is to use GNSS receiver “base station”
on the ground with known location as a fixed static reference point. The
position of a base station is determined to a high degree of accuracy using
GPSS and conventional surveying techniques.
In particular point of time, the base station measures ranges to GNSS
satellites. Since the base station "knows" where it is with high accuracy, it can
compute the errors in its position calculations (or timing errors). Then
corrections for the errors can be sent to any number of roving receivers (rovers)
in the same general area. These rovers incorporate the corrections into their
position calculations (Figure 37). This requires that the base and rover
receivers "see" the same set of satellites at the same time.
The incorporation of corrections is based on the following assumption:
since GNSS satellites orbit high above the earth, the propagation paths from
the satellites to the base stations and rovers pass through similar atmospheric
conditions, as long as the base station and rovers are not too far apart.

Figure 37. Principle differential corrections with real-time Differential GNSS

Differential real-time positioning requires a data link between base stations and
rovers if corrections need to be applied in real-time, and at least four GNSS
64

satellites in view at both the base station and the rovers. The absolute accuracy
of the rover's computed position will depend on the absolute accuracy of the
base station's position and separation between base station and rover positions
(baseline). The base station can usually serve users in an area with up to 500
kilometers radius of baseline. However, differential GNSS works with better
accuracy if with base-station-to-rover separations of up to 20 kilometers.
The base station, depending upon how it is configured, can correct
roving GNSS receiver data in one (or both) of two ways:

In real-time differential correction or real-time differential GNSS
(DGNSS), the base station transmits error correction messages to GNSS
receivers located in the field and corrections is performed in real-time by using
GNSS differential correction software. Real-time correction can be
implemented based on:
o
Local ground-based or terrestrial radio-beacon base stations with
BoB (Beacon-on-Belt) receivers. For example, the Nationwide Differential
GPS (NDGPS) radio-beacons stations’ network is a terrestrial augmentation
system, which is used for real-time or post-processed differential corrections.
o
Satellite-based augmentation system (SBAS). For example Wide
Area Augmentation System (WAAS) and OmniSTAR communication
satellites is used for real-time differential corrections.

A post-processed differential correction is implemented in the office
after GNSS data are collected. Thus a file with differential correction errors
can be download from a base station via network (e.g., Internet) and applied to
the field GNSS measurements on a computer by using differential correction
software. The base station file contains information about the timing errors.
Since the base station and rover receivers have to "see" the same set of
satellites at the same time, the base file has to start before the rover file starts,
and end after the rover file ends (a base station is normally set up to track all
satellites in view, insuring that it will "see" at least the four satellites that the
roving receiver is using to compute positions). Now GNSS differential
correction services are available wirelessly through mobile devices.
Differential correction files are disseminated in specific formats. One of most
widely used formats is Receiver Independent Exchange (RINEX) format,
which supports conversion of position data.


Blended mode – a user uses real-time and post processed techniques.

As it is shown above, there are ground based augmentation systems (GBAS)
and satellite based augmentation system (SBAS). For applications where the
cost of a ground differential GNSS system is not justified, or if the rover
stations are spread over too large an area, a Satellite-Based Augmentation
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System (SBAS) may be more appropriate for enhancing position accuracy.
SBAS systems are geosynchronous satellite systems that provide differential
correction services for improving the accuracy, integrity, and availability of
basic GNSS signals.
A geosynchronous orbit has an orbital period matching the Earth’s sidereal
rotation period. This synchronization means that for an observer at a fixed
location on Earth, a satellite in a geosynchronous orbit returns to exactly the
same place in the sky at exactly the same time each day. The term
geostationary is used to refer to the special case of a geosynchronous orbit that
is circular (or nearly circular) and at zero (or nearly zero) inclination, that is,
directly above the equator. Satellites in geostationary orbits appear stationary at
one location at all times.
SBAS systems include reference base stations, master stations, uplink stations
and geosynchronous SBAS satellites (Figure 38).

Figure 38. GNSS-SBAS data gathering and correction broadcast

Reference base stations, which are geographically distributed
throughout the SBAS service area, receive GNSS signals and forward them to
the master station. Since the locations of the reference base stations are
accurately known, the master station can accurately calculate wide-area
corrections. Corrections are uplinked to the SBAS satellite(s), and then
broadcast to GNSS receivers throughout the SBAS coverage area (Figure 38).
User equipment receives the corrections and applies them to range
calculations.
Several countries have implemented their own satellite-based
augmentation systems. Europe has the European Geostationary Navigation
Overlay Service (EGNOS) which covers the EU and possibly beyond
(http://egnos-portal.gsa.europa.eu/discover-egnos/about-egnos).
EGNOS
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provides both correction and integrity information about the GNSS system,
delivering opportunities for Europeans to use the more accurate positioning
data for improving existing services or developing a wide range of new
services.
The USA has its Wide Area Augmentation System (WAAS). Thus, with
Selective Availability set to zero, and under ideal conditions, a GNSS receiver
without WAAS can achieve 10-15 meter accuracy most of the time. Under
ideal conditions, a WAAS equipped GNSS receiver can achieve less than
three-meter accuracy 95% of the time.
CDGPS is currently offered throughout Canada, most of the continental
United States, and much of the Arctic. Japan is covered by its Multifunctional Satellite Augmentation System (MSAS). India has launched its
own SBAS programme named GNSS and GEO Augmented Navigation
(GAGAN) to cover the Indian subcontinent. Both Korea (2013) and China
(2014) have announced plans to start their own SBAS implementation.
Some companies, such as OmniSTAR (provide worldwide services
including Europe, Middle East, Russia and CIS) and RACAL provide
differential corrections in real-time via their own communication satellite
systems. A special satellite receiver as well as the payable subscription are
necessary to receive their signals.
SBAS services can be free (e.g., WAAS, EGNOS) and commercial
(e.g., OmniSTAR, VERIPOS). In general, free government-provided SBAS
services use the same frequency as GPS/GLONASS, and commercial SBAS
services use a different frequency. In this case, additional equipment may be
required to use SBAS differential corrections.
GNSS instruments from some companies offer an integration of
GPS/GLONAS receiver with SBAS correction receiver within one rover. For
example, in North America, many receivers are now WAAS compatible.
Differential correction can be attributed to satellite ephemeris and clock
errors, but mostly to errors associated with atmospheric delay. Differential
correction cannot correct for multipath or receiver error; it counteracts only
the errors that are common to both base station and roving receivers. For
example, GNSS error budget with standard (without differential correction)
vs. with differential correction is shown in the following table 5:
Typical Error in Meters (per Satellite)
Standard GNSS

Differential GNSS

Satellite Clocks

1.5

0

Orbit Errors

2.5

0
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Ionosphere

5

0.4

Troposphere

0.5

0.2

Receiver Noise

0.3

0.3

Multipath

0.6

0.6

SA

30

0

Typical Position Accuracy
Horizontal

50

1.3

Vertical

78

2

3-D

93

2.8

1.7.3. Carrier Phase Positioning
For applications such as cadastral surveying, higher accuracies are
required than cannot be achieved from code phase positioning techniques even
with differential corrections. Higher accuracies can be achieved by using
carrier phase positioning techniques. Carrier phase receivers typically provide
up to a few centimeters position accuracy with differential correction. Carrier
phase positioning can only be used with a differential system, and only works
to about 30 km from the base station.
The carrier phase processing technique gathers data via a carrier phase
receiver, which uses the carrier signal to calculate positions. The carrier signal,
which has a much higher frequency than the pseudo-random code, is more
accurate (typically, about two orders of magnitude) than using the pseudorandom code alone. Thus, carrier wavelengths (19 cm for L1) are much shorter
than the C/A code length (293 m modulated in L1) and consequently
potentially can be measured more accurately and used to achieve much higher
positional accuracies than code measurements. The pseudo-random code with
differential correction narrows the reference then the carrier code narrows the
reference even more. After differential correction, the carrier phase processing
technique results in centimeter accuracy.
Thus, the carrier frequency 𝜈 is multiplied by the vacuum speed of light
𝑐 gives the wavelength 𝜆, e.g., 19 cm for L1. In this case, accuracy detection of
pseudo-range 𝐷 is within 1% of wavelength and error is as little as 2
millimeters. This compares to 3 meters for the C/A code and 0.3 meters for the
P code.
𝜆 = 𝑐/ 𝜈
However, 2 millimeter accuracy requires measuring the total phase - the
number of waves (or full carrier cycles) multiplied by the wavelength plus the
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fractional wavelength (or cycle). This requires specially equipped receivers. At
a very basic conceptual level, carrier phase receivers measure the distance from
the receiver to the satellites by counting the number of carrier waves (and even
portions of waves) of the L1 and/or the L2 signal between the satellite and the
rover station, then multiplying this number by the carrier wavelength.
There is, however, one problem. The carriers are just pure sinusoidal
waves: all cycles look the same. A GPS receiver cannot differentiate one cycle
of wave from another. The receiver, when it is switched on, cannot directly
determine the total number of complete cycles between sattelite and the
receiver. It can only measure a fraction of a cycle very accurately (as little as 2
millimeters), while the initial number of complete cycles remains unknown or
ambiguous. This is known as the initial cycle ambiguity. Fortunately, the
receiver has the capability to keep track of the phase changes after being switch
on. This means that the initial cycle ambiguity remains unchanged over time
(El-Rabbany, 2002).
A complicated process called “ambiguity” resolution is needed to
determine the number of whole waves. If the initail cycle ambiguity paraemters
are resolve, accurate range meuremnts can be obtained.
A GNSS receiver which records the carrier phase, measures the fraction
of one wavelength (i.e. fraction of 19 cm for the L1 GPS carrier and 24 cm for
the L2 GPS carrier) when the receiver first locks onto a satellite and
continuously measures the carrier phase from that time. The number of
cycles/waves between the satellite and receiver at initial start-up (the ambiguity
and the measured carrier phase together represent the satellite-receiver range
(i.e. the distance between a satellite and a receiver) and can be represented as
𝐷 = Φ − (𝜆 ∗ 𝑁 + 𝑒)
Where 𝐷 is the pseudo-range observation, Φ is the carrier phase
observation (in length units), 𝜆 is the carrier wavelength, 𝑁 is the integer
carrier phase ambiguity, 𝑒 is errors (range errors due to satellite and receiver
clocks’ errors, ionospheric and tropospheric refractions) (Wells et al. 1987).

The ambiguity is the unknown integer number of times the carrier wave
length at initial start-up. Such ambiguity can be fixed mathematically to get the
carrier phase measurements at the accurate level of a few centimetres.
Resolution of integer ambiguity requires sophisticated statistical software,
access to multiple satellites, and that receivers record the full-wavelength
carrier phase and signals of two or more frequencies (e.g., C/A codes from L1
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and L2). A rover determines its position using algorithms that incorporate
ambiguity resolution and differential correction.
To boosts the GNSS accuracy, dual-frequency techniques should be used.
Dual-frequency receivers are capable of providing sub-centimetre GNSS
position accuracy with differential correction. Dual-frequency receivers receive
signals from the satellites on two frequencies simultaneously. For example,
when combined with L1 C/A in a dual-frequency receiver, the new L2C-code
enables ionospheric correction, a technique that increases accuracy. Civilians
with dual-frequency GNSS receivers enjoy the same accuracy as the military
(or better).
Requirements for survey-grade GNSS receivers are that they record the
full-wavelength carrier phase and signal strength of the L1 and L2 frequencies,
and they track at least eight satellites simultaneously on parallel channels.
The electronics to carry out carrier phase positioning are much more
sophisticated and precise than those used for code phase positioning. Unlike
code phase positioning, carrier phase positioning must use an analogue radio
receiver, which cannot be placed on a chip like inexpensive carrier phase
receivers.
The carrier phase receivers are much more accurate than C/A code phase
receivers, but require strict data collection requirements and more postprocessing. Thus, occupation times on rover stations can be 30 minutes and
more. A GNSS receiver has a configuration option to set carrier occupation
time, as soon as it is achieved the receiver stores the collected rover file with
GNSS data, and then the data can be differentially corrected with carrier phase
processing (Figure 39). A new rover file must be created for each subsequent
carrier session. Although it is more difficult to gather carrier code data than
solely PRN code, accuracy is increased.
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Figure 39: The carrier phase positioning: the range is calculated by determining
the number of carrier cycles between the satellite and the rover station, then
multiplying this number by the carrier wavelength.

Carrier phase receivers (survey grade) require a clear view to the
satellites in order to maintain a constant lock with at least 4 satellites, while
C/A code receivers (mapping grade) do not need to maintain a constant lock
with the satellites to calculate positions. This makes a C/A code receiver
imperative to gathering data in adverse conditions (for example, under trees).
There are several field surveying methods for using carrier phase GNSS
observations. Among them are static, rapid static and kinematic techniques.
These field positioning methods can use carrier phase signals and PRN signals
from GPS or/and GLONAS, and plus differential correction techniques.
Conventional static GNSS surveying was the first method used in the
field and it continues to be the primary technique used today. Static GNSS
surveying requires collecting data from the same satellites simultaneously
between stationary receivers (base stations) for an extended period of time,
usually from 1 hour to 4 hours, depending on baseline length. Using this
method requires the design of a GNSS network and an observation schedule for
the coordination of receivers. The range of accuracy using conventional static
GNSS varies depending on the observing and processing procedures followed,
the baseline lengths measured and the receivers/antennas used, the accuracy of
the differential corrections, among other variables (e.g., site and time selection,
the quality of the base station etc.). For very precise applications, specialised
software with processing techniques should be employed to handle errors.
Using such techniques, accuracies of less than 1 cm can be achieved for
baselines of up to 600 km in length depending on satellite geometry.
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Fast static is a procedure that uses very short occupation times - minutes
instead of hours of observations. Unlike static methods, which sometimes
require multiple occupation sessions to build redundancy into the network,
rapid-static stations need to be occupied only once. The technique relies on
specific processing algorithms and additional information such as P-code
observations or redundant satellites (e.g. seven or eight satellites instead of the
minimum four). In addition, rapid static surveys should be conducted over
short baselines (e.g. less than 10 km) to achieve the few centimetre level
accuracy.
The main limitations of carrier code techniques are as follows:

Need to support limited range with respect to the base location.

The need of a communication channel for real time applications.

Some convergence time is needed to fix the phase ambiguities.
This time depends on the processing algorithm and the distance between base
and rover.

In order to avoid re-initialization of the processing, the rover has
to track the GNSS signals continuously.
1.7.4. Real Time Kinematic
GNSS positioning may also be categorized as static or kinematic. In
static positioning, a GNSS receiver is required to be stationary whereas in
kinematic positioning a receiver collects GNSS data while continuously
moving. Kinematic techniques are sometimes referred to as continuous
kinematic or pure kinematic techniques. This differentiates kinematic from
semi-kinematic techniques, which require stops at points to be positioned
(USGS Global Positioning Application and Practice, 2015).
The Real Time Kinematic (RTK) approach, originated in the mid-1990s,
involves using at least one stationary reference receiver (e.g., base station) and
at least one moving rover (or several receivers), in addition a communication
channel between base station and rover is required. The technique is based on
the use of carrier measurements and the transmission of corrections from the
base station to the rover, so that the differential errors cancel out. This allows
for real-time surveying in the field and allows the surveyor to check the quality
of the measurements without having to process the data. If a RTK base station
covers a service area spreading about 10 or 20 kilometers, then RTK surveying
achieves performances in the range of a few centimeters. A DOP above 6
results in generally unacceptable accuracies for DGPS and RTK operations.
There is also Post-Processed Kinematic (PPK) techniques. PPK surveys
are similar to RTK procedures, but the baselines are not processed in real-time.
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PPK involves using one or more roving receivers and at least one static base
station. GNSS data are simultaneously collected at the reference and rover
receivers. The data are downloaded from the receiver, and the baselines
processed using GNSS software.
Table 6: Positional accuracies of satanic and kinematic Carrier Phase
techniques

Positioning Mode

Typical Horizontal
Accuracy
(5 Satellite’s visibilities,
PDOP<4)

Maximum Operating
Range

Static

Horizontal: 5mm + 1 ppm
(part-per-million)
Vertical: 10 mm + 1 ppm

Several 100 km depending
on satellite geometry

Real-time
Kinematic

Horizontal 1 cm + 2 ppm
Vertical: 2 cm + 2 ppm

Recommended: <10 km
Maximum: 40 km
Usually dependent on
communication link

When choosing between a kinematic and a static methodology, the GNSS
surveyor basically is making a choice between productivity and accuracy. The
kinematic techniques can produce the largest number of GNSS points in the
least amount of time; however, because of the shortened occupation times and
less data to resolve integer ambiguity, there is a slight degradation in the
accuracy of the work.
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VOCABULARY
Almanac of GNSS: GNSS data about the state (health) of the entire
GPS satellite constellation, coarse data (including coordinates) on every
satellite's orbit, and satellite clock correction parameters.
Ambiguity: The number of whole carrier signal wavelengths (cycles)
between a GPS satellite and a GPS receiver. This is important in the use of
relative carrier phase measurement techniques.
Base station: A stationary reference receiver on the ground (can be on
the roof of building) with known location measured with a high degree of
accuracy.
Boundary or property line: An imaginary or marked line which define
the extent of the legal limits of ownership of any parcel of land.
Cadastral map: A map which is produced by joining together
individual cadastral plans.
Cadastral survey plan: A plan of a property boundary survey, which is
carried out for legal purposes so as to accurately establish land legal
boundaries and land’s ownership, restrictions and usage.
Carrier phase positioning: GNSS measurements based on carrier
signal.
Carrier signal or waves: A signal which is modulated in frequency,
amplitude, or phase, in order for it to carry information.
Chain traversing: The method in which the whole work is done with
chain and tape is called chain traversing.
Closed traverse: A traverse that begins at a point and ends at the same
point or at a point whose position is known.
Closure error (or misclosure, discloser error): A traverse error which
indicates accuracy of the surveying of closed traverse and potential problems
in the original survey data.
Code phase positioning: GNSS measurements based on the pseudo
random code (PRN) as opposed to the carrier of that code.
COMPASS (BeiDou): The Chinese GNSS, set to supersede the
COMPASS regional system operating since 2000, is managed by the
governmental China Satellite Navigation Office.
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Compass rule: The adjustment method then the error of closure is a
result of accidental errors affecting angular and linear measurements equally.
Control GNSS segment: A ground-based network of master control
stations, data uploading stations, and monitor stations.
Coordinate geometry (COGO): A method for calculating coordinate
points from surveyed bearings, distances, and angles.
Crandall method: The adjustment method then the error of closure is a
result of accidental errors and the effects of errors in angular measurements
are negligible or have already been adjusted out of the traverse. It assumes
that any adjustment should be applied only to the lengths/distances of the
courses.
Differential correction: The method of reducing the effects of some
GNSS rover errors by applying corrections received from a base station.
Dilution of Precision (DOP): The set of parameters which can be used
to measure quality of satellite geometry or a numerical definition of satellite
geometry.
Ephemeris of GNSS: A set of parameters that can be used to accurately
calculate the location of a GNSS satellite at a particular point in time.
Galileo: Europe’s GNSS, currently under development as the only civil
GNSS, is owned and managed by the European Union.
Global Navigation Satellite System (GNSS): A satellite system that is
used to pinpoint the geographic location of a user's receiver anywhere in the
world.
Global Positioning System (GPS): The first GNSS, fully operational
since 1995, is managed by the US Department of Defence
GLONASS: The Russian GNSS, completed in 1995 and fully
operational since 2011, is managed by the Russian Aerospace Defence
Forces.
Ground based augmentation systems (GBAS): A network of local
terrestrial base stations with GNSS receivers (base stations) used for the
deferential corrections.
Ionospheric delays: Delays of GNSS signals in ionosphere due to free
electrons.
Land surveying: The art and science of measuring, marking,
recovering, and mapping the relative positions or locations of terrain features
and real property boundaries.
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Least Squares adjustment: The adjustment method then the error of
closure is a result of accidental errors. The Least Squares adjustment theory
states that, for any set of measured values, the best set of corrections to apply
to the measured values is one such that the sum of the squares of all of the
corrections is minimized.
Loop traverse: A traverse which starts at a given point, proceeds to its
destination, and returns to the starting point without crossing itself in the
process.
Metes and bounds: the method of descriptions of the perimeter of
property.
Monumentation: The process of establishing corners of parcel’s
boundaries. It is often defined in specifications established by states,
provincial and/or professional surveying organizations.
Multipath: Displacement errors of GNSS carrier signals caused by
reflections from buildings, walls etc. when signals entering the receiver
antenna.
Navigation message: A low frequency signal added to the carrier signal
that gives information about the satellite's orbits, their clock corrections and
other system status. It contains ephemeris data and almanac data.
Occupation time: the amount of time required to allow satellite
acquisitions on a station, or point, and to achieve successful processing of
GNSS data.
Open traverse: A traverse that originates at a starting station,
proceeds to its destination, and ends at a station whose relative position
is not previously known.
Plain table traversing: A method of tacheometry where a plane
table is set at every traverse station in the clockwise or anticlockwise
direction, and circuit is finally closed.
Plat: A report of a land survey in the form of a cadastral drawing.
Post-processed differential correction: A differential correction
techniques which can be implemented in the office after GNSS data are
collected.
Propagation time: A difference between a time when signal
reached receiver and time when signal left satellite.
Relative positioning: The process of determining the relative
difference in position between two locations.
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Pseudo random code: A signal with random noise-like properties
with repeating pattern of 1's and 0's.
Pseudo-range: A distance measurement between a GNSS satellite
and a recovers based on the correlation of a satellite transmitted code and
the local receiver's reference code, that has not been corrected for errors
in synchronization between the transmitter's clock and the receiver's
clock. A pseudo-range is a range estimated from the time rather than a
true distance.
Real Time Kinematic (RTK): The GNSS acquisition technique
involves using at least one base station and at least one moving rover (or
several receivers). The GNSS rover can be mounted on a vehicle or
aircraft. The RTK technique provides high positioning performance in
the vicinity of a base station.
Real-time differential correction (DGNSS): A differential
correction techniques which can be implemented by GNSS receivers in
the field during surveying.
Resection: COGO method of calculation for the coordinates of an
unknown or free station by observing the three established stations or
known points from the unknown point.
Rover: A GNSS receiver used for Real Time Kinematic
positioning.
Satellite-Based
Augmentation
System
(SBAS):
A
geosynchronous satellite systems that provide differential correction
services for improving the accuracy, integrity, and availability of basic
GNSS signals.
Selective Availability: The capability of GPS. It can be occurred
when the DoD intentionally degraded the accuracy of GNSS signals by
introducing artificial clock and ephemeris errors.
Side shot: A single measurement to a feature, which is to the side
of the main traverse line.
Space GNSS segment: GNSS and SBAS satellites that are
orbiting.
Survey post: A control point which is set in the ground to define
the boundaries of the parcel.
Tacheometry: An optical solution to the measurement of distances and
angles.
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Theodolite: A precision instrument that consists of a movable telescope
for sighting distant target objects, two measurement wheels that work like
protractors for reading horizontal and vertical angles precisely, and bubble
levels to ensure that the angles are true.
Theodolite-EDM: An instrument known in jargon as a total station that
is able to measure distance, vertical and horizontal angels, and relative
elevation by reflecting off a reflector’s prism or features.
Timing offset: An error between satellite and receiver clocks.
Total Station: A surveying device which uses electronic transit
theodolites in conjunction with an electronic distance meter (EDM) to read
any slope distance from the instrument to any particular spot.
Transit rule: The adjustment method then the error of closure is a
result of accidentally errors affecting and that the angular errors are less that
the linear errors.
Traverse stations (TS): Turning points of a traverse, whose X and Y
coordinates are to be determined in some reference system of coordinates.
Traverse: The method of the field surveying. It consists of a series of
lines, whose lengths and directions are measured by surveyors in associated
connecting points, called traverse stations (TS) or traverse points.
Traversing by fast needle method: The method in which the magnetic
bearings of traverse lines are measured by a theodolite fitted with a compass.
Triangulation: The surveying method that is based on the trigonometry
that if one side and three angles of a triangle are known, the remaining sides
can be computed.
Trilateration of GNSS: the method of measuring the distances from 3
satellites to establish a position of a receiver on the Earth.
Trilateration: The surveying method that is based on the trigonometry
that the lengths of all the sides of the triangle are measured and a few
directions or angles are measured to establish azimuth, the remaining angles
can be computed.
User GNSS segment: Military and civilian users who use GNSS
equipment to process the received signals from the GNSS and/or SBAS
satellites.
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ASSIGNMENT 1: CADASTRAL GPS AND
TACHEOMETRIC SURVEY AND PLAT DRAWING

Description and Objectives
The aim of this lab assignment is to introduce students with the process of
measurements of cadastral land plot by using professional GPS and
tacheometer instruments, as well as to demonstrate how ArcGIS software can
be used to process field survey measurements and draw a cadastral plan.










The students will be introduced to the following cadastral measurements and
drawing topics:
Prepare and configure survey instruments for cadastral plot measurements;
Survey a plot of land based on adjacent measurements;
Use a GPS device to build a control point network for cadastral survey;
Use an electronic tacheometer/total station to survey cadastral plot objects;
Transfer the measurement data from the survey instruments to ArcGIS;
Create a GIS database of cadastral measurements in ArcGIS;
Process cadastral measurements using ArcMap;
Design a cadastral plot drawing using ArcMap.
Submission Requirements
Once you have finished the exercise, complete the questions, which you can
find within the text. Your result of this exercise must be plot_drawing.pdf file.
Preparation
GIS data for this exercise you will find: D:\Data\Lab1_Data\. On your local
computer
create
new
directory
Lab1_Result
in
C:\Users\YourUserName\Documents. This directory must contain all your
data and maps for this exercise.
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Cadastral GPS and Tacheometric Survey and Plot Drawing
EXERCISE
The aim of the lab assignment is to simulate the field activities of a surveyor,
and then a new order is received to measure a cadastral plot and produce a
cadastral drawing. These practical tasks are based on the execution of a
standard process of field cadastral measurements. Then a land surveyor /
geodesist measures a land plot and as a result provides the customer the
measurement data and plot drawing.
The first part of this lab demonstrates how to perform field measurements of
cadastral plot by using professional GPS and tacheometer instruments. This
part will start with a demonstration of technological aspects of instruments
(preparation and configuration) as well as the planning of survey activities. The
second part of the surveying exercise demonstrates how to build a geodetic
ground GPS point network according to the shape of the land plot and its
topography. The procedures of GPS surveying are described in detail. Then,
how to survey cadastral objects by using an electronic tacheometry based on
measured GPS points is demonstrated in step-by-step instructions.
The second part of this lab, instructs how to process field measurements and
draw a plot plan in ArcGIS. The first part shows how to transfer measurement
data into ArcGIS, and then how to build cadastral feature classes from
measurement data. Then demonstrates how to design and layout a cadastral
plot plan in ArcMap.
SCENARIO
For this lab, a surveyor carries out cadastral measurements to coordinate a
proposed land plot. The plot has an adjoining boundary with seven existing
parcels. The information on the neighboring parcels can be found in the public
registry/cadastre. The area of the projected plot is larger than 30 hectares – this
is a large plot. The task is to compile a plot boundary drawing which also
shows metric measures of its segments and other associated cadaster objects.
The resulting cadaster data should be stored in a geodatabase.
The field measurements were done using a Leica GPS 1200 instrument and a
Leica TPS 1205 tacheometer/total station. The details of presented
measurement instructions can vary according to the manufacturer
specifications of devices used; however, the principles of measurement
methodology remain the same. ArcGIS Desktop version 10.2.2 is used for
processing and presentation of measurements. Due to the differences in
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functionalities of ArcGIS versions, the implementation of some ArcMap steps
can slightly vary.
PART A: GPS AND TACHEOMETRIC SURVEY OF CADASTRAL
OBJECTS
Surveying, like any profession, has its special terms and slang. The surveying
terms and slang can be slightly different, depending on the country. In this lab,
the following terms will be in used.
Land parcel is a single area of land under homogeneous real property rights
and unique ownership. Land plot is a component of a land parcel, normally
defined by the way in which the land is used and capable of being plotted on a
map. In this lab, the ownership of the proposed plot is unknown; we are only
dealing with surveying component of cadaster objects. Cadastral plan is a
plan that showing land parcel and/or plot boundaries. Cadastral plans may also
show buildings and other associated objects.
Land boundary is a line of demarcation between adjoining parcels or lots of
land. A land boundary may be marked on the ground by material monuments
placed primarily for that purpose; by fences, hedges, ditches, roads, and other
service structures along the line; or by coordinates on a survey whose position
on the ground is witnessed by material monuments/markers that are established
without reference to the boundary line; and by various other methods. A
boundary line is a line along which two areas meet. Boundary survey is a
survey made to establish or to re-establish a boundary’s line on the ground, or
to obtain data for constructing a plot showing a boundary line. Another term
for cadaster drawing is a plot. A plot is a drawing of a parcel of land created by
the surveyor that shows the fieldwork, with bearings, distances, etc.
Tachometry (from Greek for "quick measure") is used for cadaster survey of
land plot/parcels boundaries. Traditionally, tachometry or tacheometry is a
method(s) of surveying for the determination of distance, direction, and relative
elevation of a point with respect to the survey station (a position from which
measurements in surveying are made), by a single observation on a rod or other
object at the point. The tachometry computation uses a single survey station at
a control point with known coordinates. Traditionally a tachymeter or
tacheometer was a type of theodolite. A modern electronic tachometry uses a
total station (slang), which contains a theodolite and Electronic Distance
Measuring (EDM) instruments, to measure distance, direction, and relative
elevation by reflecting off a reflector’s prism placed at the point. Total station
instruments include or are connected a field computer that stores readings and
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facilitates the processing of the data electronically. The computer records the
slope and horizontal distances, horizontal and vertical angles from the survey
station to the point, and can perform numerous calculations, including absolute
coordinates of the point, using operating software that is loaded into the unit.
The surveying of a proposed cadastral plot plan starts with the establishment of
geodetic GPS ground control point network. The GPS point network is
necessary for the positioning and orientation of a tacheometer at a survey
station from which the plot’s boundary will be measured. The orientation of
tacheometer is carried out at a survey station, which consists of two GPS points
(fixed GPS points). One GPS point can be used as a tacheometer position and
second one for the orientation of a tacheometer. At least two GPS points are
necessary for orientation a tacheometer on a station. This technique of
tachometry survey from two GPS control points is shown below:

Figure 1: If trees and hills obstruct the views in survey area, it is necessary to
set up two stations with two GPS points each. Two measurement stations –
station #1 with GPS points 1A and 1B, and station #2 with GPS points 2A and
2B. GPS point 1B is used for a tacheometer positioning, and GPS point 1A is
used for the tacheometer orientation. Similarly, GPS point 2B can be used for a
tacheometer positioning, and GPS point 2A is used for the tacheometer
orientation or vice versa.

If the terrain is relatively flat throughout the surveying area (in the range of up
to 3 meters) then it is enough to use only one station with two GPS points to
survey whole area. However, if in the area there are objects such as forest,
bushes, single trees that can obstruct the view between two GPS points or from
a tacheometer position to measured objects, then in the practice, surveyors
established a number of two-GPS points’ stations that cover the entire
surveying area.
84

As soon as a tacheometer is positioned and oriented at a GPS point, a plot’s
boundary and other objects around the positioned station can be measured
using a tacheometer and reflector with a prism.
The example implementation of such a survey technique is described in Part A
of this lab. In this part of the lab, you will just need to follow the steps and
answer the questions found in the text.
Another classical tacheometric survey method is more complex. It is a traverse
from two GPS points with known coordinates through the surveying area that
also ends with two known GPS points. The example is shown below:

Where A and B, C and D are GPS known points. 1, 2, 3, 4 points are the
intermediate traverse points which should be measured and used for
tacheometry. To improve the accuracy of measurements, adjustments of the
traverse measurements can be done e.g. by software of a total station
instrument. To perform the adjustment, the traverse should end with two
known GPS points.
Preparation Stage:
At the beginning of survey work, a spatial configuration of the proposed plot
should be examined using existing topographic materials, such as orthophotographs and existing cadastral plots (Figure 2). This is necessary for a
surveyor to plan where to set up survey stations with two GPS points that will
be using for measuring of the proposed plot’s boundary and associated objects.
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Figure 2: The orthophoto plan of survey area – red line shows the boundary of
proposed land plot and green lines show the boundaries of existing
parcels/plots.

Positions of stations (GPS points) have to be selected according to the natural
characteristics of the proposed plot, i.e. the plot shape, terrain and pattern of
forest cover. A denser network of GPS points is better according the surveying
guidance. GPS points should be fixed in open areas from which the boundary
of plot is clearly visible as well as the plot’s corner points (buildings,
infrastructure objects, etc.). A GPS point network should cover the whole
surveying area and allow coordinating of all associated plot’s objects. Thus, the
number of the GPS points can vary depending on the natural characteristics of
survey area, for example:

•

•

If a plot is in an open field and on a plain surface, and all surveying objects are
visible from 2 GPS points, then 2 measurement stations are enough to survey a
plot. These two stations will have 4 fixed GPS points (two for each GPS
station). Two stations with 4 GPS points are necessary to check and adjust the
measurements;
If a plot is located in a hilly or/and wooded area, a GPS point’s network should
include as many points as necessary, in order to coordinate all objects of plot.
For example, if 20 measurement stations are needed, there should be 40 GPS
points measured (two for each GPS point) in order to survey whole plot.
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In our case, the survey area is a wooded field with a large perimeter; therefore,
a several GPS stations should be used to survey the plot using the discussed
tacheometry technique. On arrival to the study area, the configuration of the
plot should be analyzed and a decision made on how many stations should be
set and where the GPS points will be fixed. An optimal configuration of
geodetic ground point network should be selected.
As discussed above, a GPS point should be fixed in an open area from which it
would be possible to survey the terminal points of plot boundary. Each station,
from which a plot will be measured, must consist of at least two GPS points,
i.e. the minimum number of the points necessary to carry out this tacheometry
technique. A third point can also be fixed in the station to increase the accuracy
of the measurements through adjustments, but two points are normally enough
for accomplish a cadastral survey with required accuracy.
The position of GPS points should also consider the positions of GPS satellites
in the sky. Any surrounding objects, such as buildings, trees, should not disturb
satellite signals received by a GPS device. During the measurements, a GPS
device should have direct views to at least 6-7 (maximum of 12) satellites, as
well as to signals from differential correction satellites or networks (if
provided).
Considering all these requirements, 12 stations with 24 GPS fixed points were
selected at the surveying area. This configuration covers the entire surveying
area, as shown in Figure 3.
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Figure 3: The scheme of tacheometric stations and GPS points

- a fixed GPS point;
- a turning point of the land plot;
- the boundaries of proposed land plot;
- the boundaries of existing land plots;
- the field road.
GPS Measurements Stage:
Leica GPS 1200 receiver was used for GPS measurements. To start the
measurements at a GPS point, a new job was created by pressing Management
> Jobs > New (see the sequence of print-screens of GPS receiver below).
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When a dialog of the new job was opened, the new job title was entered, for
example, GPS_points. Then, by pressing Cont (Continue) button, metadata for
the job can be entered.

Returning to the Main Menu, the Survey option was selected. Then the
GPS_points job was selected from the Job list and then Cont button was
pressed.
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Now GPS coordinates on the occupied point can be fixed. The dialog shows
the parameters of the signal strength and accuracy, which have to be
considered before fixing the GPS point coordinates.

1.
2.
3.
4.

Figure 4: Main screen of signal strength and accuracy parameters of GPS
device:
Number of available satellites.
Satellite signal strength. Black bands indicate GPS signals strengths, red –
GLONASS signals strengths.
Available accuracy.
PDOP parameter.

The accuracy of ongoing cadastral measurements of horizontal coordinates
must be less than 0.03 m. To achieve such accuracy, a high-quality signal
should be awaited for about 1-3 minutes. In addition, the PDOP parameter
should be considered. This parameter shows the accuracy of the satellite
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signals, which should not exceed 4.00 PDOP for cadastral measurements. The
smaller the PDOP value, the smaller are the satellite signal errors, and the more
accurate are measurements of point coordinates. Therefore, before fixing the
point coordinates, the horizontal measurement error of the GPS device should
be less than 0.03 m and PDOP less than 4.00. If the values of these parameters
correspond to the surveying requirements, then the GPS point coordinates can
be fixed.
When the required accuracy is reached, the GPS receiver was set on the station
point and Occupy option was applied. The point coordinates were set
automatically after 20 seconds. It necessary to set the point coordinates 2
times; the second measurement is necessary for confirmation.

Next, the coordinates of other remaining 23 GPS points of selected 12 stations
(Figure 3) were measured. Again, each point was measured twice for
confirmation. Surveyed GPS points were marked with the temporary markers,
such as lath and ribbon, in order to find them later when the tacheometric
survey will be carried out.
The coordinates of 24 GPS points were measured by Lithuanian surveyors.
They are shown in Table 1. These points are prepared in LKS-94, which is the
Lithuanian Coordinate System based on Lithuania 1994 (ETRS89) datum
http://georepository.com/crs_4669/LKS94.html.
Table 1: A list of the GPS point coordinates
Coordinate system LKS-94
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358.5
6
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1
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160.5
8

5441
35.6
4
5441
84.5
9
5441
00.9
8
5440
37.4
9
5439
50.2
9
5438
57.7
3
5437
72.0
5
5437
13.9
2
5437
56.5
6
5436
70.9
6
5438
52.2
5
5438
75.9
6

Question 1: What is the minimum number of GPS points that must be
measured for cadastral survey of plot? (2 points)
a) 2 GPS points
b) 4 GPS points
c) 6 GPS points
d) 8 GPS points
Question 2. What are the main criteria for choosing right positions for
measuring GPS points in tachometry survey? (2 points)
a) Relief
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b)
c)
d)
e)
f)
g)
h)
i)
j)

Vegetation (trees)
Buildings
Weather
a and b
b and c
c and d
a, b, c, and d
a, b and c
b, c and d

Question 3: Minimum of 4 satellite readings is necessary to get an accurate
3-D position using a GPS receiver. Explain why. (4 points)
Question 4: What coordinate system is used to define the position of GPS
satellites? What coordinate system is used in GPS receivers? (4 points)
Question 5: PDOP stands for: …. Quantify your answer. (3 points)
Question 6: We mentioned about “differential corrections”. What does this
term mean and how does DGPS work? (4 points)
Tacheometric Survey Stage:
After fixing the coordinates of 24 GPS points, the points’ measurements, which
are their LKS-94 coordinates, should be transferred from the GPS data-logger
to the electronic tacheometer. Leica TPS 1205 total station was used as the
tacheometer for the fieldwork. Since there were not too many fixed GPS
points, they can be manually added into the tacheometer, since usually there
are no devices for data transfers in the field.
To add a new GPS point into tacheometer, first, the Management option was
used, and then Data > New point options were selected (see the sequence of
print-screens of GPS receiver below).
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In the New Point dialog, a new point was created in the tacheometer by
entering its ID, Easting (Y) and Northing (X) coordinates obtained from the
GPS measurements. The Store command was applied to create the point, so the
point was saved in the device memory.

The same dialog was used to enter ID and coordinates of another GPS point.
Sequentially, all points listed in Table 1 with their ID and GPS coordinates
were entered in the tacheometer. ESC button was used to return to the main
menu.
Once the GPS points with coordinates are entered into the tacheometer, the
survey of plot boundary can be started. To start, a new job was created by
pressing Management > Jobs > New.
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The job title Measurements was assigned to the new job. Then, by applying
Cont button, metadata for the job can be entered.

Next, the total station was positioned on one of the measured GPS points,
which was found by the temporal marker created on site earlier. Then, the total
station was horizontally aligned by using its level.
Then the Survey option was selected from the Main Menu.
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Next, from the job list, the Measurements job was selected and the Setup
button was clicked.

Once the Setup dialog window was opened, a function Known BS Point was
selected from Method list. Then the From Job option was selected from the
Station Coord list. In the list Station ID, the GPS point on which a device was
fixed was selected (one of the 24 measured GPS points). In this case, it was the
1st GPS point. The value of Instrument Ht option should be left empty. The
heights of the points were not measured because a georeferenced orthoptograph
was used as a background for a survey plan. In the list Fixpoint Job, the job
Measurements was selected. These parameters were applied by clicking the
Cont button. These setting defined the position of the tacheometer.
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In the next dialog window Set Stn & Ori - Known BS Point, the GPS point to
which the tacheometer should be oriented was selected from the list Backsight
ID, e.g., this is the second GPS point. If tacheometric station consists of two
GPS points #1 and #2 (see Figure 3), and if the tacheometer was positioned at
the point #1, then it should be oriented to the point #2. Thus, the list value of
Backsight ID was set up to the point #2. These setting defined the orientation of
tacheometer.

Next, the telescope of tacheometer was oriented to the prism (Figure 4), which
was positioned at the second point, and then Set. The orientation of device was
confirmed by pressing OK.

Figure 5: Directing the tacheometer into the prism
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Question 7: What is the minimum number of GPS points that must be used
for orienting tacheometer? (2 points)
a)
2 GPS points
b)
4 GPS points
c)
6 GPS points
d)
8 GPS points
Once the instrument was oriented, the measuring dialog window opens
automatically. To start measuring, the Survey button was clicked, the
previously created Job was chosen and then DIST button in the Job menu
dialog was selected. The prism was positioned on a turning point of the land
plot. Then the REC button was pressed to save measurement and the next
measurement point was chosen. Thus the plot boundary and objects of interest,
which should be shown on a cadaster plan, such as roads, power poles, etc.,
were measured around the GPS point #1.
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Road surveying: To survey the roadsides, the reflector with prism was set on
the edge of the road. Edges of roads were measured in terminal points from the
both sides, then later they can be joined to show road on a plat. The example of
a survey of road section is illustrated in Figure 5. The drawing shows where the
road terminal points were fixed.

Figure 6: The drawing of road terminal points’ survey

The surveying of power poles: To survey the power poles, the prism was
positioned near the power pole directly to the tacheometer. Then the exact
positions of the power poles were fixed.
Other plot objects, such as fences, forest boundaries, etc., are surveyed in
turning points, which are where the objects change in configuration, position
or/and direction.
During the tacheometry, each surveying object was coded with the following
descriptions: house-1, house-2, house-3 – these points indicate the house corner
or wall edge; road-6, road-7, road-8 – these points indicate the road terminal
points; fence-7, fence-8, fence-9 - these points indicate a terminal point of the
fences, etc.
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If the visibility in the surveying area is good, the coordinates of a plot object
can be done with a laser beam without using a reflector with prism. By
pressing Shift and F11, the laser is activated. By press F11 change from the
prism mode into the reflectorless mode.

The laser of the tacheometer can be pointed at a plot object (e.g., poles), plot
terminal points (e.g. fences), and their coordinates can be fixed. Measurements
by the laser speed up the work and make it easier, because an assistant to the
surveyor does not have to walk and move a reflector. In addition, the
measurement with a laser is very convenient when measurements are made in
hard to reach or dangerous locations. However, reflectorless survey can be less
accurate.
The cadastral measurements in the surveying area have been completed. Now
the measurement data should be transferred into the GIS to prepare the plot
drawing.
Question 8. What is the main purpose of using tacheometer in cadastral
mapping?(2 points)
a)
For measuring GPS points coordinates
b)
For coordinating the objects of plot
c)
For compiling cadastral plan
d)
For editing measurements data
Question 9. In tacheometric survey, when you can use laser to survey objects
instead of using reflector? (2 points)
a)
When the objects are difficult to reach
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b)
c)
d)

When raining
When good weather
When you don't have tachymeter

Question 10. State the principle of tacheometric survey (4 points)
Question 11. A total station contains
________________ instruments (2 points)

a

______________

and

Question 12. What for the second GPS point is required to set up an
electronic tacheometer at station (2 points)
PART B: TRANSFERING THE CADASTRAL SURVEYED DATA
After making the cadastral measurements of the survey area, preparation for
the plot drawing can begin. Before designing a plot, the measurement data
should be transferred from the tacheometer into the GIS, where you will do the
data processing as well as design a plot drawing. For this task, you will be
using ArcGIS for Desktop, where you will transfer the measurement data into a
geodatabase.
The software of Leica devices (GPS and tacheometer) includes functions for
data conversion and export. Conversion can be done from the Main Menu by
follow Main Menu > Convert > Export Data from Job > Cont. In the Job list,
the Measurements job, which was created and filled in tacheometric survey,
was selected.
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Then by applying Cont, the measurement data was saved in TXT format in the
memory cards of the tacheometer. Using a memory card reader (usually it is
integrated in a computer), the measurement data was transferred into a personal
computer, which has the ArcGIS software.
From this point, you should not only answering questions, but also start to
work on this assignment task in ArcGIS.
1. You can find Measurements.txt file with the measurement data in your
working directory, e.g. Lab1_Data.
Now you will import the TXT file into ArcGIS.
2. Open ArcCatalog. Create a folder connection to your working directory
where you copied the TXT file. Right-click the Folder Connections entry of
ArcCatalog tree and select Connect to Folder.
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In the opened dialog of Connect To Folder, set the path into your working
directory (Lab1_Data).

Additionally, create a directory Data where you will create databases, and so
on.
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3. Create a database where you will transfer the tacheometric measurement
data. Right-click on the Data folder and select New > File Geodatabase. Name
the new database as Measurements.gdb.

4. Open Measurements.txt file in any text editor and check that the
measurement data are saved in such form:

The column names should be specified such as ObjectID, POINT_X,
POINT_Y and the measured point data should be listed below. The data values
delimited with a space. The measurement data can be edited in a text editor, for
example, Notepad, etc.
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5. In ArcCatalog, find and select Measurements.txt file in your working
folder. Right-click on Measurement.txt and select Create Feature Class >
From XY Table.

In the opened window, select the file’s fields that include the X and Y
coordinates (in this case, it is POINT_X, POINT_Y), then select the
Coordinate System of Input Coordinates as LKS_1994_Lithuania_TM. You can
search
this coordinate system by the keyword LKS in the Spatial Reference
Properties dialog. Finally, set Output into Measurements.gdb\Measurements
feature class of File and Personal Geodatabase. Click OK.
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6. Check that the data from TXT files have been transferred to the database
Measurements.gdb properly. Open the database Measurements.gdb, select
the feature class Measurement and click Preview in the right window of
ArcCatalog. You should see the measurement points transferred from the TXT
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file. If the Measurement layer looks like as the following example, it means
that you successfully transferred the data into the geodatabase.

7. To create a drawing of cadastral plot, you need to filter roads, plot
boundary and other objects from the tachometry data collection. You will do
that by creating feature classes for each respective cadastral object class within
Measurements.gdb. Open the database Measurements.gdb, right-click on it
and select New > Feature Class.
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You start with creating a roads feature class by specifying the Name as Roads
and select its Type of geometry as Line Features. Then click the Next button.

Then you should select the coordinate system of the feature class, which will
be again LKS_1994_Lithuania_TM and then click the Next again.
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Accept the default settings of XY tolerance and the database configuration in
the next two dialogs by clicking the Next buttons.
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In the last dialog window, you may enter names of the attribute table columns.
For example, if you are creating a feature class of buildings, then you may
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specify the type of the buildings (e.g., made of bricks, wooden, inhabited,
uninhabited, abandoned and so on). In our case, creation of fields for additional
attribute is not required. Click Finish. You have just created a first feature class
Roads that is still empty.

PART C: PROCESSING THE CADASTRAL DATA
In this part of the lab, you will split, update and edit the measurement data, i.e.
you will create and/or load feature classes of roads, plot boundary and other
surveyed features.
8. Open ArcMap and Add the two feature classes from Measurements.gdb
database. Zoom to measurements layer: right click on it > Zoom To Layer.
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The layers are displayed in the left Data view window of ArcMap. You will
only see the data of measurements layer. Road layer is the only feature to
display so far.

9. To start loading the roads, plot boundary and other objects with features
from the tachometric data collection, you have to work in an editing session of
ArcMap. Bring Editor toolbar on the ArcMap interface: in the main menu of
ArcMap, navigate to menu Customize > Toolbars and check Editor.
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10. Start the data editing session from the Editor toolbar dropdown menu by
clicking Start Editing. Remember that after finishing an editing session, you
have always to Save edits from Editor toolbar dropdown menu.

11. To have a perfect matching among edited features, the snapping mode
should be turned on. This mode allows snapping to points, ends, vertices or/and
edges of coincident features from one layer or multiple layers. For example, if
you will build a road by connecting GPS data points, you will need the
sidelines of road to be perfectly snapped with those GPS points. You can
activate the snapping mode by clicking the dropdown menu of Editor >
Snapping > Snapping Toolbar.
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The Snapping toolbar will open. You can leave the standard Snapping settings,
which are activated for the four types of snapping: points, ends, vertices and
edges. From the Option link of Snapping dropdown list, open the Snapping
Options dialog window and check Show tips boxes. It will help during manual
edits.
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12. First, you will create a parcel_line feature class. From the tacheometric
survey, we know that our plot boundary line consists of the measurement
points with the ID from 1 to 48 (you may have taken notes about this while
carrying out the survey, or added associate code as an additional attribute to
surveyed points). Thus, you have to select only those points from the
measurements collection feature class. Double-click the measurements layer
and select Properties.
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In the dialog window of Properties, select the Definition Query tab and build a
query as OBJECTID_1 <= 48 and press OK. Then the layer measurements
will display only the points with ID less than or equal to 48.
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13. In the ArcToolbox
, search and find a tool that will convert the selected
48 points into the line, which marks the boundary of land plot. Navigate
through the Data Management Tools > Features and run Points To Line tool.

In the Points To Line tool dialog, select the measurements layer from the
dropdown list of the Input Features textbox. The tool will only use the selected
GPS points from 1 to 48 in processing. In the field Output Feature Class,
navigate to the measurements.gdb database and enter the name of the new
feature class, for example parcel_line. Check the Close Line box. Click OK.
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The tool will create a new linear layer, which will outline the boundary of land
plot.

14. Then you will use the parcel_line feature class to create a polygonal
feature class of the plot. This polygonal feature class can be used to find out the
exact length (or perimeter) and area of the land plot. Before creating a polygon,
make sure that your parcel_line is a closed polyline, i.e. the plot boundary
begins and ends at the same point. In ArcToolbox, find the tool which will
convert the parcel_line feature class into a polygon. Navigate through the Data
Management Tools > Features and run the Feature to Polygon tool.
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In the dialog of Feature to Polygon tool, select the parcel_line layer from the
Input Features dropdown menu. In the Output Feature Class box, navigate to
Measurements.gdb database and enter the name of the new layer, for
example, parcel_polygon. Click OK.

The tool will create a new feature class of the area of land plot.

119

15. Save your work as MXD document
in your working folder and repeat
the Save operation from time to time in order does not lose your ongoing work.
16. Next, the roads feature class will be created based from the measurements
feature class. Repeat step 12, but this time build a Definition Query only for
those points which ID larger than 48. You will see selected points depicting the
roads in the Data View.
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Question 13. How many road’s points you selected from the measurements
feature class? (2 points)
17. This time you will use the Straight Segment tool
of Editor toolbar to
connect the selected measurement points into the road feature class. From the
Editor toolbar, choose the Create Feature option
.

In the Create Feature dialog window, select the road feature class and
Line Construction tool below it.
Start drawing the road sideline from the first road point (see the below printscreen) using Straight Segment tool
. When you move to a point, make sure
that the cursor is snapped – it should show snapping tip such as
Measurment.Point, and only then click on the point to create a polyline
vertex. Connect points from the same sideline into a polyline. When you reach
the last point of a sideline, double-click on it to complete the polyline.
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Create roadside polylines from the remaining points. The road network from all
measurement points is shown below.

Finish the data editing session by following from the dropdown menu of Editor
> Save Edit > Stop Editing.
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PART D: DRAWING THE PLOT CADASTRAL PLAN
In the last part of lab, you will be using the ArcGIS cartographic functionality
to compile a plan drawing of the land plot, which will include cadaster objects
and tables, annotations, titles and other associated cartographic elements.
18. You will start with symbolization of the plot boundary. Repeat step 12 to
select only the plot boundary points. Then click on the symbol of
measurement layer to open the Symbol Selector dialog. Select a triangle
symbol to display the plot terminal points. From the Color dropdown palette,
select a red color. Choose 10 pixels for the symbol size. Then click OK.

19. Label the plot terminal points by using their points ID. Double-click the
measurements layer to open the Properties window. In the Properties
window, select the Labels tab. Check the option Label feature in this layer. In
the Text Spring section from the Label Field list, select the field
OBJECTID_1. Select the type and the size of the font, e.g., Arial Narrow and
8 pixels, and then click OK.
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The plot will be symbolized with the chosen symbology and labels.

20. Next, you will design the parcel_polygon layer. Click on a symbol of
parcel_polygon layer to open the Symbol Selector dialog. Set a light gray color
from the Fill Color palette. Do not use outline for this layer. Set the Outline
Width as 0.00 or/and Outline Color as in No Color. Click OK.
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21. Then you will label the plot polygon with its area and perimeter; these plot
dimension parameters are often shown on parcel plot. Double-click on the
parcel_polygon layer to open the Properties dialog. In the dialog, select the
Labels tab, and check the option Label feature in this layer. In the Text String
block, click the Expression button.
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In the Expression box, you can enter attribute fields that will be displayed as a
part of label, and a static text to annotate a label. Use the following expression:
"Parcel Lenght = "& [Shape_Length]
Parcel Area = "& [Shape_Area].

&

vbCrLf

&

"

User defines the text in the quotes. The symbol & is used to join one text
segment with another. The special combination vbCrLf is used to create
staked text. For example, this expression creates a label with the
Shape_Length field and the Shape_Area field on separate lines. The
square brackets enclose field names, whose values will be inserted into the text
label. Click OK.

Additionally, you may define the type and size of label font. On a map, you
will see a labeled plot with its metric values.
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If you are not satisfied with the number of decimal places depicted the parcel
length and area, you can change it. Open the Open Attribute Table of
parcel_polygon layer. Then, open the Properties dialog of Shape_Length
column – right click on the column header and choose the Properties option. In
the Properties dialog, click Numeric button .
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In the Number Format dialog, change the value of Number of decimal places
within the Rounding block to 2. Repeat the same for Shape_Area column.
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The values of label’s attribute will be changed on the map. You may need to
Refresh
the plan to see changes.

22. Design the parcel_line layer.

23. Additionally, often the lengths of segments are shown between the plot
terminal points. This dimensional information is important for cadastral
purposes. First, you will split the parcel_line into straight segments. In
ArcToolbox, find and run the Split Line at Point tool from Data Management
Tools > Features. In the Split Line at Point dialog, pick up the parcel_line
from the Input Feature dropdown list, and the measurements layer from the
Point Features dropdown list. In the Output Feature Class box, navigate to the
Measurements.gdb database and specify a new output feature class as
parcel_line_measurements. Set the Search Radius to 10 m.
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The tool will partition the parcel_line polyline into straight-line segments
where the polyline touches the points of the measurement feature class. As a
result, the tool creates a new feature class that matches the parcel_line,
however, the polyline traverse will be partitioned into straight-line segments
and the lengths of segments will be calculated.

24. Now you will design the parcel_line_measurements layer. Make the
symbol of this layer invisible, because the parcel_line layer already shows the
plot’s boundary. Change the symbology of parcel_line_measurements layer
to No Color or/and zero width.
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25. Label the segments of parcel_line_measurements layer with their
attribute values from the Shape_Length field. Use the same procedures that
you have done above to label the parcel_polygon layer.
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In addition, round Shape_Length values to 1 decimal place similar as you
have done above for the parcel_polygon layer.
26. Finally, you have to layout the plot. First, switch to the Layout View from
the ArcMap main menu View > Layout View.

27. Set the Page and Print Setup parameters in the ArcMap main menu File >
Page Setup and Print dialog. Set a page size of the plat to A4 and landscape
orientation.
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28. Set 1: 5000 scale of the plot. Fit the plat on the right side of layout page by
using the zoom tools from Tools toolbar and resizing the map frame anchors.
Use the Select Elements tool
to work with layout frames.
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Question 14. What is system of metes and bounds that is used to describe the
extent and location of property units? Describe the concept of this western
European system. (4 points)
29. Now you will insert other plan elements such as a legend, north arrow,
annotation, scale etc. on the layout. All of these plat’s elements can be inserted
from the ArcMap main menu Insert.
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You can customize inserted plot elements by changing their Properties. In the
right top side of drawing layout, insert the title of plot’s plan and a date of
drawing’s complied into a separately text frame such as it is shown below.

30. Next, insert a geographical grid around the plan. Use the Select Elements
tool to select the frame with the plan, then right-click on it and open the frame
Properties. In the dialog, go the tab Grid and press the New Grid button.
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Go through the grids wizard steps and select the main geographical grid
settings as shown below. Apply the Finish button on the last wizard step and
then OK.
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The plot’s title should look like as the following:

If you would like to change the grid appearance, select it with the Select
Elements tool, right click it to open its Properties. Now you can customize the
grid appearance from the tab Grids by using the Properties of selected grid.
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Change the grid so that the side labels of geographic coordinate are aligned
properly and make the tics of grid denser, as it shown below.

31. Now you will insert tables from the PlanTable.xlsx file. These tables were
prepared for your use. The tables provide information about the surveyors and
other characteristics of plot. There are a few ways to insert tables into an
ArcMap layout. If a table prepared in Microsoft Excel, it can be directly
inserted into an ArcMap layout. Open the PlanTable.xlsx file in Excel from
your working folder Lab1_Data.
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32. Select one table and copy it in the clipboard (you may use keyword
combination Ctrl+ C to copy). Insert a copied table in the plat below the title
from the ArcMap main menu Edit > Paste, or use the keyboard combination
Ctrl+V. Adjust the table into the layout as it shown below by using the Select
Elements tool.
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Copy and insert the second table into your plot’s layout. These tables can be
used to annotate the plot.
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Thus, you have compiled a cadastral plot drawing.
33. Print the plot drawing in PDF format: from the ArcMap main menu File,
use the Export Map option. In the dialog, select PDF as the Save As Type, 300
dpi as the Resolution and export the plot’s drawing into your working folder
with the name plot_drawing.
Open your plot_drawing.pdf file in Adobe Acrobat Reader. ArcMap creates a
dynamic PDF file. In Adobe Acrobat Reader, navigate to the main menu View
> Navigation Panes > Show Navigate Pane > Layers if you do not see the
Layers menu in the PDF viewer. You can then turn on and off individual layers
by clicking on the "eyeballs" beside each layer.

Question 14: Submit you plot_drawing.pdf with your lab hand-in. (15 points)
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CHAPTER II
2. SPATIAL DATA SOURCES FOR CADASTER: REMOTE
SENSING
2.1. WHAT IS REMOTE SENSING?
The simplest definition for the term Remote Sensing is: “Remote
Sensing (RS) is the acquisition of information about an object without
touching it.” This definition is not very helpful in describing the field of
remote sensing.
John Jensen (2007) offers a more descriptive definition:
Remote Sensing is the “noncontact recording of information from the
ultraviolet, visible, infrared, and microwave regions of the electromagnetic
spectrum by means of instruments such as cameras, scanners, lasers, linear
arrays, and/or area arrays located on platform such as aircraft or spacecraft,
and the analysis of acquired information by means of visual and digital
image processing” (Jensen, Remote Sensing of the Environment: An Earth
Resource Perspective, 2nd ed., 2007).
Remote Sensing also can be considered as a discipline of Geomatics
or Geo-Information Science, along with GPS and Cartography (Figure 1).

Figure 1. Remote Sensing as a sub-discipline to GIS.

In much of remote sensing, the process involves an interaction
between incident radiation and the targets of interest. This is exemplified by
the use of imaging systems where the following seven elements are involved
(Figures 2-9). Note, however that remote sensing also involves the sensing
of emitted energy (or thermal energy) and the use of non-imaging sensors.
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Figure 2. Seven elements comprise
the remote sensing process from
beginning to end (A to G). (CCRS,
2004).

Figure 2. Energy Source or
Illumination (A): The first requirement
for remote sensing is to have an
energy source, which illuminates or
provides electromagnetic energy to
the target of interest (CCRS, 2004).

Figure 3. Radiation and the
Atmosphere (B): As the energy
travels from its source to the
target, it will come in contact with
and interact with the atmosphere it
passes through. This interaction
may take place a second time as
the energy travels from the target
to the sensor (CCRS, 2004).

Figure 4. Interaction with the Target
(C): Once the energy makes its way to
the target through the atmosphere, it
interacts with the target depending on
the properties of both the target and
the radiation (CCRS, 2004).
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Figure 5. Recording of Energy by
the Sensor (D): After the energy
has been scattered by, or emitted
from the target, we require a
sensor (remote - not in contact
with the target) to collect and
record the electromagnetic
radiation.

Figure 6. Transmission, Reception,
and Processing (E): The energy
recorded by the sensor has to be
transmitted, often in electronic form,
to a receiving and processing station
where the data are processed into an
image (hardcopy and/or digital)
(CCRS, 2004).

Figure 7. Interpretation and Analysis
(F): The processed image is
interpreted, visually and/or digitally or
electronically, to extract information
about the target that was illuminated
(CCRS, 2004).

Figure 8. Application (G): The final
element of the remote sensing
process is achieved when we apply
the information we have been able to
extract from the imagery about the
target in order to better understand it,
reveal some new information, or
assist in solving a particular problem
(CCRS, 2004).

2.2. USE OF REMOTE SENSING FOR CADASTER
Remote Sensing (RS) has become a traditional source of information
for a variety of applications such as agriculture, natural resource
management, forestry, urban planning etc., because it is relatively
inexpensive, provides rapid collection of data for large areas and often
offers more current information than maps in vector or paper formats.
Among those Remote Sensing applications is land management. Land
management is often based on a cadastre where the landscapes have been
structured as land parcels defined by polygons, each polygon being
modelled as an object with attributes and relationships with its neighbours.
Remote Sensing sources (aerial photograph and satellite images) are
widely used for cadastral purposes. The following practices of Remote
Sensing use in cadastral mapping can be identified:

Remote Sensing images of high-resolution may be used for
creating cadastral maps. Large-scale aerial and satellite imaging offers a
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rapid and cost effective means of extracting topographic and cadastral
information for creating maps of parcel fabric. Although aerial and satellite
surveys are not the best alternative to field survey with respect to surveying
accuracy of parcel boundaries, in many countries it is impossible to do mass
rapid cadastral field surveying, and RS techniques can be alternative
approach for establishment of a cadastral system in its initial stages. Thus,
orthophoto imagery can be used to delineate land parcels with relatively low
accuracy for property registration, later updated from field surveying. In
addition, orthophoto and LiDAR imagery can be used to delineate cadastral
objects on the properties such as buildings or elements of the utility
infrastructure (hydrant, power lines etc.)

Thus according with General Survey Instruction Rules for
British Columbia (General Survey Instruction Rules, 2015), the position of
natural boundaries may be determined by any survey method that yields an
accuracy of 0.5 metres or better. Such methods also can include indirect
photogrammetric methods, e.g., aircraft and satellite images.

Remote Sensing imagery can be used for updating cadastral
maps. RS is a rapid technique for monitoring changes of cadastral objects.
Illegal use of land and illegal construction on the land can be effectively
monitored via RS techniques.

RS imagery from land resource satellites are traditionally used
for land use and land cover (LU/LC) classification. Such LU/LC
classifications are then used for urban and rural zoning, definition of
protected areas, etc. RS can be an instrument to monitor the evolution of the
actual land use using spatial indicators relevant for policy at the political
level to support decision-making.

Remote Sensing imagery can also be used for land and real
estate evaluation. For example, RS imageries can be used to classify urban
areas based on quality of land and then this zoning can be used for land
evaluation and taxation. Real estate agents and potential purchasers can
review properties using high-resolution 3D views created from RS imaging
sources without needing to visit the site.

Local municipal organizations are actively using RS sources for
their asset infrastructure management. Cadastral related objects such as
electricity lines, poles, manholes, etc. can be mapped and monitored using
high-resolution imagery.

Remote sensed imageries provide a historical record of the areas
that can be revisited in the future to see what changes have taken place and
identify areas in need of updating cadastral records (deeds). In smaller
spatial scales, RS sources provide means to describe urban pattern and
spatial directions of urban growth.
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There are also some disadvantages for using remote sensing for
cadastre. Property boundaries frequently do not have visible marks on the
ground, so finding the boundaries using RS techniques may be difficult.
Aerial and satellite imaging is also highly dependent on weather and
climatic conditions.
The implementation of Remote Sensing for land management
applications has dramatically changed with digital, web and mobile
technologies. In the 1980s, aerial photographs were systematically scanned
to be digitally processed and used for land management purposes. In the
1990s, most aerial and satellite imagery was captured in digital formats. In
the 2000s, near real-time processing systems began to be used to produce
quick-turnaround imagery in digital format within hours of data acquisition
through the web or Wi-Fi. More recently, LiDAR (LIght Detection And
Ranging) technology appeared in the remote sensing market. LiDAR can be
used for creating a 3D cadaster, parcels mapping, identification of rooftops
of buildings, etc., but generally speaking as a developing technology LiDAR
is still looking for its application in the field of cadastre.

2.3. TYPES OF REMOTE SENSING
How do sensors differ from each other? Most of the Remote Sensing
systems can be distinguished between each other based on: platforms for
remote sensing sensors; use of energy sources; imaging methods; and image
characteristics.
Platforms for Remote Sensing Sensors: In order for a sensor to
collect and record energy reflected or emitted from a target or surface, it
should reside on a stable platform removed from the target or surface being
observed. Platforms for remote sensors can be situated (Figures 10-13):
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Figure 10. On the
ground (up to 50
m) and in situ invasive
technique.

Figure 11. On an aircraft
(up to 50 km) or balloon
(or some other platform
within the Earth's
atmosphere) - noninvasive technique.

Figure 12. On
an unmanned
aerial vehicle
(UAV) (up to
20km).

Figure 13. On a
spacecraft or satellite
(from about 100 km
to 36000 km) outside
of the Earth's
atmosphere - noninvasive techniques.

Use of Energy Sources: Three main energy sources used for Remote
Sensing are:
 Solar reflected radiation (from the Sun - reflected energy).
 Long-wave emitted radiation (from the Earth - emitted energy).
o The sun's energy is also absorbed and then re-emitted in the form
of thermal infrared wavelengths.
 Human-made sources (radio and laser wave emission - active
energy).
This energy exists in the form of electromagnetic radiation (EMR). The EMR
of the electromagnetic spectrum ranges from the shorter wavelengths (including
gamma and x-rays) to the longer wavelengths (including microwaves and
broadcast radio waves). Several regions of the electromagnetic spectrum are
useful for Remote Sensing that are ultraviolet (UV), visible (Blue, Green, Red
lights), infrared (NearIR, MidIR and FarIR (or thermal)) and microwave (used for
RADAR) portions (Figure 14).
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Figure 14: Portions of the electromagnetic spectrum used in Remote Sensing

Remote sensing systems that measure energy, which is naturally
available, are called passive sensors. Active sensors detect and record
energy emitted from the sensor itself.
Passive sensors can record:

Reflected energy (visible, illuminated by the Sun).
o For all reflected energy, this can only take place during
the time when the Sun is illuminating the Earth. There is no reflected
energy available from the Sun at night.
o Optical RS makes use of visible, near infrared and mid
infrared waves’ sensors to form images of the earth's surface by detecting
the solar radiation reflected from targets on the ground.

Emitted energy (thermal infrared, emitted by the Earth and
objects on it).
o Energy that is naturally emitted (such as thermal
infrared) can be detected day or night, as long as the amount of energy is
large enough to be recorded.
o Thermal RS is operating in the far infrared part of the
spectrum: 3.0 to 14 micrometers.
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Active sensors, on the other hand, provide their own energy source for
illumination. Thus, active sensors actually emit EMR in certain wavelengths
toward the target to be investigated, and then detect and measure the returning
signal. Active sensors are much more complex than passive sensors, both in
their technology and the interpretation of the signal. Some examples of active
sensors are a laser fluorosensor and synthetic aperture radar (SAR). Thus,
RADARs (RAdio Detection and Ranging) use pulses of long wave EMR in
the radio spectrum (~1 mm – 1 m wavelengths) to illuminate the terrain to
determine the distance and angular position of objects. In a similar way as
RADAR, LiDARs (LIght Detection And Ranging) measure the time for laser
pulse (usually visible or near IR wavelengths) to return and generate distance
measurement. “Three Models” of RS is demonstrated in the following Figure
15.

Figure 15a: Passive
sensor - reflected
solar radiation.

Figure 15b: Passive
sensor - emitted terrestrial
radiation.

Figure 15c: Active
sensor - emitted own
energy. (Campbell,
1996).

Imaging methods: A Sensor’s systems can be classified by
imaging methods:
 Framing systems are instantaneously measure radiation coming
from the entire scene at once to form an image, and include:
o Analogue photographic cameras.
o Digital array sensors (digital cameras).
 Scanning systems sense the entire scene pixel by pixel (the
instantaneous field of view, or IFOV) along or across successive lines over a
finite time, and include:
o Video scanning (vidicons, video sensors).
o Optical mirror scanning.
o Line or lines’ scanning.
Image Characteristics: There are four types of image resolutions
related to image characteristics that can be used to categorized RS images as
well as RS sensors:
 Spatial resolution: smallest discernible physical object or detail in
an image.
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A measure of the spatial resolution of a remote sensing imaging
system is the most common measure of resolution and can be defined as that
area on the ground that is viewed by the instrument from a given altitude at
any given time. The detail distinguishable in an image is dependent on the
spatial resolution of the sensor and refers to the size of the smallest possible
feature that can be detected.
Spatial resolution of passive sensors depends primarily on their
Instantaneous Field of View (IFOV). The IFOV is the angular cone of
visibility of the sensor (A) and determines the area on the Earth's surface
that is "seen" from a given altitude at one particular moment in time (B). The
size of the area viewed is determined by multiplying the IFOV by the distance from
the ground to the sensor (C) (CCRS, 2004). This area on the ground is called the
resolution cell and it determines a sensor's maximum spatial resolution (Figure 16).

Figure 16: Instantaneous Field of View or sensor's maximum spatial
resolution

RS images can be classified by spatial resolution as coarse or low
resolution; fine or high resolution, and sub-meter resolution images.
Examples images in from course to sun-meter spatial resolutions are shown
on the Figure 17:
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Figure 17: Satellite imageries in different resolutions (ITC, 2006).


Spectral resolution: “thickness” of bands or channels (min and
max wavelength sensed).
A RS sensor gathers and stores information from a particular wavelength
range in a band, also sometimes referred to as a channel. A band is a region
of the EMR to which a set of detectors are sensitive.
Spectral resolution is the number, wavelength position and width of spectral
bands a sensor has. Spectral resolution describes the ability of a sensor to
define fine wavelength intervals (bands). The number and distribution of
these bands determines the spectral coverage. Multispectral sensors have a
few and wide bands. Hyperspectral sensors have many narrow bands.
Images by spectral resolution can be categorized in three types:
o Low (or coarse) spectral resolution images. E.g., panchromatic
image.
o Medium spectral resolution images. E.g., multispectral
imagery with 2 to 10 spectral bands (Figures 18-19).
o High (or fine) spectral resolution images. E.g., hyperspectral
imagery (aka imaging spectrometer) with more than 10 bands.
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Figure 18: Example of six bands (Blue, Green, Red, Near Infrared, Mid
Infrared 1 and Mid Infrared 2) of multispectral imagery

Figure 19: Color composites combinations using multispectral images (The
Biodiversity Informatics Facility at the American Museum of Natural History,
2009)

Radiometric resolution: difference between minimum and maximum
reading or measurement, or number of steps between min and max reading or
measurement.
While the arrangement of pixels describes the spatial structure of an image,
the radiometric characteristics describe the actual information content in an image.
Every time an image is acquired on film or by a digital sensor, its sensitivity to the
magnitude of the electromagnetic energy determines the radiometric resolution.
The finer the radiometric resolution of a sensor the more sensitive it is to detecting
small differences in reflected or emitted energy.
A digital image is a matrix of brightness values that are described by Digital
Numbers (DN). Brightness values or DN (Figure 20) usually are represented by
positive digital numbers which vary from 0 to (one less than) a selected power of 2.
This range corresponds to the number of bits used for coding numbers in binary
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format. Each bit records an exponent of power 2 (e.g., 1 bit equals 2 of power 1
and equals 2 (with the range 0-1), 8 bit equals 2 of power 8 and equals 256 (with
the range 0-255)) (Figure 21).

Figure 20: Brightness values of band’s pixels and their Digital Number

Figure 21: By comparing a 2-bit image representing 4 levels of brightness
(left) with an 8-bit image to display 256 levels of brightness (left), we can see
that there is a large difference in the level of detail (brightness) discernible
depending on their radiometric resolutions.

 Temporal resolution: time between repeated sensing.
The concept of temporal resolution relates to the concept of revisit
period of satellite RS, which refers to the length of time it takes for a
satellite to return and image the same point on the Earth (CCRS, 2004). The
revisit period of a satellite sensor can be several days or even a couple of
weeks. However, because of some degree of overlap in the imaging swaths
of adjacent orbits for most satellites and the increase in this overlap with
increasing latitude, some areas of the Earth tend to be re-imaged more
frequently (CCRS, 2004). Some satellite systems are able to point their
sensors to image the same area between different satellite passes separated
by periods from one to five days. Thus, the actual temporal resolution of a
sensor depends on a variety of factors, including the satellite/sensor
capabilities of off-nadir view, the swath overlap, and latitude.
A digital Remote Sensing imagery (Figure 22) consists of:
 Multiple bands or channels with a particular spectral resolution.
 Each band is a matrix of pixels in a particular spatial resolution.
 Digital number (DN), which quantifies a magnitude of
reflectance, defines value of each pixel in particular radiometric resolution.
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Figure 22: Components of a RS imaginary

2.4. AIRCRAFT OPTICAL IMAGERY
Aerial photography is process of making of images from an aircraft
(up to 50 km) or balloon (or some other platform) within the Earth's
atmosphere. Aerial photographs and digital aerial imagery has been a
primary source of topographic and cadastral mapping in medium and large
scales for quite a long time. Aerial photographs started almost as soon as
portable cameras were invented and became practical with the invention of
the airplane. As the camera was used more and more for aerial photographs,
the science and profession of photogrammetry was defined. Digital aerial
cameras are replacing film cameras as the sensor of choice in the 1990s.
Aerial photography is a passive method of RS which uses reflected
energy from the Sun. Cameras used for aerial photography are mostly frame
systems. Two basic types of cameras are used in aerial photography, aerial
photographic cameras and digital CCD (charge-coupled device) cameras
(Figure 23).
A photograph refers specifically to images that have been detected as
well as recorded on photographic film (Figure 24). Photographic films can
be sensitive to light from 0.3 micrometers to 0.9 micrometers in wavelength
covering the ultraviolet (UV), visible, and near-infrared (NIR).
Panchromatic (greyscale), true color and infrared aerial photographs can be
printed onto paper or plastic and can be converted into digital formats.
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Figure 23: Frame sensors: aerial photographic and digital cameras

Figure 24: A typical aerialphoto is black and white, with image size of 9 inch x
9 inch, and focal length approximately of 6 inch (can be shown in mm)

Digital cameras record electromagnetic radiation electronically, and
they differ significantly from their counterparts that use film. Instead of
using film, digital cameras use a gridded array of silicon coated CCDs
(charge-coupled devices) that individually respond to electromagnetic
radiation. The CCD is a rectangular array of pixels that respond to light and
record the intensity of the range of the electromagnetic spectrum that it is
calibrated to record. It is possible to split multiple CCD’s across multiple
lenses, or use multiple CCD’s with a single lens to simultaneously record
different portions of the electromagnetic spectrum (Figure 25).
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Figure 25. The reflected energy from the visible portion of the
electromagnetic spectrum reacts with a three CCD system

Figure 25 shows how reflected energy from the visible portion of the
electromagnetic spectrum reacts with a three CCD system. In a three CCD
system, there is one CCD for each primary color (Blue, Green and Red). A
complex set of mirrors and filters redirect the primary colors onto its
respective CCD. This creates three separate images, each reflecting the
intensity of returned energy for one of the three primary colors. When those
three images are laid on top of each other, they create a true color
photograph.
Modern digital imaging systems are capable of collecting data with a
spatial resolution up to 1.8 cm at 300 m flying height, and with a spectral
resolution of four multispectral bands: Blue, Green, Red and Near Infrared
plus a panchromatic band. In general, a panchromatic band refers to black
and white imagery exposed by all visible light (but can be exceptions).
The size of the pixel arrays varies between systems, but typically
ranges between 512 x 512 to 17,310 x 11,310 pixels. Radiometric resolution
can be up to 14 bit.
Most aerial images are classified as either oblique or vertical,
depending on the orientation of the camera relative to the ground during
acquisition. Vertical images are images that are tilted less than 3° off the
vertical are regarded as vertical. For cadastral purposes, vertical images are
mostly applicable as they provide high accuracy for delineating parcels and
buildings.
When obtaining vertical aerial images, the aircraft normally flies in a
series of lines, each called a flight run (A). The distance the camera moves
between exposures is called the air base. Aerial images are taken in rapid
succession looking straight down at the ground and overlap within and
between flight runs. The overlap in these two directions is called forward
overlap (or endlap) and sidelap. The forward overlap ensures total coverage
along a flight line and also facilitates stereoscopic viewing. Forward overlap
157

within a flight run is from 60 to 70% between sequential images. Sidelap
between flight runs is from 25-40% and ensures that no areas are left
unphotographed (Figure 26).

Figure 26: Illustration of flight run, air base and overlaps

There are a few primary uses of aerial imagery: topographical
surveying and mapping (including cadastral mapping), Digital Elevation
Model extraction, visual and digital image interpretation, and background
use.
Where a new cadastral survey of a large area is required to be carried
out quickly, an aerial survey is often the most practical method. When time
and money allow, the areas can be resurveyed to higher accuracy at a later
date.
In the simplest case, aerial images may be used as a base on which to
outline the parcels (Figure 27). However, a parcel’s boundary delineation
could be done only where the boundaries of parcels are visible from the air
and/or a ground control network is available to rectify images. Delineation
of parcel boundaries can be a laborious if performed by manual screen
digitizing or photogrammetry. In some countries, it is sufficient to produce a
plan which acts as a signpost to the parcels, the boundaries of which can be
determined by inspection on the ground. In such cases there is no need to
record the accurate dimensions of any land parcel so long as its boundaries
are clearly visible on the aerial images. Such an approach is expedient
where large numbers of parcels need to be recorded over a short period of
time.
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Figure 27: Osama bin Laden compound,
http://www.digitalglobe.com/index.php/27/Sample+Imagery+Gallery

In some cases, particularly in urban environments, it is expected that
control markers will mark the parcel boundary. Such markers can relate to
borderlines, like fences that surround buildings, or break lines between the
ground level of buildings and the street. If recognizable, such objects can be
used to generate a partitioning that often reflects the actual (or eventual)
parcelation of cadastral blocks.
Cadastral surveys of small areas, extensions to existing surveys, and
revision work will usually best be done by the ground surveying techniques.
In this case, the advantage of speed is much less, and must in any event be
weighed against increased costs.
The consideration of aerial images for particular mapping applications
depends on the scale of imagery. The accuracy and photo-map scale
relationships mainly depend on the resolution of aerial images, the flying
height, the base-height ratio and the accuracy of the stereo-plotting. Thus,
aerial images with spatial resolution less than 10 cm can be used for
cadastral mapping at 1:500 - 1:5,000 scale’s range.

2.5. SATELLITE OPTICAL IMAGERIES
Many satellite RS sensors (as opposed to aircraft based system)
acquire data using scanning systems, which employ a sensor with a narrow
field of view (i.e. IFOV) that sweeps over the terrain to build up and
produce a two-dimensional image of the surface. A scanning system used to
collect data over a variety of different wavelength ranges is called a
multispectral scanner (MSS), and is the most commonly used scanning
system.
Modern RS sensors are along-track scanners by design. Along-track
scanners use the forward motion of the platform to record successive scan
lines and build up a two-dimensional image, perpendicular to the flight
direction. They use a linear array of detectors (A) located at the focal plane
of the image (B) formed by lens systems (C), which are "pushed" along in
the flight track direction (i.e. along track). These systems are also referred to
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as pushbroom scanners, as the motion of the detector array is analogous to
the bristles of a broom being pushed along a floor.
Each individual detector measures the energy for a single ground
resolution cell (D) and thus the size and IFOV of the detectors determines
the spatial resolution of the system. A separate linear array is required to
measure each spectral band or channel. For each scan line, the energy
detected by each detector of each linear array is sampled electronically and
digitally recorded (Figure 28).

Figure 28: Along-track scanner’s components and principles

Most of RS satellite platforms are designed to follow a sunsynchronous orbit (from the north to the south with small inclination)
which, in conjunction with the Earth's rotation (west-east), allows them to
cover most of the Earth's surface over a certain period of time. These are
near-polar orbits, so named for the inclination of the orbit relative to a line
running between the North and South poles (Canadian Space Agency,
2009).
Many of these near-polar satellite orbits are also sun-synchronous
such that they cover each area of the world at a constant local time of day
called local sun time (CCRS, 2004). At any given latitude, the position of
the sun in the sky as the satellite passes overhead will be the same within the
same season. This ensures consistent illumination conditions when
acquiring images in a specific season over successive years, or over a
particular area over a series of days. This is an important factor for
monitoring changes between images or for mosaicking adjacent images
together, as they do not have to be corrected for different illumination
conditions (Figure 29).
The near-polar orbit (including sun-synchronous orbit) satellite travels
northwards on one side of the Earth and then toward the southern pole on
the second half of its orbit. These are called ascending (South-North) and
descending passes (North-South), respectively. If the orbit is also sunsynchronous, the ascending pass is most likely on the shadowed side of the
Earth while the descending pass is on the sunlit side. Then, sensors
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recording reflected solar energy only image the surface on a descending
pass, when solar illumination is available. Active sensors that provide their
own illumination or passive sensors that record emitted (e.g. thermal)
radiation can also image the surface on ascending passes. Most of the RS
satellite platforms today are in near-polar orbits, which means that the
satellite travels northwards on one side of the Earth and then toward the
southern pole on the second half of its orbit.

Figure 29:
Near-polar
sunsynchronou
s satellite
orbit

Figure 30:
Satellite
swath

Figure 31: The
satellite swath
shifts for each
new pass on the
orbit

Figure 32:
Nadir viewing
(CRISP,
Singapore,
2009)

Figure 33:
Off-Nadir
viewing

As a satellite revolves around the Earth, the sensor "sees" a certain
portion of the Earth's surface called swath (Figure 30). Imaging swaths for
space-borne sensors generally vary between tens and hundreds of kilometers
wide. The satellite orbits runs the Earth from pole to pole and because of the
Earth rotation (from west to east) the satellite swath shifts for each new pass
on the orbit, and thus sensor covers different areas on the Earth (CCRS,
2004). Thus, the satellite's orbit and the rotation of the Earth work together
to allow complete coverage of the Earth's surface (Figure 31).
Revolution orbital cycle is time taken for platform to complete one
orbit of the earth. The exact length of time of the orbital cycle will vary with
each satellite. Revisit period is the interval of time required for the satellite
to image the same area on the Earth. Revisit period is function of revolution
cycle, latitude and off nadir viewing capability. Using steerable sensors, a
satellite-borne instrument can view an area (off-nadir) before and after the
orbit passes over a target, thus making the revisit time less than the orbit
cycle time. Satellites can collect enough endlap that a three-dimensional
image can later be created.
Nadir viewing means the sensor images the target directly under the
satellite (Figure 32). Nadir imagery poses less distortions and displacements
with image geometry. Off-nadir viewing means the sensor can image to the
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sides of the nadir point (Figure 33). Off-nadir viewing increases revisit time
and provides stereo coverage.
Currently, there are tenths of RS satellite programs in operation which
satellite imageries can be used for cadastral applications. For the purpose of
cadastre, these system can be classified as
 High resolution sensors acquired multispectral and panchromatic
imageries with spatial resolution less than 100 meters.
These satellite imageries can be used for land use zoning. Imageries
with the spatial resolutions in the range of 20-30 meters are more
appropriate to use for analysing land use and land cover patterns than submeter spatial resolution imageries. The most popular satellite systems used
for land resource management within this resolution level are listed the
following table 1.
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Table 1: A list of satellite whose imageries can be used to study settlement
types
and
pattern,
urban
structure,
vegetation
cover
etc.
(http://www.satimagingcorp.com/satellite-sensors/)

Sensor
Type

Landsat 7
ETM+

Spectral
Resolution,
Bands,
Micrometres

Spatial
Resolutio
n Meters

Band 1 Blue

30

Band 2 Green

30

Band 3 Red

30

Band 4 NIR

30

Band 5 SWIR
1

30

Radiometric
Resolution
Bits

Temporal
Resolution,
Days

Swat
h, Km

Orbit
Altitude,
Km

8

16

18
5

705

16

16

18
5

705

Image
Examp
le

30
Band 7 SWIR
2

15

Band 8 Pan

60

Band 6 TIR
Landsat 8
OLI

Band 1
Coastal

30
30

Band 2 Blue
30
Band 3 Green
30
Band 4 Red
30
Band 5 NIR
30
Band 6 SWIR
1
Band 7 SWIR
2

30
15
30

Band 8 Pan
100
Band 9 Cirrus
100
Band 10
TIRS 1
Band 11
TIRS 2
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ASTER

Band 1 0.520.60 NIR

15

8

15

8

15

8

30

8

30

8

30

8

Band 5
2.145-2.185
SWIR

30

8

30

8

Band 6
2.185-2.225
SWIR

30

8

90

12

Band 7
2.235-2.285
SWIR

90

12

90

12

Band 8
2.295-2.365
SWIR

90

12

90

12

Band 1 Green

10

8

Band 2 Red

10

Band 3 Near
IR

10

Band 2 0.630.69 NIR
Band 3 0.780.86 NIR
Band 4 1.601.70 SWIR

16

60

705

2-3

60

822

Band 9
2.360-2.430
SWIR
Band 10
8.125-8.475
TIR
11 8.4758.825 TIR
12 8.9259.275 TIR
13 10.2510.95 TIR
14 10.9511.65 TIR
SPOT-5

20
Band 3
Shortwave IR

5

Band 5 Pan
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SPOT-6
and 7

Band 1 Blue

6

Band 2 Green

6

Band 3 Red

6

Band 3 Near
IR

6

12

1

30

694

1.5
Band 5 Pan

 Fine resolution sensors acquired multispectral and panchromatic
imageries with spatial resolution less than 1 meter.
These satellite imageries can be used for mapping parcel’s boundaries,
buildings and other cadastral objects.
Table 2: A list of satellite whose imageries can be used to map of individual
objects at 1:5,000–1:10,000 scales (http://www.satimagingcorp.com/satellitesensors/)

Sensor
Type

IKONOS

Spectral
Resolution,
Bands,
Micrometres
Band 1 Blue

Spatial
Resolution
Meters
0.82

Radiometric
Resolution
Bits

Temporal
Resolution
, Days

Swath,
Km

Orbit
Altitude,
Km

11

3

11.3

680

11

1-3.5

16.8

450

Image Example

Band 2 Green
Band 3 Red
Band 4 Near IR

Quick
Bird

Band 5 Pan

3.2

Band 1 Blue

0.61

Band 2 Green
Band 3 Red
Band 4 Near IR
Band 5 Pan

2.44
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GeoEye
1

Band 1 Blue

1.84

11

2.1

15.2

770

11

4.5

13.1

617

Band 2 Green
Band 3 Red
Band 4 Near IR

WorldVie
w3

Band 5 Pan

0.46

Band 1 Coastal

1.24

Band 2 Blue
Band 3 Green
Band 4 Yellow
Band 5 Red
Band 6 Red
Edge
Band 7 NearIR1
Band 8 NearIR2

0.31

Band 9 Pan
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Satellite images are used for creating and updating cadastral maps.
The selection and use of different types of satellite images mainly depend
upon the requisite level of details, the quality of data required etc. Thus, it is
possible to achieve an accuracy of +/- 1 meter by using sub-meter resolution
imagery and GNSS controls. In not so mountainous terrain and in planned
build up areas it is possible to generate cadastral maps with sub-meter
resolution images with up to the map scale of 1:5,000.
The below is one example, where an ortho-rectified QuickBird image
was used to digitize land plot boundaries using on-screen digitizing
techniques in GIS after confirmation from the land owners in the field
(Figure 34).

Figure 34. Digitised cadastral boundaries on high-resolution satellite imagery
in Zormandi area
(http://geografie.ubbcluj.ro/ccau/jssp/arhiva_2_2012/06JSSP022012.pdf)

2.6. ELEMENTS OF PHOTOGRAMMETRY
All remote sensing imageries (including vertical aerial and digital
photographs, satellite imageries) are inherently subject to geometric
(positional) distortions and displacements. In order to use RS imageries for
topographic and cadastral mapping, the imageries should be corrected. The
principles of aerial imagery corrections and the application of aerial surveys
for topographic mapping of the Earth's surface come from the use of aerial
photogrammetry.
Photogrammetry is the science of using aerial photographs and other
remote sensing imageries to obtain precise measurements of natural and
human-made features on the Earth and produce planimetric (topographic)
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maps. Photogrammetry forms the baseline of many RS as well as GIS and
LIS applications. For RS and GIS applications, aerial photogrammetry often
provides the foundation to develop base maps (including topographic and
cadastral). This chapter will introduce you with basic principles of
photogrammetry related to image correction.
Large-scale topographic maps use an orthographic projection (i.e.
using parallel lines of sight) and constant scale to represent features. On the
topographic map, objects are located in exactly the same position relative to
each other as they are on the surface of the Earth, except with a change in
scale. On a map, objects and features are both planimetrically and
geometrically accurate (Figure 35).

Figure 35: Projections of topographic maps and aerial images (framing
cameras)

A photographic image is created in a central perspective where it is
assumed that every light ray from the Earth’s surface (A) reaching the plane
of the film (С) during exposure passes through the camera lens which is
mathematically considered a single point, the perspective center of the lens
(B). Therefore, the relative position and geometry of the objects depicted
depends upon the location from which the photo was taken. This causes
certain forms of distortions and displacements in aerial photographs (Figure
36).
The distance between the center of the lens (B) and the principal point
of focal plane is termed the focal length 𝑓 of the camera lens (or principal
distance) and it is one of the internal camera geometry parameters. The
position of the principal point is defined by fiducial marks mounted on the
frame of the camera. Lens distortions describe non-ideal geometry of a real
lens.
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Figure 36: Internal framing camera geometry parameters

One of the important quantitative photogrammetric characteristics of
aerial imagery is the scale. In general, image scale is similar to map scale
and can be calculated as:
Scale 

the relative distance on an image
.
the distance on the ground

Alternatively, the scale of a vertical photograph approximately equals
to the ratio of the flying height above the ground (𝐻) to the focal length of
the camera lens (𝑓). The scale of a vertical photograph can be calculated as
Scale 

f
(Figure 37).
H h
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Figure 37: Aerial photo scale calculation

With respect to scale and distance, images contain distortions
inherited from a central perspective projection and distortions are different
than those found on topographic maps. Since the height of the terrain (ℎ)
varies across an area, then so does the the flying height above the ground
(𝐻) and thus the scale of the photography. These and other distortions
should be corrected.
Geometric distortions are errors on an image between the actual image
coordinates and the ideal image coordinates which would be projected
theoretically with an ideal sensor and under ideal conditions.
There are many factors affecting the quality of the aerial images and
the accuracy of the measurements. However, there are six primary sources
of aerial image distortions: terrain, camera tilt, film deformation, camera
lens, atmospheric bending, and other camera errors. These types of
distortions can occur in satellite images as well.
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The terrain and camera tilt sources of error are considered to be the
sources that contribute the greatest amount of displacement or geometry
error of aerial images. Geometric corrections may be desirable as movement
or displacement of the image pixels into correct horizontal positions and
geo-referenced space.
Tilt displacement: A tilted image presents a slightly oblique view
rather than a true vertical snapshot. All photos have some tilt. Tilt is caused
by the rotation of the platform away from the vertical.
Objects on tilted aerial photographs are shifted from their true
positions due to a tilt of camera and the respective view of the photograph.
As you can see from the slide below, the nadir point on a vertical
photograph will coincide with the principal point, but due to tilt, the nadir
point is shifted aside from the principal point. The Nadir point (N) is the
point where the vertical line projected through the center of the lens (B)
intersects the focal image plane (C), and the principal point (O), as you may
remember, is defined by fiducial marks, mounted on the frame of camera
(Figure 38). When tilt is present, all other points on aerial photographs are
shifted due to the platform tilt, as the Nadir point is in Figure 38.

Figure 38. Tilt displacement

The maximum amount of tilt displacement on a tilted photo is given
by the formula: r 

r 2 sin 
,
f  r sin 

where, 𝑟 - vector in an image from nadir

point to depicted object; 𝑓 - focal length; 𝛼 - tilt angle.
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If the amount and direction of tilt are known then the aerial image
may be rectified - transformed to create a complete, corrected vertical
image.
Relief displacement: This is typically the most serious type of
displacement. These displacements radiate outward from nadir point (N) in
an image (Figure 39). For vertical images, the nadir point (N) is very close
to the principal point (O). Topographic or relief displacement is caused by
the perspective geometry of the camera and the terrain at varying elevations.

Figure 39: Directions of relief displacements

For example, towers A and B are equally high, but placed at different
distances from the nadir point, thus have different relief displacements (blue
and red vectors respectively in the photograph). A tower depicted directly
beneath the nadir point has no relief displacement.

Figure 40: Illustration of relief displacement for towers

Relief displacement rh for vertical aerial photography is given by the
formula rh 

h
r , where 𝐻 - flight altitude above ground surface; h - relief
H

elevation on the ground; 𝑟 - vector (in blue in the photograph) in an image
from nadir point to depicted object.

For example if 𝐻 = 2000 𝑚 (flight altitude above ground surface);
ℎ = 150 𝑚 (a mountain’s elevation on the ground); and 𝑟 = 100 𝑚𝑚
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(vector in an image from nadir point to depicted object), then relief
displacement rh for the sample mountain is rh 

h
150m
r
100mm  7.5mm
H
2000m

.

What does relief displacement mean with respect to terrain rather than
discrete objects such as towers? Point A on the ground is depicted as point
a” in image, but on a topographic map it should be in a position a’, that
corresponds to point A’ on a Datum plan (a Datum plan should be projected
to a map), so we have an error in point position coordinates equal to a’a”. If
there is no elevation then there are no displacements. In addition, there is no
displacement at or near the nadir point.

Figure 41: Illustration of relief displacement for topography

The relief correction process is called ortho-rectification, thus rh can
be applied to each image pixel to remove relief displacement. In order to
perform relief displacement, elevations for all pixels depicted in aerial
photograph or image are required. These corrections are different for each
pixel in image. An orthorectified image appears as though each pixel were
acquired from directly overhead.
Elevation values used in the correction process could be acquired from
an existing Digital Elevation Model (DEM) or a new DEM can be produced
from a stereo model of stereo images. Two consecutive images along a
flight run form a stereo-pair that allows to perceive a stereo model within
the overlapping area (green rectangle in Figure 42). A single image allows
measurement of the planimetric (X,Y) coordinates of an object, however a
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stereo-pair allows one to retrieve 3D coordinates (X,Y,Z or height) of the
object.

Figure 42: Aerial photograph’s stereo pair with 60% overlap

The stereopair parallax method can be employed to determine the
height (ℎ) of objects. The parallax method of height determination method
requires two overlapping air images (aircraft or satellite) on the same flight
line, the height of the aircraft/satellite above the ground (𝐻), and the average
image base length (𝑏). The image base length is the distance from the
principal point of one air image to the other. The method uses the principle
that the radial displacement of a feature varies proportionately with the
height of the aircraft/satellite, but takes into account measurements from
two air images.
Differential parallax is determined by dP  P1  P2 (Figure 43), photo
base length is determined by b 

b1  b2
, and then height of the object is
2

determined by h  H dP

b  dp

Figure 43: Differential parallax determination principle

Ground control points (GCPs), or accurate geodetic data, is essential
for all these geometric corrections. A control point is any station that is
identified on a photo and used as an aid to geo-referencing the images.
Non-systematic errors could be corrected through the image
registration process. The geometric registration process involves identifying
the image coordinates (i.e. row, column) of several clearly discernible points
(Figure 44), called ground control points (or GCPs), in the distorted (raw)
image (A - A1 to A4), and involves matching them to their true positions in
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ground coordinates (e.g., latitude and longitude of B - B1 to B4). The true
ground coordinates (B - B1 to B4) are typically measured from a map, either
in paper or digital format, field surveys (e.g., with GNSS) or from georeferenced images. Therefore, there are respectively the following types of
image registration processes:

Image-to-map registration;

Image-to-image registration;

Coordinate input registration.

Figure 44: Image registration process principle

If an image is registered to geographic or map coordinate systems,
such a registration process also can be termed geo-referencing or
rectification. If an image is registered to a coordinate system that has no
geographic or map reference, such a process can be just termed image
registration.
Lens distortion: Small effects due to the flaws in the optical
components (i.e. lens) of camera systems lead to distortions (which are
typically more serious at the edges of photos). These effects are radial from
the principal point (making objects appear either closer to, or farther from
the principal point than they actually are); and can be corrected using
calibration curves.
Photogrammetry provides the mathematical foundation needed to
remove the distortions and displacements from aerial imagery. In the last
decades of the 20th century, aerial photographs were rectified and orthorectified by using stereo-plotting equipment. Nowadays, image-processing
software (e.g., ERDAS, PCI Geomatica, ENVI, ER Mapper, IDRISI etc.)
and GIS (e.g., ArcMap has image processing capabilities) are used to do
image correction and DEM extraction from overlapping images.

2.7. LIGHT DETECTION AND RANGING (LIDAR)
LiDAR stands for Light Detection And Ranging. LiDAR is an RS
technique that uses laser light to sample the surface, bathymetric and
atmospheric features to producing highly accurate X, Y, Z measurements
(Figure 45). The term LiDAR was created as a portmanteau of "light" and
"radar”. Thus LiDAR is laser RADAR, or optical RADAR. Both are names
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used for systems utilizing
frequencies/wavelengths.

electromagnetic

radiation

at

optical

Figure 45: LiDAR system

The acronym “laser” stands for “light amplification by stimulated
emission of radiation.” A laser is a device that which generates a stream of
high-energy particles (photons) within an extremely narrow range of
wavelengths. “High energy” means that enough energy can back scatter to
the detector. “Very narrow beam” means that the laser can illuminate and
measure small targets with more energy per area. Lasers produce a coherent
light source designed for a specific purpose.
LiDAR, laser radar, and optical radar are all names used for "radar"
systems utilizing electromagnetic radiation at optical frequencies. The
LiDAR beam is very narrow, since it is basically a laser beam of visible or
infrared radiation (very short wavelength) - the wavelength for the LiDAR
transmitted energy is near/in the visible spectrum, for example, 1.064 µm
(Nd:YAG), 0.810 µm (ScaLARS), 0.900 µm (FLI-MAP), 1.540 µm
(TopoSys, Riegl) , 1.064 and 0.532 µm (bathymetric lasers).
There are two major categories of LiDAR:

To detect atmospheric properties - atmospheric LiDARs;

To detect non-atmosphere objects – target LiDARs.
The second imaging category using a laser range finder instrument can
be applicable for cadastral purposes e.g. to delineate parcel boundaries and
real properties objects.
A LiDAR instrument principally consists of a laser scanner
(transmitter and receiver), a direct georeferencing component (specialized
GPS and inertial measurement systems (INS)) and computer processing
resources. Satellite, airplanes, helicopters and drones can be used as
platforms for acquiring LiDAR data of land areas.
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How does conventional (range finding) LiDAR work? A LiDAR
instrument uses laser optical light pulses to illuminate the terrain (up to
150,000 times per second) and often LiDAR uses nadir or near-nadir vision
of the study area. LiDAR observes only the intensity of the collected
radiation and the time delay from transmission to collection. The transmitted
laser pulse interacts with and is changed by the target. Some of this light is
reflected / scattered back to the instrument where it is analyzed. The change
in the properties (strength) of the light enables some properties of the target
to be detected. The time interval between when the laser pulse is generated
and received back at the antenna after reflecting from a target on the ground
is recorded. The time for the light to travel out to the target and back to the
LiDAR is used to determine the range to the target. The instrument then
calculates the range as:
𝑅𝑎𝑛𝑔𝑒 = 𝑐 ∗ 𝛥𝑡/2, where 𝛥𝑡 = 𝑡1 − 𝑡0 is the time delay (Figure
46); 𝑐 is the light speed.
LiDAR uses the same principle as RADAR (Radio Detection And
Ranging) and SODAR (Sound Detection And Ranging), except that
RADAR uses microwaves, and SODAR uses sound. In the case of SODAR,
𝑐 is the speed of sound.

Figure 46: Radiation is transmitted into environment, backscattered by the
objects, and then detected and analyzed by receivers (Jensen, 2007)
The main task of target, ranging or profiling LiDAR is to measure a time delay
between transmission and reception. Atmosphere or scattering LiDAR, besides time
delay, is more interested in signal strength, spectra, etc.
With knowledge of the absolute position (from GPS) of the LiDAR instrument,
the range and “pointing angle” of the laser system, the X,Y,Z coordinates of the
reflecting object can be calculated. LiDAR geo-references points by using GPS that
derives the position of the aircraft, INS that determines the pointing direction of the
sensor, and the LiDAR range that is used to extrapolate the coordinates of a target
point on the ground.
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Heights/altitude of points are calculated by LiDAR by subtracting a 𝑟𝑎𝑛𝑔𝑒 from
a precise platform base altitude (𝐷) referenced to an ellipsoid. It gives surface height
(ℎ) above the reference ellipsoid as:
ℎ = 𝐷 − 𝑅𝑎𝑛𝑔𝑒 ± 𝐼𝑛𝑡𝑒𝑟𝑓𝑒𝑟𝑒𝑛𝑐𝑒 𝑜𝑓 𝑎𝑒𝑟𝑜𝑠𝑜𝑙𝑠 𝑎𝑛𝑑 𝑐𝑙𝑜𝑢𝑑𝑠
Subtracting the geoid height (𝑁 - an approximation of sea level) from the
surface height (ℎ) gives a surface elevation (𝐻) with respect to sea level as 𝐻 = ℎ −
𝑁

The range measurement process results in the collection of elevation
data points (commonly referred to as mass-points) arranged systematically
in time across the flight line (Figure 47). The mass-points are reflected from
the ground, water bodies, roofs of buildings, power-lines, tree canopy,
poles, etc. Thus, point density is inhomogeneous and depends of nature,
condition and pattern of all these scanned features, for some patterns more
for other less.

Figure 47: LiDAR mass points is the equivalent of locating 75,000 surveyors
in the field per second

The laser pulse is a beam of light comprising a continuous waveform.
Early LiDAR systems recorded only one discrete return, either the first peak
or the final peak in the reflected wave. A sufficient amount of laser light
energy is able to continue on to generate returns from lower portions of the
tree, and finally, from the ground (Figure 48A).
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Figure 48A:
Discrete Return
LiDAR

Figure 48B: Multiple
aveform LiDAR

Figure 48C: Full
Waveform LiDAR

In a discrete multiple-return LiDAR, only the peaks would be
recorded (Figure 48B). In a waveform LiDAR, the entire return pulse is
digitized and recorded (Figure 48C). Capturing and recording this vast
amount of data poses some significant challenges and interesting
opportunities. Challenges include a need to use mass storage devices and
sophisticated software. Opportunities include a possibility to perform more
accurate recognitions of scanned features.

Figure 49: LiDAR returns
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In addition, LiDAR systems record the intensity, or the magnitude or
strength, of the return pulse (Figure 50). Objects with high reflectivity, such
as snow or a metal roof, show a higher intensity return than dark objects,
such an asphalt roadway.

Figure 50: LiDAR intensity image

LiDAR data resolution is based on collection density - 1 point/meter
to 8 points/meter. The error budget of a LiDAR system is a quantitative
evaluation of the random and systematic error sources that contribute to the
overall positional (X, Y, Z) accuracy of the post-processed LiDAR point
cloud. The majority of commercial organizations that collect LiDAR data
state that the horizontal and vertical accuracy of their data is generally on
the order of 10-20 centimetres. There are no common accuracy standards for
LiDAR used for cadastral purposes.
LiDAR datasets can be disseminated as ASCII X,Y,Z,ID text files, LAS
binary files and in other formats. Members of the industry, including LiDAR
instrument manufacturers, data acquisition vendors, and RS/GIS software
developers, came together under the auspices of ASPRS (American Society
for Photogrammetry and Remote Sensing) to establish the LAS binary format.
LAS format has rapidly become an internationally accepted standard, and
most software packages, including ArcGIS, have become interoperable with
this format.
There are numerous applications of LiDAR. The most common
application is to use LiDAR point’s clouds to generate elevation products
(e.g., DEM, DTM and DSM), contour lines for elevation etc. The terms DEM
(Digital Elevation Model), DTM (Digital Terrain Model) and DSM (Digital
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Surface Model) are all usually used to refer to various types of continuous,
three-dimensional spatial data.
In this course, we will consider that Digital Elevation Model (DEM)) is
a representation of the continuous surface of the bare earth ground by a large
number of selected points with known X, Y, Z coordinates above sea level or
ellipsoid. Digital Terrain Model (DTM) is a more complex concept that
involves the incorporation of not only elevation (height) measures, but also
other terrain features such as rivers, ridgelines, cliffs, height spots etc. into the
digital model. A DSM represents the elevations (heights) of the ground and all
features on it. For example, if there are buildings or trees in the area, DSM
includes those building and tree heights in the elevation values it provides.
In this course, you can consider that points of the first return comprise
Digital Surface Model (DSM); that points retune from bare earth and water
surface represent Digital Elevation Model (DEM) (no vegetation, building
and other non-ground object’s points are included), and difference between
DSM and DEM represents heights of buildings, trees etc. (Figure 51).

Figure
51a:
First return represents
Digital Surface Model
(DSM)

Figure
51b:
Bare
earth
(no
vegetation
or
buildings) represents
Digital
Elevation
Model (DEM)

Figure
51c:
Difference
image
represents (DTM –
DEM)
(height
of
buildings and trees)

LIDAR DEM are typically available at raster widths between 0.5 meter
and 2 meters.
For cadastral purposes, LiDAR imagery together with high-resolution
orthopho
LiDAR imagery together with high-resolution orthophoto images can
be used for machine delineation of parcel boundaries and identification of
building roofs. Machine-based delineation is an automatic approach and
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much more time and labour effective compared to manual on-screen
digitizing.
Figure 52 (left) shows an orthophoto of a residential neighborhood
with two rows of buildings and fences surrounding them (Filin S. et al,
2007). Machine delineation procedures (e.g., edge detection or image
segmentation) were applied to determine physical boundaries of cadastral
objects. The results, shown on Figure 52 (center), do not reflect the correct
cadastral fabric. Sorting out the edges that define objects from the complete
edge map is practically impossible by using orthophoto images and machine
delineation procedures.

Figure 52. An orthophoto map of a typical residential area (left) and its
resulting edge map (center), and the results following the adjustment of the
parcels boundaries (Filin S. et al, 2007)

LiDAR images and machine-based parcelation approaches can
dramatically improve the results. Application of the multi-step algorithm
(Filin S. et al, 2007) on LiDAR mass points imagery produces the
parcelation fabric shown on Figure 53 (right). The results show the great
potential of LiDAR based interpretation of cadastral objects.
LiDAR imageries also can be used for creating 3D cadastral objects.
A major concern in realizing the 3D cadastre vision is the development of
efficient methods for the attachment of the third dimension to the existing
2D systems. LiDAR and RS/GIS algorithms and tools provide a means for
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the extraction of dense and accurate 3D information and integrating the 3 rd
dimension to 2D objects (Filin S. et al, 2005).

Figure 53. Integrated LiDAR data and 2D cadastre results (Filin S. et al, 2005)

2.8. CONCLUSION
Updating cadastral information is crucial for recording land ownership
and property division changes in a timely manner. In many cases, the
existing cadastral maps do not provide up-to-date information on land parcel
boundaries.
Data collection techniques used in existing cadastre are shown in
Figure 54.

Figure 54: Data collection techniques used in existing cadastre

Remote Sensing (including photogrammetry) is less costly and more
efficient (especially in terms of speed) spatial data acquisition technique
than modern field surveying. Therefore, RS can help to gain time and speed
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in compiling and updating of cadastral maps. However, RS still can be not
completely applicable for compiling topographic plats as more accurate
measurements are required. At the same time, the potential of RS for
cadastral applications have not yet been fully explored.
Thus, so far, more accurate cadastral mapping may be achieved by
using rectified and ortho-rectified aerial images. An orthographic image
with terrain and perspective distortions removed is providing the highest
possible accuracy so ground features are displayed in their true
planimetrically correct position. Ortho-imagery combines the image
characteristics of an aerial image with the geometric qualities of a map.

Figure 55: Comparison of topographic map and orthophoto

However, spatial resolution of satellite images has dramatically
improved recently (down to 30 cm) and they may play a more important
role for cadastral work soon. Object-based extraction algorithms, which use
machine learning techniques including neural networks, have improved
dramatically in the past two decades. New techniques, such as LiDAR, are
becoming more mature and have begun to be used for cadastral purposes.
There is a tendency to integrate direct and indirect techniques for
acquiring cadastral information especially for updating the existing cadastral
maps in an efficient manner. To reduce the time and cost involved in
cadastral data acquisition, surveying and RS techniques can be integrated to
use GNSS measurements, photogrammetric products (e.g., DEM, ortho
images), sub-meter resolution RS imageries, and existing cadastral maps
within one workflow cadastral mapping process (Ali et.al., 2012).
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VOCABULARY
Active sensor: The technologies that include transmitters that send
out a signal, a light wavelength or electrons to be bounced off the target,
with data gathered by the sensor upon their reflection. Active sensors
detect and record energy emitted from the sensor itself.
Aerial imagery: Image taken usually from an airplane using either
a film or digital camera.
Aerial photography: The process of making of images from an
aircraft (up to 50 km) or balloon (or some other platform) within the
Earth's atmosphere.
Air base: Ground distance between optical centers of successive
overlapping aerial photographs.
Along-track or pushbroom scanner: A scanner use the forward
motion of the platform to record successive scan lines by a linear array of
detectors and build up a two-dimensional image, perpendicular to the
flight direction.
Analogue photo: This is the opposite of digital. A photo taken with
a film camera.
Antenna: A device that transmits and receives energy in active RS
systems.
Atmosphere: Layer of gases that surrounds some planets.
Atmospheric correction: Image-processing procedure that
compensates for effects of selectivity scattered light in multispectral
images.
Azimuth: Geographic orientation of a line given as an angle
measured in degrees clockwise from north.
Backscattering energy: The portion of the EM energy scattered by
the targets directly back toward the sensor.
Band (channel): A wavelength interval in the electromagnetic
spectrum.
Beam: A focused pulse of energy.
Brightness: Magnitude of the response produced in the eye by
light.
CCD: Charge-coupled detector.
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Centerpoint: The optical center of an imagery/photograph.
Central perspective projection
Classification: Process of assigning individual pixels of an image
to classes, generally on the basis of spectral reflectance characteristics.
"Class" can represents the real features or landuse/land cover class on the
ground (e.g., forest, building, water etc.).
Color composite image: Color image prepared by projecting any
three individual greyscale multispectral bands, each through a different
RGB (Red-Green-Blue) color filter.
Detection: A process of detection of EM radiation by a sensor.
Detector: Component of a remote sensing system that converts
electromagnetic radiation into a recorded signal.
Digital image processing: Computer manipulation of the Digital
Number values of an image.
Digital image: An image where the property being measured has
been converted from a continuous range of analogue values to a range
expressed by a finite number of integers, usually recorded as binary
Digital Number (DN), for example from 0 to 255.
Digital number (DN): Value assigned to a pixel in a digital image.
It quantifies a magnitude of reflectance, defines value of each pixel in
particular radiometric resolution.
Distortion: On an image, changes in shape, position and DN value
of targets with respect to their true shape, position and brightness value.
Dwell time: Time required for a detector IFOV to collect reflected
energy from a ground resolution cell.
Earth observation: Process of using various sensors to make
images of the Earth's surface from aircrafts and satellites.
Electromagnetic (EM) spectrum: The range of energy which
contains bands such as the gamma ray, x-ray, ultraviolet, visible,
infrared, microwave (radar), and, radio waves and which travels at the
speed of light. Different parts of the electromagnetic spectrum have
different wavelengths and frequencies.
Electromagnetic radiation (EMR): Energy propagated in the
form of and advancing interaction between electric and magnetic fields.
All electromagnetic radiation moves at the speed of light.
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Emitted energy: EM energy that radiates from a body or energy
source (sun, earth, active sensor etc.). Emission is determined by kinetic
temperature and emissivity.
Film: Light-sensitive photographic emulsion and its base.
Filter, digital: Mathematical procedure for modifying values of
numerical data.
Flight path or line: Line on the ground directly beneath a remote
sensing aircraft or satellite.
Flight run: a series of lines, which the aircraft normally flies, to
perform aerial photography.
Focal length: In cameras, the distance from the optical center of
the lens to the plane at which the image of a very distant object is brought
into focus.
Forward overlap or endlap: An overlap between images taken
along flight run.
Frame imaging system: recording systems that instantaneously
measure radiation coming from the entire scene at once.
Ground-control point (GCP): clearly discernible points on the
surface of the Earth with known locations and associated points on an
imagery, which can be, used to geo-reference the imagery.
Geometric distortion: positional displacement of objects on
vertical aerial photograph/imagery due to varying elevation, platform’s
tilt and perspective view.
Geo-referencing: Process of aligning geographic data to a known
coordinate system.
Grayscale: A sequence of gray tones ranging from black to white.
Ground truthing: The process of fieldwork then image processing
results are confirmed with reality on the ground.
Image analysis: The process of studying and processing an image
in order to explain, measure, map, count or monitor what is on the Earth's
surface.
Image: Pictorial representation of a scene recorded by a remote
sensing system.
Incident energy: Electromagnetic radiation impinging on a
surface.
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Instantaneous field of view (IFOV) or ground resolution cell:
Area on the terrain from which a detector collects information to form a
cell or pixel on an imagery. Or angle through which a detector is
sensitive to radiation.
Intensity: The brightness ranging from black to white
Interpretation: The process in which a person extracts information
from an image.
Laser range finder: LiDAR instrument that uses lasers to
stimulate fluorescence in various compounds and to measure distances to
reflecting surfaces.
Laser: Light artificially stimulated electromagnetic radiation: a
beam of coherent radiation with a single wavelength.
Lens: One or more pieces of glass or other transparent material
shaped to form an image by refraction of light.
Light Detection And Ranging (LiDAR): The remote sensing
technology that measures distance by illuminating a target with a laser
and analyzing the reflected light.
Mass-points or point cloud: Points collected by a LiDAR sensor
that show the elevation of the surface of the ground and of objects on the
ground.
Microwave: Region of the EM spectrum in the wavelength range
of 0.1 to 30 cm.
Multispectral scanner (MSS): A scanning system used to collect
data over a variety of different wavelength ranges.
Nadir: Point on the ground directly in line with the remote sensing
system and the center of the earth.
Near infrared (NIR): The shorter wavelength range of the infrared
region of the EM spectrum, from 0.7 to 2.5 micrometers.
Non-systematic distortion: Geometric irregularities on images that
are not constant and cannot be predicted from the characteristics of the
imaging system.
Off-nadir: Any point not directly beneath a scanner's detectors, but
rather off at an angle.
Orbit: The path followed by a satellite as it passes around a planet.
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Orthographic projection: Projection of light using parallel lines
of sight and constant scale to represent features.
Orthophotograph
or
orthoimage:
A
vertical
aerial
photograph/image from which the distortions due to varying elevation,
tilt and perspective view have been removed, so that it represents every
object as if viewed directly from above – in orthographic projection.
Ortho-rectification: Process of removing distortions caused by
varying elevation and tilt from imageries.
Overlap: Extent to which adjacent images or photographs cover
the same terrain, expressed as a percentage.
Panchromatic film: Greyscale film that is sensitive to all visible
and NIR wavelengths.
Parallax difference: The difference in the distance on overlapping
vertical photographs/images between two points, which represent two
locations on the ground with different elevations.
Parallax: Displacement of the position of a target in an image
caused by a shift in the observation system.
Passive RS: Remote sensing of energy naturally reflected or
radiated from the terrain.
Passive sensor: The technologies gather target data through the
detection of vibrations, light, radiation, heat or other phenomena
occurring in the subject’s environment. RS sensors that measure energy,
which is naturally available.
Photogrammetry: The science of using aerial photographs and
other remote sensing imagery to obtain precise measurements of natural
and human-made features on the Earth and produce topographic and
cadastral maps.
Photograph: Representation of targets on film that results from the
action of light on silver halide grains in the film's emulsion.
Pixel: The smallest unit in a raster or digital image.
Planimetrically correct position: the horizontal position of
features on the Earths' surface in orthographic projection.
Platform of sensor: A carrier of a sensor. It is usually a satellite or
an aircraft, but could also be a hot-air balloon, a tall tower, drones etc.
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Polarization: The direction of orientation in which the electrical
field vector of electromagnetic radiation vibrates.
Principal point: Optical center of an aerial photograph/imagery.
Pulse length: Duration of a burst of energy transmitted by a radar
antenna, measured in microseconds.
Pulse: Short burst of electromagnetic radiation transmitted by a
radar antenna.
RADAR: Acronym for radio detection and ranging. Radar is an
active form of remote sensing that operates in the microwave and radio
wavelength regions.
Radiation: Propagation of energy in the form of EM waves.
Radiometric resolution: Sensor’s sensitivity to the magnitude of
the electromagnetic energy. It is measured through the range of digital
numbers or number of the grey value levels.
Range: In active remote sensing, the distance in the direction of
pulse propagation, usually to the side of the platform in an imaging
RADAR/LiDAR system. The slant range is the direct distance from the
antenna to the object, whereas the distance from the ground track of the
platform to the object is termed the ground range.
Real time: images or data made available for inspection
simultaneously with their acquisition.
Rectification: The process of applying a mathematical
transformation to an image so that the result is a planimetric image.
Reflectance: Ratio of the radiant energy reflected by a body to the
energy incident on it. Spectral reflectance is the reflectance measured
within a specific wavelength interval.
Reflected energy: EM energy that bounce off a target in opposite
direction.
Reflected IR: Electromagnetic energy of wavelengths from 0.7
micrometers to about 3 micrometers that consists primarily of reflected
solar radiation.
Registration: Process of superposing two or more images or
photographs so that equivalent ground control points coincide.
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Relief displacement: Geometric distortion on vertical aerial
images. The tops of objects appear in the photograph to be radially
displaced from their bases outward from the photograph's centerpoint.
Relief: Vertical irregularities of a surface.
Remote Sensing: The method of obtaining information about
objects or areas from a distance.
Return: In active RS systems, a pulse of energy reflected by the
target and received at the antenna. The strength of a return is referred to
as return intensity.
Revisit period: see temporal resolution
Revolution orbital cycle: A time taken for platform to complete
one orbit of the earth.
Satellite images: Images of Earth or other planets captured by
satellites.
Satellite: A natural or manmade object continuously orbiting above
the Earth or another planet or star.
Scale, principle: Ratio of distance on an image to the equivalent
distance on the ground.
Scanner: An imaging system in which the IFOV of one or more
detectors is swept across the terrain and produce a two-dimensional
image of the surface.
Scattering: Multiple reflections of EM radiation by particles of
atmosphere or surfaces.
Scan line: Narrow strip on the ground that is swept by IFOV of a
detector in a scanning system.
Scene: Area on the ground that is covered by an image.
Sensitivity: Degree to which a detector responds to EM energy
incident on it.
Sensor: Device that receives EM radiation and converts it into a
signal that can be recorded.
Sidelap: Extent of lateral overlap between images acquired on
adjacent flight lines.
Signal: Data recorded by a remote sensing system.
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Stereo model: Three-dimensional visual impression produced by
viewing a pair of overlapping images through a stereoscope.
Stereo pair: Two overlapping images or photographs that may be
viewed stereoscopically.
Spatial resolution: Ability to separate closely spaced objects on an
image or photograph. Spatial resolution is commonly expressed as the
most closely spaced line-pairs per unit distance that can be distinguished.
Spectral resolution: A measure of sensor ability to resolve
features in the electromagnetic spectrum. It is “thickness” of bands or
channels (min and max wavelength sensed).
Stereoscopy: A technique for creating or enhancing the illusion of
depth in an image by means of stereopsis for binocular vision.
Sun-synchronous orbit: A polar orbit where the satellite always
crosses the Equator at the same local solar time.
Swath: Width of the strip of terrain that is imaged by a scanner
system.
Target: Object on the terrain of specific interest in a remote
sensing investigation.
Terrain: Surface of the Earth.
Temporal resolution or revisit period: It refers to the length of
time it takes for a satellite to return and image the same point on the
Earth.
Thermal IR energy: IR region from 3 to 14 micrometers that is
employed in remote sensing.
Thermal image: Image acquired by a scanner that records
radiation within the thermal IR band.
Tilt displacement: A slightly oblique view rather than a true
vertical snapshot.
Time delay: the time interval between the generation of a pulse of
energy and its return from the targets.
Transmitted energy: Energy that passes through an atmosphere,
object or water.
UV: Ultraviolet region of the electromagnetic spectrum ranging in
wavelengths from 0.01 to 0.4 micrometers.
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ASSIGNMENT 2: REMOTE SENSING TECHNIQUES FOR
CADASTRAL MAPPING
Description and Objectives
The goal of this lab is to introduce the students with the use remote
sensing data to compile and update parcel cadastral plans. The scenario of this
assignment includes updating procedures of a land parcel by using an aerial
digital orthophoto image (or orthoimage) and LiDAR data without fieldwork.
Also, natural and infrastructure objects related to the cadastral data will be
derived from orthophoto image and LiDAR data. These tasks will be
completed in ArcGIS software.
Students will carry out the following procedures to compile the cadastral
parcel plan:

Prepare spatial data to make a parcel plan

Digitize natural and manmade land objects (landuse classes,
hydrography, and roads) using an orthophoto image

Process LiDAR DEM cloud data to interpolate an elevation
surface

Update a riverbed line using the structural forms derived from the
LiDAR DEM

Subdivide a parcel into land plots by using a riverbed line

Layout a land parcel plan
Submission Requirements
Once you have finished the exercise, completed the questions, which you
can find within the text, submit the file containing your answers to Moodle, as
well as the zipped folder with Hydrography.zip plot_drawing2.pdf files.
Preparation
GIS data for this exercise you will find: D:\Data\Lab2_Data\. Data
package includes:
Terrain_46_28.txt

LiDAR DEM data

Ortho_4628.sid

orthophoto image

Parcel.shp

parcel boundary

On your local computer create new directory Lab2_Result in
C:\Users\YourUserName\Documents. This directory must contain all your
data and maps for this exercise.
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Assignment 2
Remote Sensing Techniques for Cadastral Mapping
EXERCISE
The goal of this lab is to introduce students how to compile and update
the cadastral plans of land plots without carrying out the accurate ground
measurements. Those plans are usually required as foundation material in
initial project stages. Later, these plans can be updated with the more accurate
cadastral fieldwork measurements. The context of the lab is based on the work
of a surveyor when he/she should make a “draft” cadastral plan in a short
period of time. This “draft” cadastral plan should show an existing state of land
demarcation, and related natural and manmade objects in the study area.
This practical exercise includes three main steps:
1)
deriving natural and manmade objects within the existing parcel
area from remote sensing material;
2)
adjusting the derived riverbed line by using LIDAR DEM data
and derived elevation surface, and;
3)
subdividing the existing parcel into land plots along the riverbed
line, and preparing a layout of plot.
In the first step, a new database will be created, existing cadastral and
remote sensing data will be imported into the geodatabase, and then new
objects will be digitized based on orthophoto image by using on screen
digitizing tools of ArcMap. The second part will use LIDAR data for
correction of natural object boundaries, which will be used to subdivide the
existing land parcel. The final part will demonstrate how to make a plan’s
layout.
SCENARIO
Although initially not given much attention, there is now renewed
interest in the application of remote sensing techniques not only for cadastral
mapping, but also for updating of the existing cadastral maps. This is due to the
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development of automated photogrammetric techniques, LiDAR technology
and the increase in spatial resolution of remote sensing imagery.
The identification of land parcel boundaries using remote sensing and
LiDAR methods is considered as an alternative to ground based surveys and
has been adopted in different ways by various countries at different periods of
time. The main motivation was to increase the speed of mapping and to reduce
costs, particularly where a large number of boundaries had to be registered.
Photogrammetric and remote sensing techniques are also used in updating of
existing cadastral plans/maps.
The scenario of these practical exercises is to simulate the process of
compilation of the land plan ordered by a customer. Some spatial data are
provided. You will be using a high resolution orthophoto image and preprocessed LIDAR data to derive additional spatial data. The study area is
located in Lithuania; however, the remote sensing and LiDAR data are
acquired and prepared by a Ukrainian provider. If you would need to compile a
parcel plan on the other areas, you could obtain remote sensing and cadastral
materials through web services of respective country’s SDI.
The exercises are implemented by using ArcGIS version 10.2.2;
however, they can also be done using older versions of ArcGIS software.
PART A: DERIVING OBJECTS RELATED TO THE CADSTRAL
PARCEL FROM ORTHOPHOTO IMAGE
You will start by creating a new database for cadastral data. The database
will be used to import the exiting data and carry out editing, analysis and
layout of derived data. Many operations, which you have executed in the
previous lab and described step-by-step, will be required to complete this lab
independently. For detailed instructions of how to perform those operations
refer to the lab 1 notes.

1.
Open the ArcCatalog. Connect To your working Folder
Lab2_data) where you have stored the lab data and other files.

(e.g.,
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2.
Within your working folder, create a database where you will
import the existing data. Use the New > File Geodatabase operation and name
the new geodatabase as PlanData.gdb.
3.
Transfer the parcel dataset Parcel.shp and orthophoto image
Ortho_4628.sid into the geodatabase. To transfer the Parcel.shp, use the
Import -> Feature Class (single) tool to create a new Parcel feature class
within the geodatabase. To transfer the orthophoto image into the geodatabase,
use the Import > Raster datasets tool. This last operation can take a time.
The parcel dataset Parcel.shp includes a boundary of a large parcel. In
order to create a multipurpose parcel plan, we need to add natural and
infrastructure objects, which are present in the study area, into our cadastral
database. We can do this by using the orthophoto image. You will start to do
that by adding new feature classes for landuse, hydrography and roads of the
area within the land parcel.
4.
Create three new feature classes Landuse (a polygon feature
class), Roads (a line feature class) and Hydrography (a line feature class)
within the PlanData.gdb database by using New > Feature Class command.
a.
For the Landuse feature class, select the Polygon Features as the
Type of geometry, in the next dialog use the Add Coordinate System list
to
Import the coordinate system definition of the existing Parcel feature class
(that is LKS_1994_Lithuania_TM). In the next two dialogs, accept the default
settings. In the following dialog, manually create a new Text field Type with
the Length of 25 characters for the Landuse feature class: you can type the
name of new field and change its settings as it shows in the following screen.
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b.
Later, you will be using this field to specify the landuse/land
cover type (e.g., forests, meadow, etc.). Use the Finish button to create the
future class.
c.
In the same way, create the Roads and Hydrography feature
classes. When creating the feature classes, select the required geometry types.
You do not need to add new fields in attribute tables of these feature classes.
5.
Now you have five datasets within the PlanData.gdb. Close
ArcCatalog and start ArcMap. Select and add all five datasets from the
PlanData.gdb on the map. Zoom to the Parcel layer.
The five layers are displayed in the Data View window of ArcMap. You
can only see Parcel and Ortho_4628 data because other layers are still empty.
Now you will start to create the new objects required to be shown on a parcel
plan.
6.
Change the symbology of the parcel layer on the map to make the
following editing procedures more convenient. Choose the Hollow for the fill
color of parcel polygon, set the Outline Width to 2 and the Outline Color to red
as

.
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7.
Save your work as Plan.mxd document
in your working
folder and repeat the Save operation from time to time in order to not lose your
ongoing work.
8.
Start the data editing session in the Editor toolbar. Remember that
after finishing editing, you always have to Save Edits.
9.
To have a perfect match among edited features, the snapping
mode should be turned on. This mode allows snapping to points, ends, vertices
or/and edges of coincident features from one layer or multiple layers. You can
activate the snapping mode by clicking the dropdown menu of Editor >
Snapping > Snapping Toolbar. The Snapping toolbar will open. Activate or
check all four types of snapping: points, ends, vertices and edges
. From the Option link of Snapping dropdown list, open the
Snapping Options dialog window and check Show tips boxes. It will help
during manual edits.
You will be using the Editor tool to vectorize forests, meadows, riverbed
and roads on the orthophoto image.
10.
First you should vectorize landuse types within the parcel
polygon. You will be drawing landuse objects within the parcel starting from
the forest polygons that are usually best seen in orthophoto images. In the
Editor
toolbar,
choose
the
Create
Features
tool
. In the Create Feature window
select Landuse to start digitizing forest polygon.
You will be using the Trace tool
to digitize the forest within the
parcel. The Trace tool allows digitizing of a polygon outline by matching
edges of existing features from visible layers on the map. By using this tool,
you can preserve topological coincidences among features among the layers.
11.
Choose the Trace tool from the Editor toolbar, and start to
vectorize the forest by clicking on one of the parcel corners and then follow the
parcel outline with the trace tool.
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12.
However, there are a few places where the parcel is also includes
non-forest landuse classes. In these places, you may turn off the Trace tool and
start manual vectorization the forest boundary. If you need to change a
vectorization mode, click on the turning point and select the Straight Segment
tool
. Use this tool to digitize the forest line as it goes, e.g., as you can see in
the following print-screen.

13.
When you finish manual digitizing of forest segment, you may
again switch to the Trace tool and vice versa. The forest polygon may looks as
it is shown on the following print-screen.
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14.

Finish the sketch with double click at the starting point.

15.
Now you need to specify that this polygon is a forest. Use the
Attributes
button of Editor toolbar to open the Attributes editing dialog.
Enter Forest in the Type field. If you will add another polygon which you want
to associate with Forest class, you can use the Attributes dialog to enter its
Forest attribute’s value. Do not forget to save your edits.
16.
Create the meadow polygons as it shown on the following printscreen. Use the Trace tool to traces edges of forest boundary and also parcel
outline. Enter Meadow as the Type value in the attribute editing dialog.
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17.
You should digitize all landuse polygons within the Parcel layer.
Your final landuse coverage may be look as it is shown in the print-screen
below. If you would like, you may introduce and digitize more land cover
classes, e.g., you can divide the Forest class to mature forest and regrown
forest etc.
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18.
Now symbolize your landuse layer based on values from Type
field. In the Layer Properties window, choose Symbology tab > Categories >
Unique values. Choose Type in the Value Field list and click Add All Values
button. Assign appropriate colors to Forest and Meadow polygons. Uncheck
the <all other values> symbol category, and then click the Apply button.
19.
If you would like to digitize other objects by using the orthophoto
image and Landuse layers, we need to make the Landuse layer transparent.
Navigate to the Display tab of the Layer Properties dialog, and set the layer
transparency to 30%. The Landuse layer will become transparent on the map,
and underneath it the orthophoto image can be seen. These layers can be used
for layouting a final plan.
In the next step, a small river crossing the parcel should be digitized and
saved in the Hydrography feature class. It is not an easy task to derive a
riverbed from the orthophoto image as the parcel is covered by forest and we
can recognize only the riverbed path approximately by following the changes
in the vegetation pattern. Obviously, a result of manual digitizing of the
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riverbed central line will not be accurate, but we have a LiDAR data to
improve the riverbed path.

20.
Select the Hydrography layer in the Create Features window .
First try to do a visual interpretation of the orthophoto image within the parcel
interior to find the river valley. You may start riverbed digitizing from the top
edge of the parcel, as it shown in the print-screen below. You may zoon in
more closely to the image. Snap to the top edge approximately at the point
where river starts crossing the parcel, as it is shown in the print-screen.

21.
Manually digitize the riverbed by sketching its central line by
following its valley – the darker tone between the trees. You can use the
following print-screen, with the riverbed digitized, to locate the riverbed
central line.
In the next part of this lab, you will correct your digitizing by using
LiDAR data. Finish the riverbed sketch by snapping its line to the right-bottom
edge of parcel boundary as it is shown in the following print-screen.
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There is only one road in the study area and this road actually is not
inside the parcel, but just shares the bottom boundary with the parcel. This road
is shown in black color in the print-screen below. There are no other roads in
this study area.

22.
Follow the same procedures, which that described above, to
digitize the both sides of road of Roads feature class. You can use the Straight
Segment and Trace tools to digitize the road’s sides.
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23.
When you finish digitizing, assign the appropriate symbology for
the features of Hydrography and Roads layers.
You have vectorized the natural and manmade objects of study area
based on the orthophoto image. Thus, you have just created a database of
objects related to the cadastral parcel, which a customer would like to see on
the final drawing.
24.

Save your Plan.mxd and answer the following questions:

Question 1: What is the main purpose of using an orthophoto image in
compiling the cadastral plan? Explain your choice. (2 point)
e)
f)
g)
h)

To visually present the real estate property
To vectorize objects in the land plot
To use as a background for mapping of the land plot
For geolocation in the study area

Questions 2: What tool you can use to vectorize the matching edges of
the features? Explain your choice. (1 point)
a)
b)
c)
d)

Start Editing
Create Feature
Trace
Create New Feature Layer

Questions 3: What is the difference between geo-referencing and orthorectification of remote sensing images? (3 points)
Questions 4: What is the range of the finest possible spatial resolution
of aerial images obtained from the aircrafts and unmanned aerial vehicles
(drones)? (2 points)
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PART B: USING LIDAR DATA TO ADJUST THE RIVERBED
PATH AND SUBDIVIDING THE PARCEL
In this part of the assignment, you will be using LIDAR data to
adjust/correct the path of the riverbed and use the riverbed path to subdivide
the parcel into two separate plots.
In the wooded area, it is extremely difficult to find a riverbed central line
by interpretation of an orthophoto images, because a riverbed is often hidden
by foliage, shadows, and so on. LIDAR data, and an elevation surface derived
from them, provide the means to locate the riverbed more precisely.
First, you will import the LIDAR data file Terrain_46_28.xlsx into the
geodatabase and store it in the database.
25.
Save your Plan.mxd document and close ArcMap and open
ArcCatalog.
The Terrain_46_28.xlsx file is very large file and can take some time to
open it in a Excel editor. The Terrain_46_28.xlsx file includes three columns
named Field1, Field2 and Field3, in which are stored respectively X, Y and Z
coordinates of LiDAR points cloud. There are more than a million points in the
cloud. Each point is stored as a separate row. In order to import the data into
the ArcGIS, you need to specify which particular columns correspond to the X,
Y and Z fields.
In ArcCatalog navigate to your working folder and locate the
Terrain_46_28.xlsx. Expand the file to see its table: click on plus symbol
26.

. Right-click on Terrain_46_28X$and choose and run Create
Feature Class > From XY Table tool.

27.
In the Create Feature Class From XY Table window, assign the
Field1 of LiDAR file to the X Field, Field2 to the Y Field and Field3 to the
Z Field.
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28.
Assign the Coordinates System of Input Coordinates to the
Lithuania LKS 1994 TM coordinate reference system. You can select the
Lithuania LKS 1994 TM system either by importing it from the existing file
with the same coordinate system or navigating to Projected Coordinate
Systems > National Grids > Europe > Lithuania LKS 1994 TM. Also, you can
choose this coordinate system from your Favorites list, as you have used it
several times.
29.
Your Output feature class should be saved within the
PlanData.gdb, use XYLiDARcloud as the name for a new points cloud
feature class.
30.
After filling all the Add XY Data fields, run the XY geocoding
process. It can take some time, as you are geocoding more than million points.
Once the process is finished, Preview the XYLiDARcloud points cloud and its
table in ArcCatalog.
31.
Close ArcCatalog and open the Plan.mxd in ArcMap. Add the
XYLiDARcloud feature class in the map display. It also may take some time
to display LiDAR points cloud in ArcMap.
Question 5: Why are there such large variations of points cloud density
inside the parcel area? (3 points)
The Terrain_46_28.txt file is already a preprocessed LiDAR file. This
file includes only height points that are reflected from Ground (bare earth) and
Water. All other points (Vegetation, Building, Noise etc.) are removed from
this file.
Question 6: What is difference between a Digital Elevation Model
(DEM) and a Digital Surface Model (DSM)? (3 points)
Millions of cloud’s points with heights are not so useful if you do not
process them to highlight or extract relief forms and natural boundaries, which
can be used to correct the vectorized riverbed line. We are going to use the 3D
Analyst tools of ArcGIS to create a DEM interpolated surface from the LiDAR
file first and then you will be using the interpolated surface to correct the
digitized riverbed line.
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32.
You may need activate the 3D Analyst extension of ArcMap
from the main menu Customize > Extensions.
To create a continuous surface from the elevation points, you will be
using the IDW (Inverse Distance Weighted) tool. This tool interpolates a raster
surface from points using an IDW method. IDW method assumes that the
variable being mapped decreases in influence with distance from its sampled
location. IDW interpolation determines cell values using a linearly weighted
combination of a set of sample points. The weight is a function of inverse
distance. The surface being interpolated should be that of a locationally
dependent variable. You can read more about this method and tool at
http://resources.arcgis.com/ru/help/main/10.2/index.html#/na/00300000000700
0000/.
33.
Run the IDW tool from ArcToobox > 3D Analyst Tools > Raster
interpolation > IDW.
 Select the XYLiDARcloud dataset in the Input point features box
of IDW tool.
 In the Z value field box, select the Field3.
 In Output raster, navigate into the PlanData.gdb database and
type a new IDWsurface name for an interpolated surface.
Note: In order to run 3D Analysts extension it should be activated in the menu
Customise > Extensions.
One of the main parameters of this tool, which a user should define, is
the Output cell size. This parameter defines the cell size of the output raster.
This value is assigned based on the environment setting by default; otherwise,
it can be calculated and assigned based on the following rule of thumb: it
should be the shorter of the width or height of the extent of the output raster,
divided by 250. In our case, the calculated cell size should be around 1. The
use of a smaller cell size produces a more detailed DEM, however, at the same
time, its file size will be larger and processing time will take longer.
Question 7: Could orthophoto images be used to create DEM? Explain
your answer why yes or why not. (4 points)
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34.
Set the Output cell size to 1, use default parameters in the other
tool boxes.
35. In the IDW tool window, set the processing extent from the button
Environments > Processing Extent > and set Extent to Orto_4628 and
OK.
36.
Then run the tool. Wait until the IDWsurface has been created.
Processing can take a time.
Question 8: What is the linear unit of the chosen cell size? How you
know this? (1 point)
37.
Turn off all the layers in the ToC and leave only the parcel
boundary and IDWsurface layer visible. Change the symbology of
IDWsurface layer: right-click the layer and select Properties > Symbology tab
> Stretched > OK. Note how well the riverbed and its valley are highlighted in
the IDWsurface layer, as well as other structural forms of relief: hills, hollows,
gullies, etc.
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38.
We can still stretch the IDWsurface surface even more to make
these forms more prominent. Come back to the Symbology tab of Layer
Properties window. In the Stretch Type field select the Minimum-Maximum
option. The minimum and maximum values of the calculated statistics will be
used as the minimum and maximum values of the color ramp and all values in
between will be interpolated linearly. Then check the Use hillshade effect box
in order to make the relief forms stand out more. Click Apply. Now you can see
that it is possible to demarcate the riverbed path more accurately.
39.
Go to the Display tab and choose the Cubic Convolution from the
Resample during display using list. Cubic convolution resampling creates a
sharper-looking image and can be appropriate for our task of riverbed
demarcation. Click OK.
40.
Next, you should correct the previously digitized riverbed central
line by using the stretched surface. In the ToC, turn on visibility of the
Hydrography layer. You may zoom in closely to the riverbed line. You may
find many segments where your vectorized riverbed line does not match well
with the actual riverbed. The following print-screen examples demonstrate
such miss-digitizing.

41.
Start Editing the Hydrography feature class. You may use the
Edit Tool
to double-click on the riverbed line and edit it vertexes (e.g.,
move, insert or delete). Another tool of Editor toolbar, which will be useful, is
the Reshape Feature Tool . This tool allows correcting the object edges by
vectorising them again in a new location.
With the Reshape Feature Tool you can adjust the riverbed line so that it
will match the relief forms. When using the Reshape Feature Tool, it is
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important to know that a newly entered line segment must cross the original
line in order to reshape the line. Start the riverbed line adjustment from the
other side of the reshaping segment by clicking on the map (1), then vectorize a
new segment (2), and again finish editing in the other side of reshaping
segment by double-clicking on the map (3).

42.
Correct the entire riverbed line within the parcel. Do not forget to
Save Edit when you finish corrections.
Here are examples of riverbed line before editing and after editing:
Before

After
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43.
When you finish and save the edits, preview the adjusted riverbed
line on the top of orthophoto image.
Questions 9: Export the Hydrography feature class into a shapefile
named Hydrography.shp. Make an archive of Hydrography shapefiles and
submit it together with other required files using Moodle for assessment.
Your riverbed central line should follow the riverbed as precisely as possible.
(8 points)
You may notice that the parcel is transected by the river. The owner
would like to divide the parcel by the riverbed line into two separate plots.
44.
You will divide the parcel by using ArcMap tools. First, export
the Parcel feature class to the Plots feature class within the PlanData.gdb:
from the layer drop-down menu use Data > Export Data. Then, select the
Plots feature class in the Create Features window
to start editing it. Turn
off the visibility of Parcel layer in the ToC.
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45.

From the Editing toolbar select the riverbed line using the Edit
. Then, run the Clip function from the in Editing drop-down list

Tool
.

46.
In the Clip dialog, enter the Buffer Distance, which defines the
buffer width that will be clipped around the selected line. You will need a
buffer with a width of 7 meters in total – the river is approximately 7 meters
wide. Therefore you should enter a buffer distance of 3.5 meters to make
buffers on both sides of the riverbed line that total 7 metres. Run the Clip
operation.
47.
Bring the Advanced Editing toolbar on the display, select
the
Plots polygon (it is multipart feature) and run the Explode Multipart Feature
tool .
After performing Clip and Explode Multipart Feature operations, the
existing parcel will be divided into large plots separated by the riverbank lines.
Area and perimeter values of plots will be calculated by ArcMap within the
Plots feature attribute table. If you will get additional small polygons, you may
leave them as they are, but do not label them when you will design a plan in the
next section.
Question 10: What are the total area of the parcel and the total areas of
the plots? (3 points)
Usually, a cadastral drafting should include not only annotations of area
and perimeter dimensions of the plots, but also lengths/distances of segments
of plots boundaries. These dimensions are often required to be shown on
cadastral plans/maps.
48.
You will derive the lengths dimensions of plots by using a few
ArcMap operations. First, the Feature to Line tool will be used. Navigate to
ArcToolbox and then to Data Management Tools > Features and run the
Feature to Line tool. Select the Plots layer from the Input Features drop-down
list and name the Output feature class as Plots_measurements within the
PlanData.gdb, and run the tool.
214

The created Plots_measurements feature class will have a few polylines
with records, which include Shape_Lenght attributes. We would like to
annotate with distance labels of only the straight segments of external plots
boundaries, but not the riverbank lines. The riverbank lines should be left as
solitary segments. Now we need to split the polylines to separate external plot
boundaries from the riverbank lines.
49.
Select the Plots_measurements feature class in the Create
Features window
to start edit it. Use the Edit Tool
of Editor toolbar to
select the Plots_measurements polyline and then the Split Tool
to split
each polyline in the point where the plot external outline turns to the riverbank
line. As the result, you should have 4-5 polylines in the Plots_measurements
feature attribute table.

Now, we need to divide the polylines of the external plot boundary into
straight COGO segments at their turning points.
50.

Bring the COGO toolbar on the ArcMap display. Use the Edit
Tool
of Editor toolbar to select polylines of plot external boundary. Use
tool Split into COGO lines
of COGO toolbar to split the external plot
boundaries into straight segment lines. Choose the Plots_measurements
template to create features.
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51.
Open the Plots_measurements feature attribute table and you
will see that plot boundaries are comprise of two polylines, which represent the
riverbank segments, and the rest of the records are straight lines, which
represent the external plot boundary.
52.
Symbolize the Plots_measurements layer with the same
symbology style that you have used to symbolize the Parcel layer.
53.

Save and stop your editing session as well as save the Plan.mxd.

Now, you may answer the following questions and then move to the third
part of the lab where you will layout a cadastral plan.
Questions 11: What is the result of the IDW analysis of LiDAR data?
Explain your choice. (2 points)
a)
b)
c)

Digital elevation model (DEM)
3D model of relief
Terrain model
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d)

Hillshade image

Questions 12: What was the main purpose of using LiDAR data for the
compiling of cadastral plan? Explain your choice in this assignment. (1
point)
a)
To create digital elevation model
b)
To vectorize the cadastral objects
c)
To correct the boundaries of the natural objects based on the
derived relief forms
d)
To create cartographic background for cadastral mapping
Questions 13: Which of the following is a "passive" (as opposed to
"active") remote sensor? Explain your choice. (2 points)
a)
b)
c)
d)

Digital aerial camera
LiDAR
RADAR
Sonar

PART C: LAYOUTING THE LAND PLOT PLAN
In this part of assignment, you will compile a cadastral plan drawing that
represents the Plots_measurements, Plots, Hydrography, Landuse and
Roads layers on the top of orthophoto image.
54.
Make the Roads, Hydrography, Plots_measurements, Plots,
Landuse and Ortho_4628 layers visible on the map. You have already
symbolized these layers in the previous steps. You still can adjust symbology
and transparency of layers to make all objects readable. Remove the
IDWsurface and XYLiDARcloud layers from the ToC.
55.
Change the Fill Color and Outline Color of Plots layer to No
Color. You will use this layer to label area and perimeter dimensions of the
plots. The parcel boundaries will be visualized by the Plots_measurements
layer.
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56.

Label the invisible Plots layer’s polygons with values of their

area and perimeter. The label should look like as
the Assignment 1 instructions on how to build the labels.

. Check

Question 14: Print-screen and insert an image with your label here. (3
points)
Question 15: Are decimal degrees useful unit for area? Explain your
answer. (2 points)
57.

Label the Plots_measurements segments with their length. The

distance labels may look like

.

58.
Next, layout your map in the Layout View. Make a similar layout
of main map as you have done in Assignment 1: use the landscape orientation,
A4 size page, 1: 5000-scale etc. Your layout may look as the following printscreen.
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59.
Next use the functionality of Insert menu to place the plan title
and subtitle, legend, north arrow and scale. You can customize inserted plot
elements by changing their Properties. Your layout may look as the following
print-screen, or you may even find a better design solution of the map
elements.

60.
Insert and design a geographical coordinate grid around the plan.
Your layout may look as the following print-screen.
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61.
Now you will insert two tables from the PlanTable.xlsx file as
you did in Assignment 1. Only now, first you should fill this table with
Percentage and Area values of the two landuse classes in Microsoft Excel. You
can get the Area values from feature attribute table of Plots and Landuse layer.
The Percentage values you should calculate yourself in the Excel.
62.
Print the plot drawing in PDF format with the name
plot_drawing2. . And answer the following questions.
Question 16: Submit you plot_drawing2.pdf with your lab hand-in. The
assessment of your PDF plot will be based on the completeness of plot
elements and plot design. (15 points)
Question 17: Which view mode of ArcMap is used for plan layouting?
Explain your choice. (1 point)
a)
b)
c)
d)

Edit View
Template View
Data View
Layout View
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